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ibm.com and related resources

Product support and documentation are available from ibm.com.

Support and assistance

Product support is available on the Web. Click Support from the product Web site
at:

FileNet Content Manager Support
http://www.ibm.com/software/data/content-management/filenet-content-
manager/support.html

Information center

You can view the product documentation in an Eclipse-based information center
that you can install when you install the product. By default, the information
center runs in a Web server mode that other Web browsers can access. You can also
run it locally on your workstation. See the information center at
http://publib.boulder.ibm.com/infocenter/p8docs/v4r5m1/index.jsp.

PDF publications

You can view the PDF files online using the Adobe Acrobat Reader for your
operating system. If you do not have the Acrobat Reader installed, you can
download it from the Adobe Web site at http://www.adobe.com.

See the following PDF publications Web sites:

Product Web site

Product Documentation for FileNet
P8 Platform

http://www.ibm.com/support/docview.wss?rs=3278
&uid=swg27010422

“How to send your comments”
Your feedback is important in helping to provide the most accurate and highest
quality information.
“Contacting IBM” on page vi
To contact IBM customer service in the United States or Canada, call
1-800-IBM-SERV (1-800-426-7378).

How to send your comments
Your feedback is important in helping to provide the most accurate and highest
quality information.

Send your comments by using the online reader comment form at
https://www14.software.ibm.com/webapp/iwm/web/signup.do?lang=en_US
&source=swg-rcf.
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Consumability survey

You are invited to tell IBM how to improve the consumability of software
products. If you want to help IBM make IBM® FileNet® P8 easier to use, take the
Consumability Survey at http://www.ibm.com/software/data/info/
consumability-survey/.

Contacting IBM
To contact IBM customer service in the United States or Canada, call
1-800-IBM-SERV (1-800-426-7378).

To learn about available service options, call one of the following numbers:
v In the United States: 1-888-426-4343
v In Canada: 1-800-465-9600

For more information about how to contact IBM, see the Contact IBM Web site at
http://www.ibm.com/contact/us/.
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Installing IBM FileNet Workplace XT

You must install Workplace XT on a Web application server. After you install the
software, you must also configure the Web application server to work with
Workplace XT. You can then deploy and use the Workplace XT application.

“Planning and preparing for the IBM FileNet Workplace XT installation”
Planning and preparation tasks for IBM FileNet Workplace XT are required
before installation. Complete these preparation tasks and capture IBM FileNet
P8 environment installation values in the Installation and Upgrade Worksheet
before you begin to install IBM FileNet Workplace XT. You can then use the
worksheet to complete your installation.
“Installing and configuring IBM FileNet Workplace XT” on page 5
You can install IBM FileNet Workplace XT on a Web application server in your
IBM FileNet P8 environment. After you install, you must also install client
software for other IBM FileNet P8 components. You can then configure the
application server and deploy the Workplace XT application.
“Configuration and startup tasks” on page 51
After you install Workplace XT, you must also configure settings for the FileNet
P8 environment. Some of these configuration settings are required, and some
are optional.
“Installing optional components” on page 60
Workplace XT provides additional components that you can install and use.
You can also deploy multiple Workplace XT instances.

Planning and preparing for the IBM FileNet Workplace XT installation
Planning and preparation tasks for IBM FileNet Workplace XT are required before
installation. Complete these preparation tasks and capture IBM FileNet P8
environment installation values in the Installation and Upgrade Worksheet before
you begin to install IBM FileNet Workplace XT. You can then use the worksheet to
complete your installation.

The planning information and preparation tasks for IBM FileNet Workplace XT are
located in the Plan and Prepare Your Environment for IBM FileNet P8 Guide.

“Definition of installation roles” on page 2
The tasks in this guide and the rows in the Installation and Upgrade Worksheet
are organized by administrative roles. Your organization might have different
roles, and some of the responsibilities of listed roles will vary from those
assigned by default in this documentation.
“Using the installation and upgrade worksheet” on page 3
The Installation and Upgrade Worksheet is a Microsoft® Excel spreadsheet
(p8_worksheet.xls). The worksheet describes the properties and parameters
required to complete IBM FileNet P8 installation, upgrade, and configuration
programs, and provides a way to record the values you assign to these
properties and parameters.
“IBM FileNet Workplace XT port numbers” on page 5
IBM FileNet Workplace XT requires various ports to communicate with the
other components in the FileNet P8 Platform environment. You can review your
requirements and check the availability of the ports.

© Copyright IBM Corp. 2007, 2009 1



Definition of installation roles
The tasks in this guide and the rows in the Installation and Upgrade Worksheet are
organized by administrative roles. Your organization might have different roles,
and some of the responsibilities of listed roles will vary from those assigned by
default in this documentation.

Installation administrator
v Runs IBM FileNet P8 installers during initial setup.
v Runs the Configuration Manager tool during initial setup, followed by starting

IBM FileNet Enterprise Manager.
v Runs IBM FileNet P8 Upgrade programs during upgrades.
v Abbreviated as IA. Responsible for coordinating the information described in

this worksheet. The information itself will require the input from the other roles.

The role of IA is usually filled by an IBM FileNet Certified Professional (FCP).

Information technology administrator
v Responsible for the networking and operating systems settings required by IBM

FileNet P8.
v Responsible for performing certain security configurations.
v Abbreviated as ITA. Responsible for providing the information in the rows in

the Installation and Upgrade Worksheet with a value of ITA in the Role column.

Security administrator
v Responsible for configuring the directory servers required by IBM FileNet P8

components, including Content Engine and Application Engine.
v Creates and maintains directory server user and group accounts.
v Abbreviated as SA. Responsible for providing the information in the rows in the

Installation and Upgrade Worksheet with a value of SA in the Role column.

Database administrator
v Creates, configures, maintains database installations and database or table

spaces.
v Responsible for creating database accounts needed by IBM FileNet P8.
v For purposes of this documentation, the database administrator is expected to

have responsibilities regarding the JDBC data sources.
v Abbreviated as DBA. Responsible for providing the information in the rows in

the Installation and Upgrade Worksheet with a value of DBA in the Role column.

Application server administrator
v Responsible for providing the application servers required by IBM FileNet P8.
v Responsible for application server administrative accounts.
v Abbreviated as ASA. Responsible for providing the information in the rows in

the Installation and Upgrade Worksheet with a value of ASA in the Role column.

IBM FileNet P8 administrator
v This role designation actually refers to the administrator or administrators who

perform regular maintenance of Content Engine, Process Engine Application
Engine, Workplace or Workplace XT.
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v The administrator who logs on to Enterprise Manager by using the gcd_admin
account or an object_store_admin account is considered an IBM FileNet P8
administrator.

v Abbreviated as P8A. Responsible for providing the information in the rows of
the Installation and Upgrade Worksheet with a value of P8A in the Role column.

E-mail Administrator
v Creates an e-mail account that will be used to configure the Notification Tab of

the Process Task Manager so that Process Engine can send e-mail notifications to
end users. (Required only if you use this feature.)

v Abbreviated as EA.

Using the installation and upgrade worksheet
The Installation and Upgrade Worksheet is a Microsoft Excel spreadsheet
(p8_worksheet.xls). The worksheet describes the properties and parameters
required to complete IBM FileNet P8 installation, upgrade, and configuration
programs, and provides a way to record the values you assign to these properties
and parameters.

Administrators who are preparing the environment for installation or upgrade of
IBM FileNet P8 components must use the worksheet during their preparation tasks
to record the appropriate values and provide them to the Installation
Administrator who runs the installation or upgrade programs.

Some of the features of the Installation and Upgrade Worksheet are:
v Instructions: describes the worksheet and includes a button that runs the

Customize Worksheet macro.
v The two highlighted columns, Property or Parameter and ENTER YOUR

VALUE HERE, provide the simplest view of the requirement. The others add
identifying information and help you sort and filter the rows usefully.

v The Role column assigns each row to an administrator and uses the following
acronyms:
– ITA: Information Technology Administrator
– ASA: Application Server Administrator
– DBA: Database Administrator
– SA: Security Administrator
– P8A: IBM FileNet P8 Administrator

v Property definitions are contained in the column titled Description.
v Some rows, though not all, contain a hyperlink in the IC help link column.

Click this hyperlink to run a query against the IBM Information Center, which
opens with the Search Results pane showing the topics that contain the words in
the query phrase. Browse the search results until you have enough information
to be able to enter a value in the Worksheet row.
“Running the Customize Worksheet macro” on page 4
The Customize Worksheet macro lets you extract only those rows that describe
your environment.
“Autofiltering and sorting the Worksheet” on page 4
There are several ways to organize the Worksheet to make finding properties
and entering values easier.
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Running the Customize Worksheet macro
The Customize Worksheet macro lets you extract only those rows that describe
your environment.

Important: For support of the full range of built-in filter and macro features, use
Microsoft Excel to view the Installation and Upgrade Worksheet file. You can use
other spreadsheet programs to view the file; however, filter and macro support can
vary. For example, in Calc from OpenOffice.Org, the column filters work as
expected, but the Customize Worksheet button does not.
To run the Customize Worksheet macro:
1. Open the Installation and Upgrade Worksheet (p8_worksheet.xls) and click the

Instructions worksheet (also called a tab).
2. Scroll down until you see the button representing the Customize Worksheet

macro. Click the button.
3. Select the components and options that describe the environment you are

preparing for IBM FileNet P8.
v Installation or Upgrade
v FileNet P8 Components
v Application Server type
v Operating system
v Database type
v Directory Server type
v Number of object stores (adds new sets of rows for creating additional data

sources)
v Name of customized sheet

4. Click OK. The macro copies the rows that fulfill your selection criteria into a
new worksheet with the name you entered. Enter the values for your
environment into this new worksheet.

5. Click the name of the new worksheet at the bottom of the Excel window. Add
your preparation values into this new worksheet.

6. Notice that the new worksheet has buttons at the top titled Show Installer
View and Show Full View, depending on its state. The Show Installer View
displays only those columns that you need while running installation or
configuration programs.

Autofiltering and sorting the Worksheet
There are several ways to organize the Worksheet to make finding properties and
entering values easier.

AutoFiltering is a quick way to display only those rows that meet a certain criteria.
To use AutoFilter:
1. Make sure AutoFiltering is enabled. (Select the entire row with the column

headers, then click Data → Filter → Autofilter.) AutoFilter arrows will appear to
the right of the column labels.

2. Click the AutoFilter arrow in the Installation or Configuration Program
column header and select the program you are interested in (for example, PE
installer).

3. Click the AutoFilter arrow in the Setup Type column header, select Custom,
and specify Setup Type contains Installation.

4. For a custom AutoFilter, click the AutoFilter in any column header, select
Custom, and specify Setup Type contains “Installation”.
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5. To turn off AutoFiltering in a column, click the column AutoFilter arrow and
select (All).

6. To reorder rows alphabetically, do a Sort:
a. Click anywhere in a column, for example, Column A Role.

The only possible values in the Role column are ASA, SA, DBA, ITA, and
P8A. Sorting on Role therefore groups the rows by this attribute, in
alphabetic order. Several other columns also have a limited number of
possible values which means they can be usefully sorted.

b. Click the Sort Ascending icon in the Excel toolbar, or use the Data → Sort
menu command. The rows sort on Role.
Sorting the Worksheet reassigns row numbers. If you refer to rows by
number, be aware that row numbers change if you change the sort order.

IBM FileNet Workplace XT port numbers
IBM FileNet Workplace XT requires various ports to communicate with the other
components in the FileNet P8 Platform environment. You can review your
requirements and check the availability of the ports.

The table below lists the default port numbers used by IBM FileNet Workplace XT.

WebSphere® Application Server 9080

WebSphere Application Server SSL 9443

WebLogic Server 7001

WebLogic Server SSL 7002

JBoss Application Server 8080

JBoss Application Server SSL 8443

Process Engine (RMI) 32771

Component Manager (Event Port)
Remember: Ensure that this port number is
open if you are using Component Manager.
On UNIX systems, this port is closed by
default.

32773

Web Services Reliable Messaging Client Port 32767

Installing and configuring IBM FileNet Workplace XT
You can install IBM FileNet Workplace XT on a Web application server in your
IBM FileNet P8 environment. After you install, you must also install client software
for other IBM FileNet P8 components. You can then configure the application
server and deploy the Workplace XT application.

“Installing the IBM FileNet Workplace XT documentation” on page 6
Before you install and configure IBM FileNet Workplace XT, you can install the
documentation so that it will be available during the process. Install the
documentation on the same Web application server where the main FileNet P8
Platform documentation is installed.
“Installing IBM FileNet Workplace XT” on page 7
You can choose to install Workplace XT interactively, with the installation
program, or silently using a response file with installation parameters.

Installing IBM FileNet Workplace XT 5



“Installing IBM FileNet Workplace XT software updates” on page 13
After you install the IBM FileNet Workplace XT software, you must install any
service packs, fix packs, and interim fixes required for Workplace XT.
“Installing the latest Content Engine Client files on Workplace XT servers” on
page 13
The Content Engine Client software enables communication between the
Workplace XT and the Content Engine. Install the latest release or fix pack
version of the Content Engine Client files on all Workplace XT servers.
“Installing the latest Process Engine Client files on Workplace XT servers” on
page 15
The Process Engine Client software enables communication between the
Workplace XT and the Process Engine. Install the Process Engine Client files on
all Workplace XT servers.
“Configuring Workplace XT on the Web application server” on page 18
After you install Workplace XT and any necessary software updates, you must
configure your Web application server to work with the application. You can
choose the appropriate configuration tasks for your application server type and
environment. Workplace XT can only be deployed in a container-managed
application server environment.
“Deploying Workplace XT on the Web application server” on page 44
After you install and configure Workplace XT, you must deploy the application
on the Web application server. You can recreate the WAR or EAR files before
you deploy to capture any configuration changes from software updates.

Installing the IBM FileNet Workplace XT documentation
Before you install and configure IBM FileNet Workplace XT, you can install the
documentation so that it will be available during the process. Install the
documentation on the same Web application server where the main FileNet P8
Platform documentation is installed.

Before you install IBM FileNet Workplace XT, ensure that at least version 4.0.2-001
of the IBM FileNet P8 Platform documentation is installed on your documentation
server. Version information is available in the FileNet P8 Platform help topic Help
Directory → About the documentation - IBM FileNet P8 4.5 → Documentation
version and build information.

To update your FileNet P8 Platform documentation, download the zip file from the
IBM Information Management support page (http://www.ibm.com/software/
data/support/).

Copy the PDF of this guide into the ecm_help/installation/WorkplaceXT
installation directory on the documentation server before you re-index for the
search function. This ensures that the guide is available for future use and is
searchable from the FileNet P8 Platform Documentation online help.

To install Workplace XT documentation:

Because Workplace XT is an expansion product for FileNet P8 Platform, you must
add the associated Workplace XT documentation to an existing installation of the
FileNet P8 Platform help. This action makes Workplace XT help available to your
users and enables context-sensitive help from the product user interface.
For details and instructions on installing expansion product documentation, see the
IBM FileNet P8 Platform Installation and Upgrade Guide. Pay special attention to the
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topic Installing and re-indexing expansion-products, custom, and auxiliary
documentation in the task Installing IBM FileNet P8 Platform documentation.

Installing IBM FileNet Workplace XT
You can choose to install Workplace XT interactively, with the installation program,
or silently using a response file with installation parameters.

“Installing IBM FileNet Workplace XT interactively”
The installation program creates the IBM FileNet Workplace XT folder structure
and files needed for Workplace XT. After installing the files, and any necessary
updates, you must also configure and deploy the Workplace XT application.
“Installing IBM FileNet Workplace XT silently” on page 9
The installer creates the IBM FileNet Workplace XT folder structure and files
needed for Workplace XT. After installing the files, and any necessary updates,
you must also configure and deploy the Workplace XT application. These
procedures are available in subsequent topics.

Installing IBM FileNet Workplace XT interactively
The installation program creates the IBM FileNet Workplace XT folder structure
and files needed for Workplace XT. After installing the files, and any necessary
updates, you must also configure and deploy the Workplace XT application.

Before you install IBM FileNet Workplace XT:
v Make sure your installation location meets the requirements specific to IBM

FileNet Workplace XT outlined in the IBM FileNet P8 Hardware and Software
Requirements.

v You must have installed and configured a supported Web application server for
IBM FileNet Workplace XT.

v To ensure proper functionality, performance, and ongoing maintenance, IBM
FileNet Workplace XT should only be installed once per application server (or
virtual machine or AIX LPAR). You can, however, deploy multiple instances of a
single IBM FileNet Workplace XT version per application server.

v For an accessible install process of Workplace XT, follow the procedures
provided for the silent install method, “Running the Workplace XT installation
silently” on page 12.

v If you plan to use JAWS screen reader for the setup program, you must perform
the following tasks before you begin the Workplace XT install:
1. Ensure that the Sun Java JRE 1.5.0 or 1.5.x is installed on the system where

you will be performing the install.
2. Install the Java Access Bridge (available at http://java.sun.com).
3. Start the JAWS screen reader.

v Before logging in to Workplace XT for the first time, make sure at least one
object store has been created on the Content Engine.

v If you plan to set up a web farm or clustered environment, in addition to these
instructions, read and follow the instructions in the IBM FileNet P8 High
Availability Technical Notice.

v In the installation program, the version list for application servers includes
versions that might no longer be supported. To confirm supported versions,
check the IBM FileNet P8 Hardware and Software Requirements.

To install IBM FileNet Workplace XT software:
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1. Collect the parameters needed to complete your installation. For information on
parameter values, see "Installation and upgrade worksheet" in Plan and Prepare
Your Environment for IBM FileNet P8.
HINT With the Data > Filter > AutoFilter command enabled, as it is by default
in the shipping worksheet file (p8_worksheet.xls), perform the following actions
to quickly see only the installation properties you must specify for the
Workplace XT installation program:
v Click the AutoFilter drop-down arrow in the "Installation or Configuration

Program" column header and select WPXT installer.
v Click the AutoFilter drop-down arrow in the "Setup Type" column header,

select Custom, and specify: Setup Type contains "Installation."
v Click the AutoFilter drop-down arrow in all other column headers and

select (All).
2. Log in to the server where you want to install Workplace XT:

Option Description

UNIX Log in as a user with read, write, and
execute access to the directory where you
plan to install IBM FileNet Workplace XT.

Windows Log in as a member of the local
Administrators group or a user with
equivalent permissions.

3. Locate the IBM FileNet Workplace XT 1.1.4.0 installation software package.
4. Start the installation program in one of the following ways:

a. Run the appropriate installation program for your operating system.

Platform Command

AIX WorkplaceXT-1.1.4.0-AIX.bin

HPUX WorkplaceXT-1.1.4.0-HPUX.bin

HPUXi WorkplaceXT-1.1.4.0-HPUXi.bin

Linux WorkplaceXT-1.1.4.0-LINUX.bin

Solaris WorkplaceXT-1.1.4.0-SOL.bin

Windows WorkplaceXT-1.1.4.0-WIN.exe

Linux for System z WorkplaceXT-1.1.4.0-ZLINUX.bin

b. Optional: Run the installation program for your operating system, and have
the program record your installation choices in a response file.
Enter the following command:
WorkplaceXT-1.1.4.0-operating_system.bin -options-record
record_file_name

(with no space between -options-record)
where
operating_system is the platform where you are installing Workplace XT, for
example:
AIX, HPUX, HPUXi, LINUX, SOL, WIN, or ZLINUX
(For Windows, the file extension is .exe.)
record_file_name is the name of the response file to be generated, for
example, xt_record.txt.
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For more information about response files, see “Generating the silent
installation response files” on page 10.

5. Complete the Workplace XT installation program screens.
6. View the web_client_install_log_1.1.4.0.txt file located in

install_path/IBM/FileNet/WebClient.
Verify that no errors or failures were logged. Look for the ERROR designation
at the start of a line. Correct any errors before you proceed.

Installing IBM FileNet Workplace XT silently
The installer creates the IBM FileNet Workplace XT folder structure and files
needed for Workplace XT. After installing the files, and any necessary updates, you
must also configure and deploy the Workplace XT application. These procedures
are available in subsequent topics.

Before you install IBM FileNet Workplace XT:
v Make sure your installation location meets the requirements specific for IBM

FileNet Workplace XT outlined in the IBM FileNet P8 Hardware and Software
Requirements.

v You must have installed and configured a supported Web application server for
IBM FileNet Workplace XT.

v To ensure proper functionality, performance, and ongoing maintenance, IBM
FileNet Workplace XT should only be installed once per application server (or
virtual machine or AIX LPAR). You can, however, deploy multiple instances of a
single IBM FileNet Workplace XT version per application server.

v Before logging in to Workplace XT for the first time, make sure at least one
object store has been created on the Content Engine.

v If you plan to set up a web farm or clustered environment, in addition to these
instructions, read and follow the instructions in the IBM FileNet P8 High
Availability Technical Notice.
“Encrypting passwords for silent installation and upgrades”
Several passwords are required to silently install Workplace XT. You can
encrypt these passwords using a tool provided with Process Engine before you
enter them into the silent installation resource files.
“Generating the silent installation response files” on page 10
The Workplace XT installation files include a XT_silent_install.txt file that
contains default values for an installation. You can edit the values in this file as
needed, and use the file to run a silent installation. You can also use the
Workplace XT installation program to generate a response file.
“Running the Workplace XT installation silently” on page 12
You can use a command-line option with a response file to install Workplace
XT silently.

Encrypting passwords for silent installation and upgrades:

Several passwords are required to silently install Workplace XT. You can encrypt
these passwords using a tool provided with Process Engine before you enter them
into the silent installation resource files.

To encrypt a password:
1. Locate the encryption tool on the installation media for Process Engine

software, in the Tools directory.
2. Copy the following files from the Tools directory to a local drive:
v fnencryptutils - an executable .jar file
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v RunEncryptApp - a batch file
3. Run RunEncryptApp.bat to invoke the application.
4. Enter the appropriate values for the user name and password.
5. Reenter the password to confirm it.
6. Click Generate.
7. An encrypted password will be generated and displayed in the encrypted

password field.
8. Copy and paste this password into the appropriate silent installation resource

file.

Generating the silent installation response files:

The Workplace XT installation files include a XT_silent_install.txt file that
contains default values for an installation. You can edit the values in this file as
needed, and use the file to run a silent installation. You can also use the Workplace
XT installation program to generate a response file.

The response file generated from the installation program can generate a full
response file recorded from an actual install, or a response file template that
requires further editing. You can reuse response files to create similar installations
of Workplace XT. However, remember to edit the files for significant differences
such as path names for different platforms.

“Creating a response file by editing the silent input file”
The Workplace XT installation software package includes a silent installation
input file that you can edit with your environment values. The installation
program can use the values specified in the file to complete the installation.
“Creating a response file by recording an installation” on page 11
You can use the record option to create a response file based on the choices you
specify in the Workplace XT installation program screens. You can keep this file
as a record of the installation, or edit a copy of it to use as a response file for
similar installations.
“Creating a response file from a template” on page 11
You can use the template option to create a response file that you can edit to
create a customized input file for silent installations. With the template option,
the installation program generates a sample response file without installing
Workplace XT.

Creating a response file by editing the silent input file:

The Workplace XT installation software package includes a silent installation input
file that you can edit with your environment values. The installation program can
use the values specified in the file to complete the installation.

To create a response file:
1. Locate the Workplace XT installation software package, and copy the

XT_silent_install.txt file to a local directory.
2. Follow the instructions in the silent input file to edit the values to reflect the

appropriate responses for your installation.

Important: Even if you accept all defaults in the XT_silent_install.txt file,
you must edit the file to accept the license agreement (-V
licenseAccepted="true").
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Creating a response file by recording an installation:

You can use the record option to create a response file based on the choices you
specify in the Workplace XT installation program screens. You can keep this file as
a record of the installation, or edit a copy of it to use as a response file for similar
installations.

To create a response file:
1. From a command line, navigate to the path of the Workplace XT installation

program.
2. Enter the following command: WorkplaceXT-1.1.4.0-operating_system.bin

-options-record record_file_name

(with no space between -options-record )
where
operating_system is the platform where you are installing Workplace XT, for
example:
AIX, HPUX, HPUXi, LINUX, SOL, WIN, or ZLINUX
(For Windows, the file extension is .exe .)
record_file_name is the name of the response file to be generated, for example,
xt_record.txt.

3. Complete the Workplace XT installation program screens, and click Finish.
The installation program installs Workplace XT. The program creates the
response file with the name that you specified in the same path as the
installation program.

Creating a response file from a template:

You can use the template option to create a response file that you can edit to create
a customized input file for silent installations. With the template option, the
installation program generates a sample response file without installing Workplace
XT.

To create a response file:
1. From a command line, navigate to the path of the Workplace XT installation

program.
2. Enter the following command:

WorkplaceXT-1.1.4.0-operating_system.bin -options-template
template_file_name

(with no space between -options-template)
where
operating_system is the OS where you are installing Workplace XT, for example:
AIX, HPUX, HPUXi, LINUX, SOL, WIN, or ZLINUX
(For Windows, the file extension is .exe.)
template_file_name is the name of the response file to be generated, for example,
xt_template.txt.
The installer runs in initialize mode and generates the response file template
with the name that you specified in the same path as the installation program.

3. Open the template file for editing.
4. Remove the three comment characters (###) before each option.
5. Replace the sample value with the appropriate value for your installation.
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6. Save the changes made to the response file.

Running the Workplace XT installation silently:

You can use a command-line option with a response file to install Workplace XT
silently.

To install the Workplace XT software silently:
1. Collect the parameters needed to complete your installation. For information

about parameter values, see "Installation and upgrade worksheet" in Plan and
Prepare Your Environment for IBM FileNet P8.
HINT With the Data > Filter > AutoFilter command enabled, as it is by default
in the shipping worksheet file ( p8_worksheet.xls ), perform the following actions
to quickly see only the installation properties you must specify for the
Workplace XT installation program:
v Click the AutoFilter drop-down arrow in the "Installation or Configuration

Program" column header and select WPXT installer.
v Click the AutoFilter drop-down arrow in the "Setup Type" column header,

select Custom, and specify: Setup Type contains "Installation."
v Click the AutoFilter drop-down arrow in all other column headers and

select (All).
2. Edit your response file to reflect the options you collected.
3. Log in to the server where you want to install Workplace XT:

Option Description

UNIX Log in as a user with read, write, and
execute access to the directory where you
plan to install Workplace XT.

Windows Log in as a member of the local
Administrators group or a user with
equivalent permissions.

4. From a command prompt, navigate to and run the installation program.

Option Description

UNIX ./WorkplaceXT-1.1.4.0-
operating_system.bin -options "
path_to_edited_input_file/
input_file.txt " -silent

where

operating_system is the platform where you
are installing Workplace XT, for example:

AIX, HPUX, HPUXi, LINUX, SOL, or
ZLINUX

input_file.txt is the response file you
created or the silent input file you edited for
the installation.
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Option Description

Windows WorkplaceXT-1.1.4.0-WIN.exe -options "
path_to_edited_input_file \
input_file.txt " -silent

where input_file.txt is the response file
you created or the silent input file you
edited for the installation.

5. View the web_client_install_log_1.1.4.0.txt file located in install_path
/IBM/FileNet/WebClient.
Verify that no errors or failures were logged. Look for the ERROR designation
at the start of a line. Correct any errors before you proceed.

Installing IBM FileNet Workplace XT software updates
After you install the IBM FileNet Workplace XT software, you must install any
service packs, fix packs, and interim fixes required for Workplace XT.

To install the Workplace XT software updates:
1. To download the latest software updates, and to determine which of these

updates might be required for use with other components and expansion
products, see the IBM FileNet P8 Compatibility Matrix.

2. Open the readmes for the software updates and perform the installation
procedures provided.

Installing the latest Content Engine Client files on Workplace
XT servers

The Content Engine Client software enables communication between the
Workplace XT and the Content Engine. Install the latest release or fix pack version
of the Content Engine Client files on all Workplace XT servers.

“Installing the latest Content Engine Client files on Workplace XT servers
interactively”
The installation wizard provides an interactive way to install the Content
Engine Client files. You can use the values from your worksheet to fill in the
required value for each field on the wizard screens.
“Installing the latest Content Engine Client files on Workplace XT servers
silently” on page 14
The command-line method provides a way to silently install the Content
Engine Client files. You can use the values in your installation worksheet to edit
the silent input text file before you run the installation.

Installing the latest Content Engine Client files on Workplace XT
servers interactively
The installation wizard provides an interactive way to install the Content Engine
Client files. You can use the values from your worksheet to fill in the required
value for each field on the wizard screens.

To install the Content Engine Client files:
1. Open your completed Installation and Upgrade Worksheet file.

Tip: In the worksheet file, verify that the Data → Filter → AutoFilter command
is enabled. To view only Content Engine Client values, filter by CE Client
Installer in the Installation or Configuration Program column.
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2. To download the latest software updates, and to determine which of these
updates might be required for use with other components and expansion
products, see the IBM FileNet P8 Compatibility Matrix.

3. Log on to the server where Workplace XT is installed as any user who has the
following permissions:
v Read and write permission to a temporary directory, such as temp for

Windows or tmp UNIX, on the machine where Workplace XT is installed.
v Execute permission on the Content Engine Client install software.

4. Copy the Content Engine Client installation software from the Content Engine
installation directory to the temporary directory. The version of the installation
software must match the version of Content Engine.

5. Expand the TAR or ZIP of the Content Engine Client installation software
within the temporary directory.

6. Access the Content Engine client installation software.
7. Run the command for your operating system. CE_version is the version of your

Content Engine, for example, 4.5.1.

Operating System Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN

HPUX P8CE-CLIENT-CE_version-HPUX.BIN

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN

Linux P8CE-CLIENT-CE_version-LINUX.BIN

Solaris P8CE-CLIENT-CE_version-SOL.BIN

Windows P8CE-CLIENT-CE_version-WIN.EXE

Linux on System z P8CE-CLIENT-CE_version-ZLINUX.BIN

8. Complete the installation program screens using the parameters you collected
in the Installation and Upgrade Worksheet.
You can specify on the installation panels which applications you want to
update. If the installation program does not automatically detect Workplace XT,
select it on the appropriate panel.
You can also choose to have the installation program create the deployment file,
or create the file later. If you have additional configuration to perform, you can
defer the file creation to avoid running multiple processes to create the same
file.

Installing the latest Content Engine Client files on Workplace XT
servers silently
The command-line method provides a way to silently install the Content Engine
Client files. You can use the values in your installation worksheet to edit the silent
input text file before you run the installation.

To install the Content Engine Client files:
1. Open your completed Installation and Upgrade Worksheet file.

Tip: In the worksheet file, verify that the Data → Filter → AutoFilter command
is enabled. To view only Content Engine Client values, filter by CE Client
Installer in the Installation or Configuration Program column.

2. To download the latest software updates, and to determine which of these
updates might be required for use with other components and expansion
products, see the IBM FileNet P8 Compatibility Matrix.

14 Installation and Upgrade Guide



3. Log on to the server where Workplace XT is installed as any user who has the
following permissions:
v Read and write permission to a temporary directory, such as temp for

Windows or tmp for UNIX, on the machine where Workplace XT is installed.
v Execute permission on the Content Engine Client install software.

4. Copy the Content Engine Client install software from the Content Engine
installation software to the temporary directory. The version of the install
software must match the version of Content Engine.

5. Expand the TAR or ZIP of the Content Engine Client install software within the
temporary directory.

6. Make a backup copy of the input file:
CEClient_silent_install.txt

7. Edit the silent input file to reflect the appropriate responses for your update.
The silent input file provides instructions for editing the values. Use the
parameters recorded in the Installation and Upgrade Worksheet for your
installation.

8. Navigate to the path containing the Content Engine Client installation program.
9. Run one of the commands in the following table to perform the silent install. In

the commands,
CE_version is the version of your Content Engine, for example, 4.5.1.
path is the path that contains the installation program.

Operating
System Install Command

AIX P8CE-CLIENT-CE_version-AIX.BIN -f path/CECLIENT.AIX/
CEClient_silent_install.txt -i silent

HPUX P8CE-CLIENT-CE_version-HPUX.BIN -f path/CEClient.HPUX/
CEClient_silent_install.txt -i silent

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN -f path/CEClient.HPUXI/
CEClient_silent_install.txt -i silent

Linux P8CE-CLIENT-CE_version-LINUX.BIN -f path/CEClient.Linux/
CEClient_silent_install.txt -i silent

Solaris P8CE-CLIENT-CE_version-SOL.BIN -f path/CEClient.Solaris/
CEClient_silent_install.txt -i silent

Windows P8CE-CLIENT-CE_version-WIN.EXE -f path\CEClient.Windows\
CEClient_silent_install.txt -i silent

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN -f path/CEClient.zLinux/
CEClient_silent_install.txt -i silent

Installing the latest Process Engine Client files on Workplace
XT servers

The Process Engine Client software enables communication between the Workplace
XT and the Process Engine. Install the Process Engine Client files on all Workplace
XT servers.

“Installing the latest Process Engine Client files on Workplace XT servers
interactively” on page 16
The installation wizard provides an interactive way to install the Process Engine
Client files. You can use the values you collected on your worksheet to fill in
the required value for each field on the wizard screens.
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“Installing the latest Process Engine Client files on Workplace XT servers
silently” on page 17
You can install the Process Engine Client software on the Workplace XT server
by using a silent input text file and running the installation program from the
command line. Use the values in your installation worksheet to edit the silent
input text file before you run the installation.

Installing the latest Process Engine Client files on Workplace XT
servers interactively
The installation wizard provides an interactive way to install the Process Engine
Client files. You can use the values you collected on your worksheet to fill in the
required value for each field on the wizard screens.

To install the Process Engine Client files:
1. Open your completed Installation and Upgrade Worksheet file.

Tip: In the worksheet file, verify that the Data → Filter → AutoFilter command
is enabled. To view only Process Engine Client values, filter by PE Client
Installer in the Installation or Configuration Program column.

2. To download the latest software updates, and to determine which of these
updates might be required for use with other components and expansion
products, see the IBM FileNet P8 Compatibility Matrix.

3. Log on to the server where Workplace XT is installed as any user who has the
following permissions:
v Read and write permission to a temporary directory, such as temp for

Windows or tmp UNIX, on the machine where Workplace XT is installed.
v Execute permission on the Process Engine Client install software.

4. Copy the Process Engine Client install software from the Process Engine
installation software to the temporary directory. The version of the install
software must match the version of Process Engine.

5. Expand the TAR or ZIP of the Process Engine Client install software within the
temporary directory. The jre.tar file that is packaged with the Process Engine
Client installer must be in the same directory as the Process Engine Client
installation program when the program is run.

6. From Process Task Manager, stop the Component Manager(s) (if running), then
exit the Process Task Manager application.

7. Access the Process Engine Client software.
8. Run the appropriate installation program for your operating system.

In the program command, version is the version of your Process Engine client
and server installation.

Operating System Installation Program

AIX P8PE-CLIENT-version-AIX.BIN

HPUX P8PE-CLIENT-version-HPUX.BIN

HPUXi P8PE-CLIENT-version-HPUXI.BIN

Linux P8PE-CLIENT-version-LINUX.BIN

Solaris P8PE-CLIENT-version-SOL.BIN

Windows P8PE-CLIENT-version-WIN.EXE

Linux on System z P8PE-CLIENT-version-ZLINUX.BIN
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9. Use the parameters you gathered in the Installation and Upgrade Worksheet to
complete the program panels and run the installation.
You can specify on the panels which applications you want to update. If the
installation program does not automatically detect Workplace XT, select it on
the appropriate panel.
You can also choose to have the installation program create the deployment file,
or create the file later. If you have additional configuration to perform, you can
defer the file creation to avoid running multiple processes to create the same
file.

Installing the latest Process Engine Client files on Workplace XT
servers silently
You can install the Process Engine Client software on the Workplace XT server by
using a silent input text file and running the installation program from the
command line. Use the values in your installation worksheet to edit the silent
input text file before you run the installation.

To install the Process Engine Client files:
1. Open your completed Installation and Upgrade Worksheet file.

Tip: In the worksheet file, verify that the Data → Filter → AutoFilter command
is enabled. To view only Process Engine Client values, filter by PE Client
Installer in the Installation or Configuration Program column.

2. To download the latest software updates, and to determine which of these
updates might be required for use with other components and expansion
products, see the IBM FileNet P8 Compatibility Matrix.

3. Log on to the server where Workplace XT is installed as any user who has the
following permissions:
v Read and write permission to a temporary directory, such as temp for

Windows or tmp UNIX, on the machine where Workplace XT is installed.
v Execute permission on the Process Engine Client install software.

4. Copy the Process Engine Client install software from the Process Engine
installation software to the temporary directory. The version of the install
software must match the version of Process Engine.

5. Expand the TAR or ZIP of the Process Engine Client install software within
the temporary directory. The jre.tar file that is packaged with the Process
Engine Client installer must be in the same directory as the Process Engine
Client installation program when the program is run.

6. From Process Task Manager, stop the Component Manager(s) (if running),
then exit the Process Task Manager application.

7. Access the Process Engine Client software.
8. Copy the PEClient_silent_input.txt file to a local directory.
9. Edit the file to reflect the appropriate responses for your installation. The

silent input file provides instructions for editing the values. Use the
parameters recorded in the Installation and Upgrade Worksheet for your
installation.

10. Change the Variable_CheckboxXT line to the following:
-V Variable_CheckboxXT="true"

11. Run the Process Engine Client installer with the command for your operating
system.
In the command, version is the version of your Process Engine Client and
server installation, for example, 4.5.1.
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Operating System Install Program

AIX P8PE-CLIENT-version-AIX.BIN -options
"PEClient_silent_install.txt" -silent

HPUX P8PE-CLIENT-version-HPUX.BIN -options
"PEClient_silent_install.txt" -silent

HPUXi P8PE-CLIENT-version-HPUXI.BIN -options
"PEClient_silent_install.txt" -silent

Linux P8PE-CLIENT-version-LINUX.BIN -options
"PEClient_silent_install.txt" -silent

Solaris P8PE-CLIENT-version-SOL.BIN -options
"PEClient_silent_install.txt" -silent

Windows P8PE-CLIENT-version-WIN.EXE -options
"PEClient_silent_install.txt" -silent

zLinux P8PE-CLIENT-version-ZLINUX.BIN -options
"PEClient_silent_install.txt" -silent

Configuring Workplace XT on the Web application server
After you install Workplace XT and any necessary software updates, you must
configure your Web application server to work with the application. You can
choose the appropriate configuration tasks for your application server type and
environment. Workplace XT can only be deployed in a container-managed
application server environment.

“Configuring Workplace XT on WebSphere Application Server”
After you install the Workplace XT software, you must configure WebSphere
Application Server to work with Workplace XT. You can also configure changes
for optional modes like SSO.
“Configuring IBM FileNet Workplace XT on WebLogic Server” on page 27
After you install Workplace XT, you must configure WebLogic Server to work
with Workplace XT. You can also configure changes for optional modes like
SSO.
“Configuring Workplace XT on JBoss Application Server” on page 37
Before you can use the Workplace XT Web application, you must first configure
the application to work with your application server. You can also configure
changes for optional modes like SSO.

Configuring Workplace XT on WebSphere Application Server
After you install the Workplace XT software, you must configure WebSphere
Application Server to work with Workplace XT. You can also configure changes for
optional modes like SSO.

“Editing web.xml for Single Sign On (SSO) on WebSphere Application Server”
on page 19
If you plan to use Workplace XT in an SSO environment, you must edit the
web.xml file to create the appropriate settings.
“Configuring WebSphere Application Server to support user tokens and
WebDAV connections for Workplace XT” on page 21
Some applications that work with Workplace XT, such as Application
Integration, eForms, and Records Manager, require that you enable the
generation and acceptance of user tokens on the Workplace XT server. This
configuration is also required to enable WebDAV connections. You can verify
these settings in the Bootstrap Settings in the Site Preferences.
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“Configuring Java Virtual Machine settings for memory on WebSphere
Application Server” on page 23
You can use the Java Virtual Machine settings in the WebSphere Application
Server to configure memory settings for resource usage.
“Configuring Lightweight Third Party Authentication (LTPA) on WebSphere
Application Server” on page 23
To set up LTPA security, you must configure settings to match on both the
Content Engine Web application server and the Workplace XT Web application
server. If your Workplace XT and Content Engine are on the same WebSphere
Application Server, you do not need to configure LTPA.
“Configuring stand-alone Lightweight Directory Access Protocol (LDAP)” on
page 25
In order to enable communication between WebSphere and Content Engine,
you must configure LDAP settings on the WebSphere Application Server.
“Configuring Lightweight Directory Access Protocol (LDAP) for federated
repositories” on page 26
If you have a multiple domain environment, configure LDAP settings for
federated repositories on the WebSphere Application Server to enable LDAP
communication between Workplace XT and Content Engine.

Editing web.xml for Single Sign On (SSO) on WebSphere Application Server:

If you plan to use Workplace XT in an SSO environment, you must edit the
web.xml file to create the appropriate settings.

SSO in an IBM Tivoli Access Manager environment might require additional
configuration in WebSphere Application Server. For more details, see your IBM
product documentation.

To edit web.xml for SSO:
1. Make a backup copy of web.xml.

install_path/IBM/FileNet/WebClient/WorkplaceXT/WEB-INF/web.xml

2. Open web.xml for editing.
3. Ensure that the challengeProxyEnabled parameter is set to false, as in the

following example:
<init-param>
<!--
Set this parameter to false if deployment is on WebSphere 6, and see the
commented out sections at the bottom of this file for additional
configuration adjustments.
-->
<param-name>challengeProxyEnabled</param-name>
<param-value>false</param-value>
</init-param>

4. Set the perimeterChallengeMode parameter to true, as in the following
example:
<init-param>
<param-name>perimeterChallengeMode</param-name>
<param-value>true</param-value>
</init-param>

5. Add the following security role element just after the security-constraint
section:
</security-constraint>
- <!-- add login-config element
-->
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<security-role>
<description>everyone</description>
<role-name>everyone</role-name>
</security-role>

6. At the end of web.xml, comment out the <login-config> element, as follows:
<!--
<login-config>
<auth-method>FORM</auth-method>
<realm-name>AE Workplace</realm-name>
<form-login-config>
<form-login-page>/ContainerLogin.jsp</form-login-page>
<form-error-page>/ContainerError.jsp</form-error-page>
</form-login-config>
</login-config>
-->

7. Add the following entry:
<login-config>
<auth-method>CLIENT-CERT</auth-method>
</login-config>

8. As needed, set the ssoProxyContextPath, ssoProxyHost, ssoProxyPort, and
ssoProxySSLPort parameters. These parameter values are used to modify one
or more elements of the native URL that Workplace XT sees on a request.
Wherever the value of an SSO proxy host element in the URL request is
different from the equivalent information for the host where Workplace XT is
deployed, then you must set the corresponding sso* parameter for that element
in the URL to the value for the SSO proxy host in your environment. The
following settings are an example of the default settings:
<init-param>
<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>
</init-param>
<init-param>
<param-name>ssoProxyHost</param-name>
<param-value></param-value>
</init-param>
<init-param>
<param-name>ssoProxyPort</param-name>
<param-value></param-value>
</init-param>
<init-param>
<param-name>ssoProxySSLPort</param-name>
<param-value></param-value>
</init-param>

In general, the init parameters above must be configured as follows:
v ssoProxyContextPath: Set the value to the context path of the SSO proxy host

URL. This is the path portion of the URL that appears after the server name,
and which represents top-level access to the Workplace XT application. For
example, if the Workplace XT deploy host URL is
http://deploy_server:2809/WorkplaceXT

and the SSO proxy host URL is
http://sso_proxy_server.domain.com/WorkplaceXT

then use the following:
<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>

v ssoProxyHost: Set the value to the SSO proxy host server name. Typically,
this will be a full domain-qualified hostname. For example, if the host URL
where Workplace XT is deployed is
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http://deploy_server/WorkplaceXT

and the corresponding SSO proxy host URL is
http://sso_proxy_server/WorkplaceXT

then use the following:
<param-name>ssoProxyHost</param-name>
<param-value>sso_proxy_server</param-value>

v ssoProxyPort: Set the value to the HTTP port on the SSO proxy host. For
example:
<param-name>ssoProxyPort</param-name>
<param-value>80</param-value>

v ssoProxySSLPort: Set the value to the HTTP port on the SSO proxy host, if
defined or used to access Workplace XT pages. For example:
<param-name>ssoProxySSLPort</param-name>
<param-value>443</param-value>

9. Save your changes to web.xml and close the file.

Configuring WebSphere Application Server to support user tokens and WebDAV
connections for Workplace XT:

Some applications that work with Workplace XT, such as Application Integration,
eForms, and Records Manager, require that you enable the generation and
acceptance of user tokens on the Workplace XT server. This configuration is also
required to enable WebDAV connections. You can verify these settings in the
Bootstrap Settings in the Site Preferences.

To configure WebSphere Application Server to support user tokens and WebDAV
connections:
1. Stop WebSphere Application Server, if it is running.
2. (For installations with Content Engine at 4.5.0 or 4.5.1) Copy the

authentication-websphere.jar file from here:
install_path/IBM/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:
WAS_home/AppServer/lib/ext

3. (For installations with Content Engine at 4.0.) Copy the authentication-
websphere.jar file from here:
install_path/IBM/FileNet/WebClient/WorkplaceXT/authenticationFiles/1.1.2

to here:
WAS_home/AppServer/lib/ext

4. Copy the log4j-1.2.13.jar file from here:
install_path/IBM/FileNet/WebClient/WorkplaceXT/WEB-INF/lib

to here:
WAS_home/AppServer/lib/ext

5. Enable JAAS.
a. Navigate to the Java Virtual Machine.

WebSphere Application Server 6.1
Servers → Application Servers → server_name → Java & Process
Management → Process Definition → Java Virtual Machine
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WebSphere Application Server 7.0
Servers → Server Types → WebSphere application servers →
server_name → Java & Process Management → Process Definition →
Java Virtual Machine

b. If there is an entry in the Generic JVM arguments, add a space after it,
then add the following entry and apply your changes.
If there is no entry, do not add the space.

UNIX -Djava.security.auth.login.config=install_path/CE_API/config/
jaas.conf.WebSphere

Windows
-Djava.security.auth.login.config=install_path\CE_API\config\
jaas.conf.WebSphere

where install_path is the installation path of Workplace XT.
Your path might be slightly different depending on the version of your
client installations, or whether you have chosen a custom path for
installation. For example, if your Content Engine Client is at 4.0, this path
might include a samples directory under the config directory. Verify the
location of the file before you enter the path.
Do not copy and paste the text from this guide because hidden formatting
can cause problems with the entry. Instead, type the entry into the field.
On WebSphere Application Server for Windows, the path cannot contain a
space. You must use 8.3 notation for the install path portion of the djava
argument.
If install_path is:
C:\Program Files\IBM\FileNet\WebClient

use:
C:\Progra~1\IBM\FileNet\WebClient

c. (For components not using SSO only) Create a custom module.

Important: Do not create a custom module if you are enabling JAAS for
any component using SSO. Creating the custom module makes SSO
unusable.
1) Navigate to the JAAS login module settings in the Security area of the

administration console.

WebSphere Application Server 6.1
Navigate to Security → Secure administration, applications, and
infrastructure → JAVA Authentication and Authorization
Service → System logins → WEB_INBOUND → JAAS login
modules.

WebSphere Application Server 7.0
Navigate to Security → Global security → JAVA Authentication
and Authorization Service → System logins → WEB_INBOUND.

2) Click New to create a new custom login module.
3) Enter the following with no spaces for the Module class name setting:

com.filenet.ae.authentication.
loginmodule.UserTokenWSLoginModule

4) Apply and save your changes to the master configuration.
6. Enable trust association and specify the interceptor setting.

22 Installation and Upgrade Guide



a. Navigate to the trust association settings in the Security area of the
administration console.

WebSphere Application Server 6.1
Navigate to Security → Secure administration, applications, and
infrastructure → Web security → Trust association.

WebSphere Application Server 7.0
Navigate to Security → Global security → Web and SIP security →
Trust association.

b. In the Trust associations settings, set Enable trust association.
c. Under Additional Properties, click Interceptors.
d. Add a new Interceptor, and enter the following for the Interceptor class

name: com.filenet.ae.authentication.tai.UserTokenInterceptor
e. Apply and save your changes to the master configuration.

7. Restart WebSphere Application Server.

Configuring Java Virtual Machine settings for memory on WebSphere
Application Server:

You can use the Java Virtual Machine settings in the WebSphere Application Server
to configure memory settings for resource usage.

To configure Java Virtual Machine settings:
1. Log in to the WebSphere administrative console.
2. Navigate to the Java Virtual Machine.

Option Description

WebSphere Application Server 6.1 Servers → Application Servers →
server_name → Java & Process Management
→ Process Definition → Java Virtual Machine

WebSphere Application Server 7.0 Servers → Server Types → WebSphere
application servers → server_name → Java &
Process Management → Process Definition →
Java Virtual Machine

3. Set the Initial heap size and Maximum heap size.
Refer to your application server vendor recommendation for Initial and
Maximum heap size values. For more information on performance tuning, see
the IBM FileNet P8 Performance Tuning Guide.

4. Save your changes.

Configuring Lightweight Third Party Authentication (LTPA) on WebSphere
Application Server:

To set up LTPA security, you must configure settings to match on both the Content
Engine Web application server and the Workplace XT Web application server. If
your Workplace XT and Content Engine are on the same WebSphere Application
Server, you do not need to configure LTPA.

Attention: If you already have Application Engine or Workplace XT in your
environment, you do not need to create the LTPA settings on the Content Engine.
Skip to the step for creating the settings on the Workplace XT server.

To configure LTPA:
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1. Create the LTPA settings on the Content Engine WebSphere Application Server.
a. On the Content Engine server, log in to the WebSphere administrative

console.
b. Navigate to the LTPA settings page:

WebSphere Application Server 6.1
Navigate to Security → Secure administration, applications, and
infrastructure.

From the right side of the panel, select Authentication Mechanisms
and expiration.

WebSphere Application Server 7.0
Navigate to Security → Global security.

From the right side of the panel, select LTPA.
c. Enter a value that is larger than the default for the Timeout value for

forwarded credentials between servers setting on WebSphere Application
Server 6.1 or the LTPA timeout setting on WebSphere Application Server
7.0. For example, if the timeout value is left at the default value of 120
minutes, the LTPA key expires after 2 hours. Users will not be able to log in
to Workplace XT after being logged in for 2 hours.

d. Save your changes.
e. In the box for Cross-cell single sign-on, type a password to create the

LTPA password.
f. For password restrictions, see the WebSphere Application Server

documentation. If you have already configured Content Engine for LTPA,
use the existing password in the Workplace XT configuration below.

g. Enter the fully qualified path for the Key File Name. For example,
/opt/LTPA/ltpa_key_name.

h. Click Export keys.
i. Verify that a message similar to the following message is displayed: The

keys were successfully exported to the file ltpa_key_name.
j. Click Import keys.
k. Click OK, then click Save changes directly to the master configuration.
l. Stop and restart WebSphere Application Server.
m. Copy the key file from the Content Engine server location you specified

above to a directory on the Workplace XT server. For example,
/opt/LTPA/ltpa_key_name.

2. Create the LTPA settings on the Workplace XT WebSphere Application Server
server.
a. On the Workplace XT server, log in to the WebSphere administrative

console.
b. Navigate to the LTPA settings page:

WebSphere Application Server 6.1
Navigate to Security → Secure administration, applications, and
infrastructure.

From the right side of the panel, select Authentication Mechanisms
and expiration.

WebSphere Application Server 7.0
Navigate to Security → Global security.

From the right side of the panel, select LTPA.

24 Installation and Upgrade Guide



c. Enter a value for the LTPA timeout that is larger than the default. For
example, if the timeout value is left at the default value of 120 minutes, the
LTPA key expires after 2 hours. Users will not be able to log in to
Workplace XT after being logged in for 2 hours.

d. Save your changes.
e. In the box for Cross-cell single sign-on, type and confirm the LTPA

password you created for Content Engine.
For password restrictions, see the WebSphere Application Server
documentation. If you have already configured Content Engine for LTPA,
use the existing password in the Workplace XT configuration.

f. Specify the path for the key file that you copied to the Workplace XT server.
For example, /opt/LTPA/ltpa_key_name.

g. Click Import keys. Verify that a message similar to the following one is
displayed: The keys were successfully imported from the file ltpa_key_name.

h. Save your changes to the master configuration.

Configuring stand-alone Lightweight Directory Access Protocol (LDAP):

In order to enable communication between WebSphere and Content Engine, you
must configure LDAP settings on the WebSphere Application Server.

To configure stand-alone LDAP:
1. Open the WebSphere administrative console.
2. Navigate to the security settings page.

Option Description

WebSphere Application Server 6.1 Navigate to Security → Secure
administration, applications, and
infrastructure.

WebSphere Application Server 7.0 Navigate to Security → Global security.

3. Disable security using the following Security settings:
v Turn off (clear) the Enable Administrative Security flag.
v Turn off (clear) the Enable application security flag.
v Turn off (clear) the Use Java 2 security to restrict application access to

local resources security flag.
4. From the bottom of the panel, in the dropdown list called Available realm

definitions, select Standalone LDAP registry and click Configure.
5. Configure the LDAP provider to exactly match the corresponding settings on

the Content Engine application server.

Tip: Open the WebSphere administrative console for Content Engine to the
same panels to see and copy all settings.
v Primary administrative user name

v Automatically generated server identity

v Type

v Host

v Port

v Base distinguished name (DN)

v Bind distinguished name (DN)
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v Bind password

6. Configure the LDAP user registry settings to exactly match the corresponding
settings on the Content Engine application server.

Tip: Open the WebSphere administrative console for Content Engine to the
same panel to see and copy all settings.
v User filter

v Group filter

v User ID map

v Group member ID map

v Certificate map mode

v Certificate filter

7. Save these settings.
8. Next to Available realm definitions, ensure that Standalone LDAP registry is

still selected, and click Set as current.
9. Re-enable the following Security settings:
v Turn on (select) the Enable Administrative Security flag.
v Turn on (select) the Enable application security flag.
v Turn off (clear) the Use Java 2 security to restrict application access to

local resources flag.
The IBM FileNet P8 Platform uses LDAP-based security, and does not support
Java 2 security. Enabling Java 2 security will cause unexpected behavior.

10. Save your changes to the master configuration.
11. Test the connection on the Standalone LDAP registry page. If the test fails,

correct the error before proceeding. If it passes, click OK to return to the
previous page.
If you see a message about the ID not existing in the user repository, you can
ignore it.

12. Stop and restart the application server.

Configuring Lightweight Directory Access Protocol (LDAP) for federated
repositories:

If you have a multiple domain environment, configure LDAP settings for federated
repositories on the WebSphere Application Server to enable LDAP communication
between Workplace XT and Content Engine.

Important: If you are using federated repositories, your WebSphere administrative
console user cannot have the same username or ID as a user in the LDAP
repository.

To configure LDAP for federated repositories:
1. Open the WebSphere administrative console.
2. Navigate to the security settings page.

Option Description

WebSphere Application Server 6.1 Navigate to Security → Secure
administration, applications, and
infrastructure.

WebSphere Application Server 7.0 Navigate to Security → Global security.
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3. Disable the following Security settings:
v Turn off (clear) the Enable Administrative Security flag.
v Turn off (clear) the Enable application security flag.
v Turn off (clear) the Use Java 2 security to restrict application access to

local resources flag.
4. From the bottom of the panel, in the dropdown list called Available realm

definitions, select Federated Repositories and click Configure.
5. Configure the LDAP provider to exactly match the corresponding General

Properties on the Content Engine application server.

Tip: Open the WebSphere administrative console for Content Engine to the
same panels to see and copy all settings.
v Realm name

v Primary administrative user name

v Automatically generated server identity

v Ignore case for authorization

v Repositories in the realm

6. Save these settings.
7. Next to Available realm definitions, ensure that Federated repositories is still

selected, and click Set as current.
8. Re-enable the following Security settings:
v Turn on (select) the Enable Administrative Security flag.
v Turn on (select) the Enable application security flag.
v Turn off (clear) the Use Java 2 security to restrict application access to

local resources flag.
The IBM FileNet P8 Platform uses LDAP-based security, and does not support
Java 2 security. Enabling Java 2 security will cause unexpected behavior.

9. Save your changes to the master configuration.
10. Test the connection on the Federated repositories page. If the test fails, correct

the error before proceeding. If it passes, click OK to return to the previous
page.

Configuring IBM FileNet Workplace XT on WebLogic Server
After you install Workplace XT, you must configure WebLogic Server to work with
Workplace XT. You can also configure changes for optional modes like SSO.

“Editing web.xml for SSO (WebLogic)” on page 28
If you plan to use Workplace XT in an SSO environment, you must edit the
web.xml file to create the appropriate settings.
“Setting up JAAS login information for authentication and memory settings for
resource usage on WebLogic Server for UNIX” on page 30
You can set up JAAS login information and configure memory settings by
editing WebLogic Server files.
“Enabling trust between the Content Engine domain and the Workplace XT
domain” on page 35
In order to enable Workplace XT to communicate with the Content Engine, you
must enable trust between the Content Engine domain and the Workplace XT
domain. This configuration applies only if Workplace XT and Content Engine
are in different domains.
“Configuring Lightweight Directory Access Protocol (LDAP)” on page 35
To enable communication between Content Engine and Workplace XT, you
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must configure the LDAP settings on the Workplace XT server to match the
settings on the Content Engine server. You can create these settings with an
Authentication Provider in WebLogic Server.
“Configuring WebLogic Server to support user tokens and WebDAV
connections for Workplace XT used with other applications” on page 36
If you are using Workplace XT with other applications, such as Application
Integration, eForms, or Records Manager, you must enable support for user
tokens and WebDAV connections. You can verify these settings in the Bootstrap
Settings in the Site Preferences.

Editing web.xml for SSO (WebLogic):

If you plan to use Workplace XT in an SSO environment, you must edit the
web.xml file to create the appropriate settings.

SSO in an IBM Tivoli Access Manager environment might require additional
configuration. For more details, see your IBM product documentation.

To edit web.xml for SSO:
1. Make a backup copy of web.xml.

The file is in the following path: install_path/IBM/FileNet/WebClient/
WorkplaceXT/WEB-INF/web.xml

2. Edit web.xml.
3. Set the parameter perimeterChallengeMode to true, as in:

<init-param>
<param-name>perimeterChallengeMode</param-name>
<param-value>true</param-value>
</init-param>

4. As needed, set the ssoProxyContextPath, ssoProxyHost, ssoProxyPort, and
ssoProxySSLPort. These parameter values are used to modify one or more
elements of the native URL that Workplace XT sees on a request. Wherever the
value of an SSO proxy host element in the URL request is different from the
equivalent information for the host where Workplace XT is deployed, then you
must set the corresponding sso* parameter for that element in the URL to the
value for the SSO proxy host. The default settings are:
<init-param>
<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>
</init-param>
<init-param>
<param-name>ssoProxyHost</param-name>
<param-value></param-value>
</init-param>
<init-param>
<param-name>ssoProxyPort</param-name>
<param-value></param-value>
</init-param>
<init-param>
<param-name>ssoProxySSLPort</param-name>
<param-value></param-value>
</init-param>

In general, the init parameters above should be configured as follows:
v ssoProxyContextPath: Set the value to the context path of the SSO proxy host

URL. This is the path portion of the URL that appears after the server name,
and which represents top-level access to the Workplace XT application. For
example, if the Workplace XT deploy host URL is
http://deploy_server:7001/WorkplaceXT
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and the SSO proxy host URL is
http://sso_proxy_server.domain.com/WorkplaceXT

then use the following value:
<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>

v ssoProxyHost: Set the value to the SSO proxy host server name. Typically,
this will be a full domain-qualified hostname. For example, if the host URL
where Workplace XT is deployed is
http://deploy_server/WorkplaceXT

and the corresponding SSO proxy host URL is
http://sso_proxy_server/WorkplaceXT

then use the following value:
<param-name> ssoProxyHost </param-name>
<param-value>sso_proxy_server</param-value>

v ssoProxyPort: Set the value to the HTTP port on the SSO proxy host. For
example:
<param-name>ssoProxyPort</param-name>
<param-value>80</param-value>

v ssoProxySSLPort: Set the value to the HTTPS port on the SSO proxy host, if
it is defined or used to access Workplace XT pages. For example:
<param-name>ssoProxySSLPort</param-name>
ram-value>443</param-value>

5. (For SSO with Kerberos only ) In the exclude list of the AE PreprocessorFilter
section, remove the following entries:
/integrationCommand*
/transport*
/bootstraptransport

as shown in the following sample exclude list:
<filter>
<filter-name>AE PreprocessorFilter</filter-name>
<filter-class>
com.filenet.ae.toolkit.server.servlet.filter.PreprocessorFilter
</filter-class>
<init-param>
<param-name>challenge</param-name>
<param-value>false</param-value>
</init-param>
<init-param>
<param-name>exclude</param-name>
<param-value>
/css/*,
/download/*,
/FnJavaV1Files/*,
/images/*,
/js/*,
/scripts/*,
/Samples*,
/Source*,
/UI-INF/*,
/integrationCommand*,
/integrationResponse*,
/transport*,
/ContainerError.jsp,
/ContainerLogin.jsp,
/ContainerSignout.jsp,
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/ServerErrorDisplay.jsp,
/containerSecured/*,
/WcmError.jsp,
/WcmSignIn.jsp,
/GetUserToken.jsp,
/GetTokenSignIn.jsp,
/GetUserInformation.jsp,
/axis,
/axis/services/*,
/servlet/AdminServlet,
/setCredentials,
/SOAPMonitor,
/webdav*,
/P8BPMWSBroker/*,
*j_security_check*,
/bootstraptransport,
/pingSession,
/unitTests*,
/NoContent.jsf,
/ServerErrorDisplay.jsf,
/LoadJSResources.jsf,
/SessionError.jsf
</param-value>
</init-param>
</filter>

6. (For SSO with Kerberos only) In the security-constraint section, add the
following URL patterns:
<url-pattern>/integrationCommand</url-pattern>
<url-pattern>/transport</url-pattern>
<url-pattern>/bootstraptransport</url-pattern>
<url-pattern>/getContent</url-pattern>

as shown in the following sample:
<security-constraint>
<web-resource-collection>
<web-resource-name>action</web-resource-name>
<description>Define the container secured resource</description>
<url-pattern>/containerSecured/*</url-pattern>
<url-pattern>/integrationCommand</url-pattern>
<url-pattern>/transport</url-pattern>
<url-pattern>/bootstraptransport</url-pattern>
<url-pattern>/getContent</url-pattern>
</web-resource-collection>
<auth-constraint>
<role-name>*</role-name>
</auth-constraint>
<user-data-constraint>
<description>User data constraints</description>
<transport-guarantee>NONE</transport-guarantee>
</user-data-constraint>
</security-constraint>

7. Save your changes to web.xml and close the file.

Setting up JAAS login information for authentication and memory settings for
resource usage on WebLogic Server for UNIX:

You can set up JAAS login information and configure memory settings by editing
WebLogic Server files.

“Setting up JAAS login information for authentication and memory settings for
resource usage on WebLogic Server for UNIX” on page 31
You can set up JAAS login information and configure memory settings for
UNIX by editing WebLogic Server files.
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“Setting up JAAS login information for authentication and memory settings for
resource usage on WebLogic Server for Windows” on page 33
You can set up JAAS login information and configure memory settings for
Windows by editing WebLogic Server files.

Setting up JAAS login information for authentication and memory settings for resource
usage on WebLogic Server for UNIX:

You can set up JAAS login information and configure memory settings for UNIX
by editing WebLogic Server files.

To set up JAAS LOGIN information:
1. Stop WebLogic Server, if it is running.
2. Make a backup copy of the setDomainEnv.sh file.
3. Do one of the following to edit the MEM_ARGS variable in the setDomainEnv

file:
v For all systems except those using JRockit Java:

Find the MEM_ARGS variable and append the following to any existing
settings:
-XX:MaxPermSize=size m
where size is the value, in MB, of the MaxPermSize. Refer to your
application server vendor recommendation for a value for your
configuration. For more information about performance tuning, see the IBM
FileNet P8 Performance Tuning Guide.

v For systems using JRockit Java:
Find the MEM_ARGS variable and append the following to any existing
settings:
-Xgc:gencon

If the MEM_ARGS variable does not exist, add it to the setDomainEnv.sh file.
4. If your application server uses the IBM JVM, edit the JAVA_OPTIONS variable

to improve performance.
Modify the following line in the setDomainEnv file:
JAVA_OPTIONS="${JAVA_OPTIONS} ${JAVA_PROPERTIES}
-Dwlw.iterativeDev=${iterativeDevFlag}
-Dwlw.testConsole=${testConsoleFlag} -Dwlw.logErrorsToConsole=

${logErrorsToConsoleFlag}" export JAVA_OPTIONS

insert these entries (without a carriage return) before the export
JAVA_OPTIONS line:
-Dprogram.name=$PROGNAME -Dfilenet.pe.peorb.pool.min=2
-Dfilenet.pe.peorb.pool.max=5"

Result:
JAVA_OPTIONS="${JAVA_OPTIONS} ${JAVA_PROPERTIES}
-Dwlw.iterativeDev=${iterativeDevFlag}
-Dwlw.testConsole=${testConsoleFlag} -Dwlw.logErrorsToConsole=

${logErrorsToConsoleFlag} - Dprogram.name=$PROGNAME
-Dfilenet.pe.peorb.pool.min=2 -Dfilenet.pe.peorb.pool.max=5" export
JAVA_OPTIONS

5. Configure JAAS login. Add one of the following right after the classpath entry
for WebLogic Server.
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Enter the JAAS_LOGIN entry as a single line without line breaks. Do not copy
and paste the text from this guide because hidden formatting can cause
problems with the entry. Instead, type the entry into the script.

Important: Your path might be slightly different depending on the version of
your client installations, or whether you have chosen a custom path for
installation. For example, if your Content Engine Client is at 4.0, this path
might include a samples directory under the config directory. Verify the
location of the file before you enter the path.

Option Description

AIX # JAAS LOGIN configuration setting

JAAS_LOGIN="${JAAS_LOGIN}"
-Djava.security.auth.login.config= "
install_path /IBM/FileNet/WebClient/
CE_API/config/jaas.conf.WebLogic"

JAAS_LOGIN="${JAAS_LOGIN}"
-Dlogin.configuration.provider=

com.ibm.security.auth.login.ConfigFile

where install_path is the location where you
installed Workplace XT. For example,

"/opt/IBM/FileNet/WebClient/CE_API
/config/jaas.conf.WebLogic"

UNIX # JAAS LOGIN configuration setting

JAAS_LOGIN="${JAAS_LOGIN}"
-Djava.security.auth.login.config=
"install_path /IBM/FileNet/WebClient/
CE_API/config/jaas.conf.WebLogic"

where install_path is the location where you
installed Workplace XT. For example,

"/opt/IBM/FileNet/WebClient/CE_API
/config/jaas.conf.WebLogic"

6. Save and close the setDomainEnv.sh file.
7. Make a backup copy of the application server startup script.
v If you are using a WebLogic Server domain, modify startWebLogic.sh.
v If you are not using a WebLogic Server domain, modify startWLS.sh.

8. Use a text editor to open and edit the application server startup script.
9. Add JAAS_LOGIN section as indicated in the examples below.

${JAVA_HOME}/bin/java ${JAVA_VM} -version
if [ "${WLS_REDIRECT_LOG}" = "" ] ;
then
echo "Starting WLS with line:"
echo "${JAVA_HOME}/bin/java
${JAVA_VM}
${MEM_ARGS} ${JAVA_OPTIONS}
-Dweblogic.Name=${SERVER_
NAME} -Djava.security.policy=
${WL_HOME}/server/lib
/weblogic.policy
${PROXY_SETTINGS}
${SERVER_CLASS
}"
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${JAVA_HOME}/bin/java
${JAVA_VM} ${MEM_ARGS}
${JAVA_OPTIONS} ${JAAS_LOGIN}
-Dweblogic.Name=${SERVER_NAME}
-Djava.security.policy=
${WL_HOME}
/server/lib/weblogic.policy
${PROXY_SETTINGS} ${SERVER_
CLASS}
else
echo "Redirecting output from
WLS window
to ${WLS_REDIRECT_LOG}"
${JAVA_HOME}/bin/java
${JAVA_VM}
${MEM_ARGS} ${JAVA_OPTIONS}
${JAAS_LOGIN}
-Dweblogic.Name=${SERVER_NAME}
-Djava.security.policy=
${WL_HOME}
/server/lib/weblogic.policy
${PROXY_SETTINGS}
${SERVER_CLASS}
>"${WLS_REDIRECT_LOG}" 2>&1
fi

10. Save and close the application server startup script file.

Setting up JAAS login information for authentication and memory settings for resource
usage on WebLogic Server for Windows:

You can set up JAAS login information and configure memory settings for
Windows by editing WebLogic Server files.

To set up JAAS LOGIN information:
1. Stop WebLogic Server, if it is running.
2. Make a backup copy of the setDomainEnv.cmd file.
3. Do one of the following to edit the MEM_ARGS variable in the

setDomainEnv.cmd file:
v For all systems except those using JRockit Java:

Find the MEM_ARGS variable and append the following to any existing
settings:
-XX:MaxPermSize=size m
where size is the value, in MB, of the MaxPermSize. Refer to your
application server vendor recommendation for a value for your
configuration. For more information about performance tuning, see the IBM
FileNet P8 Performance Tuning Guide.

v For systems using JRockit Java:
Find the MEM_ARGS variable and append the following to any existing
settings:
-Xgc:gencon

If the MEM_ARGS variable does not exist, add it to the startup script.
4. If your application server uses the IBM JVM, edit the JAVA_OPTIONS variable

to improve performance.
Modify the following line in the setDomainEnv.cmd file:
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set JAVA_OPTIONS=%JAVA_OPTIONS% %JAVA_PROPERTIES% -Dwlw.iterativeDev=
%iterativeDevFlag% -Dwlw.testConsole=%testConsoleFlag%
-Dwlw.logErrorsToConsole=%logErrorsToConsoleFlag%

insert these entries (without a carriage return) after the
%JAVA_PROPERTIES%:
-Dprogram.name=%PROGNAME% -Dfilenet.pe.peorb.pool.min=2
-Dfilenet.pe.peorb.pool.max=5Result:

Result:
set JAVA_OPTIONS=%JAVA_OPTIONS% %JAVA_PROPERTIES% -Dprogram.name=
%PROGNAME% -Dfilenet.pe.peorb.pool.min=2 -Dfilenet.pe.peorb.pool.max=5
-Dwlw.iterativeDev=%iterativeDevFlag% -Dwlw.testConsole=
%testConsoleFlag% -Dwlw.logErrorsToConsole=%logErrorsToConsoleFlag%

5. Configure JAAS login. Add one of the following right after the classpath entry
for WebLogic Server.
Enter the JAAS_LOGIN entry as a single line without line breaks. Do not copy
and paste the text from this guide because hidden formatting can cause
problems with the entry. Instead, type the entry into the script.

Important: Your path might be slightly different depending on the version of
your client installations, or whether you have chosen a custom path for
installation. For example, if your Content Engine Client is at 4.0, this path
might include a samples directory under the config directory. Verify the
location of the file before you enter the path.
@REM JAAS LOGIN configuration setting

set JAAS_LOGIN=%JAAS_LOGIN% -Djava.security.auth.login.config=
"install_path \IBM\FileNet\WebClient\CE_API\config\jaas.conf.WebLogic"

where install_path is the location where you installed Workplace XT. For
example,
"C:\Program Files\IBM\FileNet
\WebClient\CE_API\config\
jaas.conf.weblogic"

6. Save and close the setDomainEnv.cmd file.
7. Make a backup copy of the application server startup script.
v If you are using a WebLogic Server domain, modify startWebLogic.cmd.
v If you are not using a WebLogic Server domain, modify startWLS.cmd.

8. Use a text editor to open and edit the application server startup script.
9. Add JAAS_LOGIN section as indicated in the example below.

If "%WLS_REDIRECT_LOG%"==""(
echo Starting WLS with line:
echo %JAVA_HOME%\bin\java
%JAVA_VM%
%MEM_ARGS% %JAVA_OPTIONS%
%JAAS_LOGIN%
-Dweblogic.Name=%SERVER_NAME%
-Djava.security.policy=
%WL_HOME%
\server\lib\weblogic.policy
%PROXY_SETTINGS% %SERVER_CLASS%
%JAVA_HOME%\bin\java %JAVA_VM%
%MEM_ARGS% %JAVA_OPTIONS%
%JAAS_LOGIN%
-Dweblogic.Name=%SERVER_NAME%
-Dweblogic.management.username=
%WLS_USER%
-Dweblogic.management.password=
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%WLS_PW%
-Djava.security.policy=
%WL_HOME%\server\lib
\weblogic.policy
%PROXY_SETTINGS% %SERVER_CLASS%
) else (
echo Redirecting output from
WLS window
to %WLS_REDIRECT_LOG%
%JAVA_HOME%\bin\java %JAVA_VM%
%MEM_ARGS% %JAVA_OPTIONS%
%JAAS_LOGIN%
-Dweblogic.Name=%SERVER_NAME%
-Dweblogic.management.username=
%WLS_USER%
-Dweblogic.management.password=
%WLS_PW% -Djava.security.policy=
%WL_HOME%\server\lib\weblogic.policy
%PROXY_SETTINGS% %SERVER_CLASS%
>"%WLS_REDIRECT_LOG%" 2>&1

10. Save and close the application server startup script file.

Enabling trust between the Content Engine domain and the Workplace XT
domain:

In order to enable Workplace XT to communicate with the Content Engine, you
must enable trust between the Content Engine domain and the Workplace XT
domain. This configuration applies only if Workplace XT and Content Engine are
in different domains.

To enable trust between the WebLogic Server domains:
1. On the Content Engine server, prepare the WebLogic Server Administration

Console for editing.

Remember: If you have already configured a trust on the Content Engine,
perform these steps only on the Workplace XT server. You will need to use the
same password as the one used on the Content Engine.

2. In the advanced security settings for your domain, enter a password for the
domain.

3. Save and activate your changes.
4. Restart the WebLogic Server if needed.
5. On the Workplace XT server, prepare the WebLogic Server Administration

Console for editing.
6. In the advanced security settings for your domain, enter a password for the

domain. You must enter the same password for both the Content Engine
domain and the Workplace XT domain.

7. Repeat this procedure in each domain for which you want to enable trust.

Configuring Lightweight Directory Access Protocol (LDAP):

To enable communication between Content Engine and Workplace XT, you must
configure the LDAP settings on the Workplace XT server to match the settings on
the Content Engine server. You can create these settings with an Authentication
Provider in WebLogic Server.

To configure Workplace XT:

Installing IBM FileNet Workplace XT 35



1. Refer to your Content Engine installation worksheet and the WebLogic Server
Administration Console settings for Compatibility Security → Realms for
Authentication Provider, users, and groups on your Content Engine.

2. On the Workplace XT WebLogic Server, create a new Authentication Provider of
the same type as the LDAP Authentication Provider on the Content Engine.

3. Configure the new Authentication Provider to have the same Provider Specific
LDAP settings as the Content Engine provider.
v Group Base DN

v User Name Attribute

v Port

v User Base DN

v Principal

v Credential

v Confirm Credential

v Host

v User From Name Filter

v Group From Name Filter

4. For both the default and the new Authentication Provider, under Common
Settings for DefaultAuthenticator, ensure that the Control Flag is set to
SUFFICIENT.

5. Save your changes.
6. Restart the application server.

Configuring WebLogic Server to support user tokens and WebDAV connections
for Workplace XT used with other applications:

If you are using Workplace XT with other applications, such as Application
Integration, eForms, or Records Manager, you must enable support for user tokens
and WebDAV connections. You can verify these settings in the Bootstrap Settings in
the Site Preferences.

To configure WebLogic Server to support user tokens and WebDAV connections:
1. Stop WebLogic Server, if it is running.
2. (For installations with Content Engine at 4.5) Copy the authentication-

weblogic.jar file from here:
install_path/IBM/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:
WL_home/server/lib/mbeantypes

3. (For installations with Content Engine at 4.0) Copy the authentication-
weblogic.jar file from here:
install_path/IBM/FileNet/WebClient/WorkplaceXT/authenticationFiles/
1.1.2

to here:
WL_home/server/lib/mbeantypes

4. Copy the log4j-1.2.13.jar file from here:
install_path/IBM/FileNet/WebClient/WorkplaceXT/WEB-INF/lib

to here:
WL_home/server/lib/mbeantypes

5. Restart the WebLogic Server, and log in to the Administration Console.
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6. Add a new authentication provider, with a name you choose, and set the type
to UserTokenAuthenticator.

7. Move the new provider ahead of the LDAP provider in the order.
8. Configure settings for the new provider:

a. On the Configuration tab, set the Control Flag to SUFFICIENT. Click
Save.

b. On the Provider Specific tab, enter the path to the Workplace XT
WcmApiConfig.properties file, for example, install_path/IBM/FileNet/
WebClient/WorkplaceXT/WEB-INF/WcmApiConfig.properties, then click
Save.

9. Save and activate changes.
10. Restart the WebLogic Server.

Configuring Workplace XT on JBoss Application Server
Before you can use the Workplace XT Web application, you must first configure the
application to work with your application server. You can also configure changes
for optional modes like SSO.

“Configuring Java and JAAS settings”
The Workplace XT Web application on JBoss Application Server requires certain
JAVA and JAAS settings to work within the IBM FileNet P8 environment. These
settings enable authentication and regulate memory resource usage.
“Configuring JBoss Application Server for Workplace XT” on page 39
Before you can use the Workplace XT Web application, you must first configure
the application to work with JBoss Application Server.
“Configuring JBoss Application Server to support user tokens and WebDAV
connections for Workplace XT used with other applications” on page 43
If you are using Workplace XT with other applications, such as Application
Integration, eForms, or Records Manager, you must enable support for user
tokens and WebDAV connections. You can verify these settings in the Bootstrap
Settings in the Site Preferences.

Configuring Java and JAAS settings:

The Workplace XT Web application on JBoss Application Server requires certain
JAVA and JAAS settings to work within the IBM FileNet P8 environment. These
settings enable authentication and regulate memory resource usage.

“Configuring Java and JAAS settings for UNIX”
You can use settings in the JBoss Application Server on UNIX to set up JAVA
and memory settings, and JAAS login information for authentication for your
Workplace XT Web application.
“Configuring Java and JAAS settings for Windows” on page 38
You can use settings in the JBoss Application Server on Windows to set up
JAVA and memory settings, and JAAS login information for authentication for
your Workplace XT Web application.

Configuring Java and JAAS settings for UNIX:

You can use settings in the JBoss Application Server on UNIX to set up JAVA and
memory settings, and JAAS login information for authentication for your
Workplace XT Web application.

To configure Java and JAAS settings:
1. Stop JBoss Application Server, if it is running.
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2. Make a backup copy of the JBoss Application Server configuration file
run.conf.

3. Open run.conf for editing.
4. Edit the Java settings.

a. Add a line to specify the path to the JDK on the machine where JBoss
Application Server is installed, as shown in the following example:
JAVA_HOME=/export/home/apps/jboss/jdk1.5.0_06

If your JDK 1.5.0 version is different, substitute your version for the one
listed above (_06).

b. Update the JAVA_OPTS memory settings.
Adjusting this setting prevents the application server from running out of
memory, a condition in which users would not be able to log in to
Workplace XT.
In the first JAVA_OPTS entry, as per the examples below, change the -Xms
and -Xmx values for your configuration.
JAVA_OPTS=$JAVA_OPTS -Xms128m -Xmx512m

See your application server vendor recommendation for Initial and
Maximum heap size values. For IBM specific recommendations, see the IBM
FileNet P8 Performance Tuning Guide.

c. If your application server uses the IBM JVM, edit the JAVA_OPTS variable in
the run.conf file immediately after the line in the previous substep. This
JAVA_OPTS edit improves performance.
Find the following line in the run.conf file:
JAVA_OPTS="$JAVA_OPTS -Dprogram.name=$PROGNAME"

and change it to this (without a carriage return):
JAVA_OPTS="$JAVA_OPTS -Dprogram.name=$PROGNAME
-Dfilenet.pe.peorb.pool.min=2 -Dfilenet.pe.peorb.pool.max=5"

d. Save your changes.
5. Configure JAAS login by adding an entry to the run.conf file.

The path for your entry might be slightly different depending on the version of
your client installations, or whether you have chosen a custom path for
installation. For example, if your Content Engine Client is at 4.0.x, this path
might include a samples directory under the config directory. Verify the
location of the jaas.conf.JBoss file before you enter the path.

Important: Enter the JAAS login entry as a single line without line breaks. Do
not copy and paste the text from this guide because hidden formatting can
cause problems with the entry. Instead, type the entry into the script.
Add this entry to the end of the run.conf file:
JAVA_OPTS="$JAVA_OPTS -Djava.security.auth.login.config=/opt/FileNet/
WebClient/CE_API/config/jaas.conf.JBoss"

6. Save and close the run.conf file.

Configuring Java and JAAS settings for Windows:

You can use settings in the JBoss Application Server on Windows to set up JAVA
and memory settings, and JAAS login information for authentication for your
Workplace XT Web application.

To configure Java and JAAS settings:
1. Stop JBoss Application Server, if it is running.
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2. Make a backup copy of the JBoss Application Server startup script, run.bat.
3. Open the run.bat startup script for editing.
4. Edit the Java settings.

a. Add a line to specify the path to the JDK on the machine where JBoss
Application Server is installed, as shown in the following example:
set JAVA_HOME=C:\Program
Files\Java\jdk1.5.0_06

If your JDK 1.5.0 version is different, substitute your version for the one
listed above (_06).

b. Update the JAVA_OPTS memory settings.
Adjusting this setting prevents the application server from running out of
memory, a condition in which users would not be able to log in to
Workplace XT.
In the first JAVA_OPTS entry, as per the examples below, change the -Xms
and -Xmx values for your configuration.
set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx512m

Refer to your application server vendor recommendation for Initial and
Maximum heap size values. For IBM specific recommendations, see the IBM
FileNet P8 Performance Tuning Guide.

c. If your application server uses the IBM JVM, edit the JAVA_OPTS variable in
the run.bat file immediately after the line in the previous substep. This
JAVA_OPTS edit improves performance.
Find the following line in the run.bat file:
set JAVA_OPTS=%JAVA_OPTS% -Dprogram.name=%PROGNAME%

and change it to this (without a carriage return):
set JAVA_OPTS=%JAVA_OPTS% -Dprogram.name=%PROGNAME%
-Dfilenet.pe.peorb.pool.min=2 -Dfilenet.pe.peorb.pool.max=5

d. Save your edits.
5. Configure JAAS login.

Add the following JAAS login entry right after the "%JAVA%" %JAVA_OPTS entry
in the run.bat file.

Important: Enter the JAAS login entry (bold below) as a single line without
line breaks. Do not copy and paste the text from this guide because hidden
formatting can cause problems with the entry. Instead, type the entry into the
script.
Your path might be slightly different depending on the version of your client
installations, or whether you have chosen a custom path for installation. For
example, if your Content Engine Client is at 4.0, this path might include a
samples directory under the config directory. Verify the location of the
jaas.conf.JBoss file before you enter the path.
"%JAVA%" %JAVA_OPTS% -Djava.security.auth.login.config= install_path
\IBM\ FileNet\WebClient\CE_API\config\jaas.conf.JBoss
"-Djava.endorsed.dirs=%JBOSS_ENDORSED_DIRS%" -classpath
"%JBOSS_CLASSPATH%" org.jboss.Main %*

6. Save and close the run.bat application server startup script.

Configuring JBoss Application Server for Workplace XT:

Before you can use the Workplace XT Web application, you must first configure the
application to work with JBoss Application Server.
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To configure JBoss Application Server:
1. Stop JBoss Application Server, if it is running.
2. Configure LDAP settings on the Workplace XT server to exactly match the

Content Engine settings.

Tip: Create a backup of the login-config.xml file before making changes.
a. On the Workplace XT server, open login-config.xml, located in

JBoss_home/server/server_name/conf, for editing.
b. Add an identical <application-policy name="FileNet"> entry to match the

corresponding entry in the login-config.xml file on the Content Engine
server. This should be added at the end of the file before the final </policy>
line.
<authentication>
<login-module code="org.jboss.security.auth.spi.UsersRolesLoginModule"
flag="required"/>
</authentication>
</application-policy>
<application-policy name="FileNet">
<authentication>
<login-module code="org.jboss.security.auth.spi.LdapExtLoginModule"
flag="sufficient">
<module-option name="java.naming.provider.url">ldap://cm-nihuevm9:389
</module-option>
<module-option name="java.naming.security.authentication">simple
</module-option>
<module-option name="allowEmptyPasswords">false</module-option>
<module-option name="bindDN">cn=ceadmin,ou=shared,ou=engineering,
ou=filenet,dc=apple</module-option>
<module-option name="bindCredential">Password1</module-option>
<module-option name="baseCtxDN">dc=apple</module-option>
<module-option name="baseFilter">(cn={0})</module-option>
<module-option name="rolesCtxDN">dc=apple</module-option>
<module-option name="roleFilter">(cn={0})</module-option>
<module-option name="roleAttributeID">memberOf</module-option>
<module-option name="roleAttributeIsDN">true</module-option>
<module-option name="roleRecursion">-1</module-option>
</login-module>
</authentication>
</application-policy>
</policy>

You can copy this entry from the Content Engine login-config.xml file. If you
have no custom entries in the file on your Workplace XT server, you can copy
the entire file from the Content Engine, and overwrite the login-config.xml file
on the Workplace XT server.

3. Set permissions for the user running the application server.
If the user who will be running the application server is different from the user
that installed Workplace XT, you must give the user read/write permissions on
the following folder:
install_path/IBM/FileNet/WebClient

For Windows, this is only required for NTFS formatted partitions.
4. (JBoss Application Server 4.0.5 only) Delete the following directory:

JBoss_home/server/server_name/deploy/jbossweb-tomcat55.sar/jsf-libs

If you have applications that depend on the default configuration jsf-libs,
you can create a new configuration and deploy Workplace XT to it. See your
JBoss Application Server documentation for details.

5. (JBoss Application Server 5.0.1 only) Remove the JSF 1.2 that is part of the
JBoss Application Server 5.0.1 installation.
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Removing the files and the references to the files in the web.xml file enables
JBoss Application Server to use the JSF 1.1 provided by Workplace XT.
a. Delete all jar files found under the jsf-libs folder of the web server, but do

not delete the jsf-libs folder:
JBoss_home/server/server_name/deploy/jbossweb.sar/jsf-libs

b. Open the web.xml file (JBoss_home/server/default/deployers/
jbossweb.deployer/web.xml) for editing.

c. Modify the web.xml file to comment out the references to the JSF 1.2
implementation, as shown in the following sample.
<!--
<context-param>
<param-name>com.sun.faces.injectionProvider</param-name>
<param-value>org.jboss.web.jsf.integration.injection.
JBossDelegatingInjectionProvider</param-value>
</context-param>
-->
<!--
<listener>
<listener-class>org.jboss.web.jsf.integration.config.
JBossJSFConfigureListener</listener-class>
</listener>
-->

<!--
<listener>
<listener-class>com.sun.faces.application.WebappLifecycleListener
</listener-class>
</listener>
-->

<!--
<init-param>
<description>JSF standard tlds</description>
<param-name>tagLibJar0</param-name>
<param-value>jsf-libs/jsf-impl.jar</param-value>
</init-param>
<init-param>
<description>JSTL standard tlds</description>
<param-name>tagLibJar1</param-name>
<param-value>jstl.jar</param-value>
</init-param>
-->

6. Clear out all files and folders within the following temp directories:
JBoss_home/server/server_name/tmp/deploy

JBoss_home/server/server_name/work/jboss.web/localhost

7. Disable JBoss Application Server logging to prevent unexpected behavior in
the deployed IBM FileNet software.
When logging is disabled, error messages will still be displayed in the JBoss
Application Server console.
a. Open the log4j.xml or jboss-log4j.xml file (JBoss_home/server/

server_name/conf/log4j.xml) for editing.
b. Add the following line (in bold) for the FILE appender, under the section

"Preserve messages in a local file":
<!-- A time/date based rolling appender -->
<appender name="FILE" class= "org.jboss.logging.appender.
DailyRollingFileAppender">
<errorHandler class="org.jboss.logging.util.OnlyOnceErrorHandler"/>
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<param name="File" value="${jboss.server.log.dir}/server.log"/>
<param name="Append" value="false"/>
<param name="Threshold" value="ERROR"/>

c. Change all threshold values and priority values from
"INFO"
"DEBUG"
"TRACE"
to
"ERROR"
except for the CONSOLE appender threshold value, which should be set to
"INFO", as shown in bold below:
<appender name="CONSOLE" class="org.apache.log4j.ConsoleAppender">
<errorHandler class="org.jboss.logging.util.OnlyOnceErrorHandler"/>
<param name="Target" value="System.out"/>
<param name="Threshold" value="INFO"/>

d. Add IBM FileNet-specific categories to avoid excessive tracing messages in
the console, which can impact performance. Add the following at the end of
the "Limit categories" section, just before the "Setup the Root category"
section:
<category name="filenet_error.api">
<priority value="ERROR"/>
</category>
<category name="filenet_tracing.api">
<priority value="OFF"/>
</category>

<category name="com.filenet.wcm.api">
<priority value="ERROR"/>
</category>

<category name="com.filenet-trace">
<priority value="OFF"/>
</category>

<category name="com.filenet-debug">
<priority value="ERROR"/>
</category>

If other IBM FileNet-specific tracing message in the command console affect
performance, add additional categories for those messages.

e. Remove the Root category priority value, if any, as shown in bold below:
<!-- ======================= -->
<!-- Setup the Root category -->
<!-- ======================= -->
<root>
<priority value="ERROR"/>
<appender-ref ref="CONSOLE"/>
<appender-ref ref="FILE"/>
</root>

f. Save and close the log4j.xml file.
8. Optional: Start JBoss Application Server as follows, to verify that configuration

changes were successful:

Option Description

UNIX ./run.sh

Windows run.bat
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Configuring JBoss Application Server to support user tokens and WebDAV
connections for Workplace XT used with other applications:

If you are using Workplace XT with other applications, such as Application
Integration, eForms, or Records Manager, you must enable support for user tokens
and WebDAV connections. You can verify these settings in the Bootstrap Settings in
the Site Preferences.

To configure JBoss Application Server to support user tokens and WebDAV
connections:
1. Stop JBoss Application Server, if it is running.
2. (For installations with Content Engine at 4.5.x) Copy the authentication-

utils.jar file from here:
install_path/IBM/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:
JBoss_home/server/server_name/lib

3. (For installations with Content Engine at 4.0.x ) Copy the authentication-
utils1.1.2.jar file from here:
install_path/IBM/FileNet/WebClient/WorkplaceXT/authenticationFiles/1.1.2

to here:
JBoss_home/server/server_name/lib

4. Modify the login-config.xml file.

Tip: Create a backup of the file before making changes.
a. On the Workplace XT server, open login-config.xml in

JBoss_home/server/server_name/conf for editing.
b. Add the following xml element (bold below) as the first entry in the FileNet

domain section, and set the flag to "optional":
<application-policy name="FileNet">
<authentication>
<login-module code="com.filenet.ae.authentication.
loginmodule.UserTokenLoginModule" flag="optional">
<module-option name="wcmApiConfigPath"><install_path>
/IBM/FileNet/WebClient/WorkplaceXT/WEB-INF/WcmApiConfig.properties
</module-option>
<module-option name="multi-threaded">true</module-option>
</login-module>
<login-module code="org.jboss.security.auth.spi.LdapExtLoginModule"
flag="required">
<module-option name="java.naming.provider.url">ldap://copenhagen:389
</module-option>
<module-option name="java.naming.security.authentication">simple
</module-option>
<module-option name="allowEmptyPasswords">false</module-option>
<module-option name="bindDN">CN=CEAdmin,OU=Shared,OU=Engineering,
OU=FileNet,DC=FileNet,DC=Com</module-option>
<module-option name="bindCredential">MyPassword</module-option>
<module-option name="baseCtxDN">DC=FileNet,DC=Com</module-option>
<module-option name="baseFilter">(cn={0})</module-option>
<module-option name="rolesCtxDN">DC=FileNet,DC=Com</module-option>
<module-option name="roleFilter">(cn={0})</module-option>
<module-option name="roleAttributeID">memberOf</module-option>
<module-option name="roleAttributeIsDN">true</module-option>
<module-option name="roleRecursion">-1</module-option>
</login-module>
</authentication>
</application-policy>
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On Windows, use double back slash (\\) in place of the forward slash in
the wcmApiConfigPath entry, as shown in the following example:
<module-option name="wcmApiConfigPath"> < install_path
>\\IBM\\FileNet\\WebClient\\WorkplaceXT\\WEB-INF\\
WcmApiConfig.properties</module-option>

When deploying as an EAR or WAR file, the wcmApiConfigPath value
must be a valid folder path, such as the install location. It cannot point to a
folder within the EAR or WAR file.

c. Save changes to login-config.xml.

Deploying Workplace XT on the Web application server
After you install and configure Workplace XT, you must deploy the application on
the Web application server. You can recreate the WAR or EAR files before you
deploy to capture any configuration changes from software updates.

“Re-creating the WAR and EAR files”
If you are using a WAR file or EAR file for deployment, you must re-create the
WAR file or WAR and EAR files and redeploy the application each time you
make changes to files in the install_path/IBM/FileNet/WebClient/WorkplaceXT
directory. If you chose not to have the Content Engine or Process Engine Client
installers create your deployment file, or if you made changes to web.xml for
SSO support or any other edits, you must re-create the WAR and EAR files.
“Deploying IBM FileNet Workplace XT on WebSphere Application Server” on
page 45
After you install and configure Workplace XT, you must deploy the Web
application on your WebSphere Application Server.
“Deploying Workplace XT on WebLogic Server” on page 48
After you install and configure Workplace XT, you must deploy the client
application on your WebLogic Server. You might be required to re-create the
WAR or WAR and EAR files before you deploy.
“Deploying Workplace XT on JBoss Application Server” on page 49
After you install and configure Workplace XT, you must deploy your client
application on your JBoss Application Server. You might be required to re-create
the WAR or WAR and EAR files before you deploy.

Re-creating the WAR and EAR files
If you are using a WAR file or EAR file for deployment, you must re-create the
WAR file or WAR and EAR files and redeploy the application each time you make
changes to files in the install_path/IBM/FileNet/WebClient/WorkplaceXT directory.
If you chose not to have the Content Engine or Process Engine Client installers
create your deployment file, or if you made changes to web.xml for SSO support or
any other edits, you must re-create the WAR and EAR files.

To re-create the WAR and EAR files:
1. If you will be deploying from a WAR file, verify that web_client.war exists. To

re-create the WAR file, run one of the following commands:

Option Description

UNIX install_path/IBM/FileNet/WebClient/
deploy/create_web_client_war.sh

Windows install_path\IBM\FileNet\WebClient\
deploy\create_web_client_war.bat
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2. If you will be deploying from an EAR file, verify that both web_client.war and
web_client.ear exist. To re-create the EAR file, first re-create the WAR file, and
then run the following command to re-create the EAR file:

Option Description

UNIX install_path/IBM/FileNet/WebClient/
deploy/create_web_client_ear.sh

Windows install_path\IBM\FileNet\WebClient\
deploy\create_web_client_ear.bat

Deploying IBM FileNet Workplace XT on WebSphere Application
Server
After you install and configure Workplace XT, you must deploy the Web
application on your WebSphere Application Server.

“Deploying Workplace XT on WebSphere Application Server 6.1”
Deploy Workplace XT as an application in the WebSphere 6.1 administrative
console. You can specify the context root for the application URL during the
deployment.
“Deploying Workplace XT on WebSphere Application Server 7.0” on page 46
Deploy Workplace XT as an application in the WebSphere administrative
console. You can specify the context root for the application URL during the
deployment.

Deploying Workplace XT on WebSphere Application Server 6.1:

Deploy Workplace XT as an application in the WebSphere 6.1 administrative
console. You can specify the context root for the application URL during the
deployment.

To deploy Workplace XT:
1. Log on to the WebSphere administrative console.
2. Navigate to Applications → Enterprise Applications → Install.
3. Select the file to deploy.
v (If the administrative console is running locally) Select Local file system

and enter or browse to the location of the web_client.war or
web_client.ear file created by the installation program. For example,
install_path/deploy/web_client.war or install_path/deploy/
web_client.ear. Do not enter the machine name.

v (If the administrative console is remote) Select Remote file system and
enter the fully-qualified path name to the web_client.war or
web_client.ear file. For example, install_path/deploy/web_client.war or
install_path/deploy/web_client.ear. Do not enter the machine name.

4. If you are deploying a WAR file, enter the Context root.

Tip: The context root is the name of the application you log in to using the
web interface. Do not include spaces. If you enter WorkplaceXT, the application
URL will be http://server_name:port#/WorkplaceXT.

5. Click Prompt me only when additional information is required, and click
Next to proceed to deploying a new application.

6. Complete the dialogs for installing a new application, using the following
settings:
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v On the Select installation options page, for Application name, enter
Workplace XT, or the name you chose to call the application.

v On the Map modules to servers page, for Clusters and Servers, specify the
server you are planning to use. Verify that your application name is selected
and associated with the correct server and nodes, if applicable.

v On the Map virtual hosts for Web modules page, for virtual host, choose
the default_host.

7. Save your configuration.
8. Navigate to Applications → Enterprise Applications → Workplace XT → Class

loading and update detection.
9. Set the polling interval for updated files with a number appropriate for your

environment, for example, 3 seconds.
10. Change the Class loader order to Classes loaded with application class

loader first.
11. Click Apply.
12. Click Workplace XT → Manage Modules.
13. Click Workplace XT.
14. Change the Class loader order to Classes loaded with application class

loader first.

Important: Do this only for the specific web application. Do not change the
similar settings for the entire application server.

15. Navigate to Enterprise Applications → Workplace XT → Security role to
user/group mapping.

16. Verify that the All Authenticated column is checked for the "All
Authenticated" role.

17. Verify that the Everyone? column is checked for the Everyone role.
18. Save all your changes to the master configuration.
19. Stop and restart WebSphere Application Server.
20. (Windows only) From the Windows Services Console, restart the Process

Workplace XT Services Manager service.
21. Restart Process Task Manager and Component Manager.
22. Exit the Process Task Manager application.
23. Start Workplace XT from the administrative console.
24. To troubleshoot the deployment, check the following log:

WAS_install_path/AppServer/profiles/profile_name/logs/server_name/
SystemOut.log

Deploying Workplace XT on WebSphere Application Server 7.0:

Deploy Workplace XT as an application in the WebSphere administrative console.
You can specify the context root for the application URL during the deployment.

To deploy Workplace XT:
1. Log on to the WebSphere administrative console.
2. Navigate to Applications → WebSphere Enterprise Applications → New

Enterprise Applications → Install.
3. Select the file to deploy.
v (If the administrative console is running locally) Select Local file system

and enter or browse to the location of the web_client.war or web_client.ear
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file created by the installation program. For example, install_path/deploy/
web_client.war or install_path/deploy/web_client.ear. Do not enter the
machine name.

v (If the administrative console is remote) Select Remote file system and
enter the fully-qualified path name to the web_client.war or
web_client.ear file. For example, install_path/deploy/web_client.war or
install_path/deploy/web_client.ear. Do not enter the machine name.

4. Click Fast Path, and click Next. Complete the dialogs for installing a new
application, using the following settings:
v On the Select installation options page, for Application name, enter

Workplace XT, or the name you chose to call the application.
v On the Map modules to servers page, for Clusters and Servers, specify the

server you are planning to use. Verify that your application name is selected
and associated with the correct server and nodes, if applicable.

v On the Map virtual hosts for Web modules page, for virtual host, choose
the default_host.

v (WAR file deployment only) On the Map context roots for Web modules
page, for Context root, specify WorkplaceXT, or whatever you want to call
the application.

Tip: The context root is the name of the application you log in to using the
Web interface. If you enter WorkplaceXT, the application URL will be
http://server_name:port#/WorkplaceXT.

5. Save your configuration.
6. Navigate to Applications → Enterprise Applications → Workplace XT → Class

loading and update detection.
7. Set the polling interval for updated files with a number appropriate for your

environment, for example, 3 seconds.
8. Change the Class loader order to Classes loaded with local class loader first

(parent last).
9. Click Apply.

10. Click Workplace XT → Manage Modules.
11. In the Modules column, click Workplace XT.
12. Change the Class loader order to Classes loaded with local class loader first

(parent last).

Important: Do this only for the specific web application. Do not change the
similar settings for the entire application server.

13. Navigate to Enterprise Applications → Workplace XT → Security role to
user/group mapping.

14. Select the All Authenticated role and click Map Special Subjects.
15. Map the All Authenticated role to the All Authenticated in Applications

realm.
16. Select the Everyone role and click Map Special Subjects.
17. Map the Everyone role to Everyone.
18. Save all your changes to the master configuration.
19. Stop and restart WebSphere Application Server.
20. (Windows only) From the Windows Services Console, restart the Process

Workplace XT Services Manager service.
21. Restart Process Task Manager and Component Manager.
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22. Exit the Process Task Manager application.
23. Start Workplace XT from the administrative console.
24. To troubleshoot the deployment, check the following log:

WAS_install_path/AppServer/profiles/profile_name/logs/server_name/
SystemOut.log

Workplace XT requires that the client operating system has the Java Runtime
Environment (JRE) downloaded and installed. If JRE is not installed, users will be
prompted to install the JRE on first login.

Deploying Workplace XT on WebLogic Server
After you install and configure Workplace XT, you must deploy the client
application on your WebLogic Server. You might be required to re-create the WAR
or WAR and EAR files before you deploy.

“Renaming the WAR file”
You can rename the WAR file if you are using a WAR file for deployment, and
you want to use "Workplace XT" or a custom name for the context root of the
application. The context root is part of the URI that end users type to access
Workplace XT.
“Deploying Workplace XT on WebLogic Server 9.2”
To use Workplace XT as a Web application, you must deploy it as an
application in the WebLogic Server Administration Console. You can specify the
context root for the application URL during the deployment.

Renaming the WAR file:

You can rename the WAR file if you are using a WAR file for deployment, and you
want to use "Workplace XT" or a custom name for the context root of the
application. The context root is part of the URI that end users type to access
Workplace XT.

By default, when you deploy from a WAR file, the context root is the first part of
the WAR filename. For example, the default web_client.war will generate a context
root of http://server_name:port#/webclient. If you want to use
http://server_name:port#/custom_name, you must rename web_client.war to
custom_name.war.

To rename the WAR file:

Use the rename command to rename the WAR file. Enter the command without
the line break.

Option Description

UNIX mv install_path/IBM/FileNet/WebClient/
deploy/web_client.war install_path/IBM/
FileNet/WebClient/deploy/custom_name.war

Windows rename install_path\IBM\FileNet\
WebClient\deploy\web_client.war
install_path\IBM\FileNet\WebClient\
deploy\custom_name.war

Where custom_name is the context root or custom application name you choose.

Deploying Workplace XT on WebLogic Server 9.2:
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To use Workplace XT as a Web application, you must deploy it as an application in
the WebLogic Server Administration Console. You can specify the context root for
the application URL during the deployment.

To deploy Workplace XT:
1. From the WebLogic Server Administration Console, navigate to the domain you

initially created for the Application Engine.
2. Prepare the WebLogic Server Administration Console to deploy the application.
3. Choose whether to deploy from an exploded folder, install_path/IBM/

FileNet/WebClient, or from the WAR or EAR file, such as web_client.war or
web_client.ear in install_path/deploy.

4. Accept the defaults for the deployment, except for the name for the
deployment. Use Workplace XT or the custom name you have chosen instead of
web_client.

5. Finish the deployment, and save and activate your changes.

Tip: To verify that the deployment was successful, expand Web Applications.
The web application Workplace XT is listed.

Tip: To troubleshoot the deployment, check the following log:

WLS_install_path/user_projects/domains/domain_name/servers/server_name/
logs/server_name.log

6. After deployment is complete, start Workplace XT (or your custom application
name) in the WebLogic Server Administration Console.

7. (Windows only) From the Windows Services Console, restart the Process
Workplace XT Services Manager service.

8. Restart Process Task Manager and Component Manager.
9. Exit the Process Task Manager application.

To troubleshoot the deployment, check the following log:

WLS_install_path/user_projects/domains/domain_name/servers/server_name/
logs/server_name.log

Workplace XT requires that the client operating system has the Java Runtime
Environment (JRE) downloaded and installed. If JRE is not installed, users will be
prompted to install the JRE on first login.

Deploying Workplace XT on JBoss Application Server
After you install and configure Workplace XT, you must deploy your client
application on your JBoss Application Server. You might be required to re-create
the WAR or WAR and EAR files before you deploy.

“Deploying as Workplace XT or custom name using a WAR file”
You can rename the WAR file if you are using a WAR file for deployment, and
you want to use WorkplaceXT or a custom name for the context root of the
application. The context root is part of the URI that end users type to access
Workplace XT.
“Deploying Workplace XT” on page 50
After you install and configure Workplace XT, you must deploy the Workplace
XT application on your JBoss Application Server.

Deploying as Workplace XT or custom name using a WAR file:
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You can rename the WAR file if you are using a WAR file for deployment, and you
want to use WorkplaceXT or a custom name for the context root of the application.
The context root is part of the URI that end users type to access Workplace XT.

By default, when you deploy from a WAR file, the context root is the first part of
the WAR filename. For example, the default web_client.war will generate a context
root of http://server_name:port#/webclient. If you want to use http://
server_name:port#/custom_name, you must rename web_client.war to
custom_name.war.

Important: You must rename the WAR file every time you regenerate it. The
create_web_client_war.sh/.bat script will by default create a file with the name
web_client.war.

To deploy as a custom name:

Use the rename command to rename the WAR file. Enter the command without
the line break.

Option Description

UNIX mv install_path/IBM/FileNet/WebClient/
deploy/web_client.war install_path/IBM/
FileNet/WebClient/deploy/
custom_name.war

Windows rename install_path\IBM\FileNet\
WebClient\deploy\web_client.war
install_path\IBM\FileNet\WebClient\
deploy\custom_name.war

Deploying Workplace XT:

After you install and configure Workplace XT, you must deploy the Workplace XT
application on your JBoss Application Server.

To deploy Workplace XT:
1. Stop JBoss Application Server, if it is running.
2. Deploy Workplace XT according to your deployment type.

Option Description

For exploded directory deployment only 1. On the JBoss Application Server, copy
the WorkplaceXT folder from:

install_path/IBM/FileNet/WebClient/

to:

JBOSS_home/server/server_name/deploy/

2. Append the extension .war to the
WorkplaceXT folder:

JBOSS_home/server/server_name/deploy/
WorkplaceXT.war

3. (optional) For a custom name for the
context root (and the application),
rename the WorkplaceXT.war folder to
custom_name.war, where custom_name is
the name you choose for your
application.
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Option Description

For WAR file deployment only On the JBoss server, copy the
web_client.war (or custom_name.war) file
from:

install_path/IBM/FileNet/WebClient/
deploy

to:

JBOSS_home/server/server_name/deploy/

For EAR file deployment only On the JBoss server, copy the
web_client.ear file from:

install_path/IBM/FileNet/WebClient/
deploy

to:

JBOSS_home/server/server_name/deploy/

3. Start or restart the JBoss Application Server.
4. Verify that the application deployed successfully.

Verify that the server.log file located in JBOSS_home/server/server_name/log/
lists deployment of the WAR or EAR file you used.

5. (Windows only) From the Windows Services Console, restart the Process
Workplace XT Services Manager service.

6. Restart Process Task Manager and Component Manager.
7. Exit the Process Task Manager application.

Each new version of Workplace XT can add new actions or modify existing actions.
When you have completed the upgrade and deployment steps, review the new
and modified actions in your upgraded Workplace XT environment and apply
whatever access roles are appropriate for your site. For details, see the Workplace
XT help topic User Help → Actions, preferences, and tools → Site preferences →
Actions preferences.

Workplace XT requires that the client operating system has the Java Runtime
Environment (JRE) downloaded and installed. If JRE is not installed, users will be
prompted to install the JRE on first login.

Configuration and startup tasks
After you install Workplace XT, you must also configure settings for the FileNet P8
environment. Some of these configuration settings are required, and some are
optional.

“Setting Workplace XT bootstrap preferences” on page 52
By successfully signing in to Workplace XT and saving the bootstrap
preferences, you verify basic Workplace XT functionality such as user
authentication as well as communication and storing of data in Content Engine.
“Configuring folder preferences” on page 55
If you plan to use folder preferences, which enable users to associate folders
with entry templates and customize columns, you must first configure the
annotations class on your Enterprise Manager.
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“Configuring the Process Engine Connection Point for Workplace XT” on page
56
Before users can access tasks and work items from Workplace XT, you must
configure the Connection Point on the Workplace XT server.
“Setting up SSL security for Workplace XT” on page 56
After you complete your installation, you can configure Workplace XT to direct
sign-ins through a Secure Socket Layer (SSL) HTTPS connection.
“Perform additional configuration tasks” on page 59
After you have completed the installation and configuration tasks, your
Workplace XT Web application is functional. There are additional tasks that you
can complete or review to prepare the system for general use.

Setting Workplace XT bootstrap preferences
By successfully signing in to Workplace XT and saving the bootstrap preferences,
you verify basic Workplace XT functionality such as user authentication as well as
communication and storing of data in Content Engine.

“Setting the bootstrap properties on first login”
Six bootstrap preference groups are available for configuring the first time you
sign in to Workplace XT.
“Verifying that a single index has been added for Application Name on the site
preferences object store” on page 54
To properly index access roles and improve login performance on Workplace
XT, an index is created for Application Name on the object store that contains
the Workplace XT site preferences. Verify this index setting after you have
successfully configured the bootstrap preferences.
“Enabling user access to the Workflow Subscription Wizard” on page 54
To allow users to create workflow subscriptions, you must configure the
PWDesigner access role using the Workplace XT Site Preferences, and give the
users appropriate access rights to the workflow subscriptions classes. You can
perform these steps in any order, and you must perform both steps any time
you need to add or remove users.

Setting the bootstrap properties on first login
Six bootstrap preference groups are available for configuring the first time you sign
in to Workplace XT.

To set the bootstrap properties:
1. Sign in to Workplace XT:

a. On any computer, open a browser and type:
http://WorkplaceXTServerName:port#/WorkplaceXT

Important: WorkplaceXTServerName cannot be localhost or an IP address.
b. Enter a user name and password, and then click Log in. The Bootstrap

Preferences page opens.
The user who initially logs in and sets the bootstrap preferences is
automatically added to the Application Engine Administrators role. For
more information, see the IBM FileNet P8 help topic User Help → Actions,
preferences, and tools → Site preferences → Access Roles preferences.

2. Enter security info (required for SSL only).
a. Enter the SSL Host and Port information for the SSL server.
b. Enter the Java™ Server HTTP port.
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Use the Security info preference to redirect Application Integration log-ins
through a Secure Socket Layer (SSL) server and to identify a remote Java
server. This encrypts the user IDs and passwords when they travel over the
network. See “Setting up SSL security for Workplace XT” on page 56 for
instructions on setting up SSL security for one or more Workplace XT
installations.

Important: After you have configured SSL, the Site Preferences application
also runs under SSL to protect the guest account's user ID and password.
This means that when you run Site Preferences on an unsecured server that
redirects sign-ins to an SSL server, you will be editing the Bootstrap
preferences of the SSL server (stored in the bootstrap.properties file). This
does not affect the General, Object Store, and Shortcut preferences, which
are retrieved from the preferences file saved in the object store.

3. Configure user token settings.
User Tokens are used by IBM FileNet P8 applications to launch into each other
without the need for an additional login.
You can specify a Token timeout interval (1 - 15 minutes) for Workplace XT.

4. (Required) Specify preference settings.
Preference settings specify the name of the site preference file, its storage
location (object store), and the documentation server URL (if installed). The site
preferences file is checked into the object store the first time you log on to
Workplace XT. The site preferences are stored as XML data in this file, Site
Preferences for Preferences name.xml. Use Enterprise Manager to access this
file, and navigate to Object Stores > Object Store location > Root Folder >
Preferences.
The bootstrap preferences are saved in the bootstrap.properties file, and not
in the site preferences file. The default location for this file is
AE_install_path/FileNet/Config/AE.
a. Select an object store from the Object store location choice list. The

preferences file will be saved in this object store. Workplace users must
have access to this object store.

b. Enter a preference file name in the Preferences name field.
c. Enter the documentation server URL in the Documentation server field.

The format of the URL is:
http://DocServerName:port#/ecm_help/
where DocServerName is the name of your Java application server where the
documentation is installed, port# is the port number, and ecm_help is the root
directory of the documentation web site.
If no documentation URL is specified, the Workplace XT Help link will
default to http://localhost.

5. Add Application Engine Administrators (ae_admin_user). Add the users and
groups that will perform Workplace XT administration tasks to the Application
Engine Administrators role.
The user who initially signs in and sets the bootstrap preferences is
automatically added to the Application Engine Administrators role. For more
information, see the IBM FileNet P8 help topic User Help → Actions,
preferences, and tools → Site preferences → Access Roles preferences.
To modify the access roles after the initial bootstrap configuration, users with
the Application Engine Administrators role can use the access roles section of
the Workplace Site Preferences. Launch Workplace XT and navigate to Admin →
Site Preferences → Access Roles.
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6. Click Apply to save your bootstrap settings.

After the initial bootstrap configuration, users with the Application Engine
Administrators (ae_admin_user) role can change any of these preferences by signing
into Workplace XT and navigating to Admin → Site Preferences → Bootstrap.

Bootstrap properties are stored in a separate file from other site preferences. The
default location for this file, bootstrap.properties, is install_path/IBM/FileNet/
Config/WebClient.

In a web farm or clustered environment, all Workplace XT installations share site
preferences by using the same bootstrap.properties file. For more information,
see the IBM FileNet P8 High Availability Technical Notice.

Verifying that a single index has been added for Application
Name on the site preferences object store
To properly index access roles and improve login performance on Workplace XT,
an index is created for Application Name on the object store that contains the
Workplace XT site preferences. Verify this index setting after you have successfully
configured the bootstrap preferences.

To verify the index setting:
1. Start Enterprise Manager.
2. In the left pane, expand the Object Stores folder.
3. Expand the object store node where your site preferences are stored.
4. Expand Other Classes and then Custom Object.
5. Right click Access Role and select Properties.
6. Select the Property Definitions tab.
7. Select Application Name and click Edit.
8. On the General tab of the Application Name Properties, verify that the

Indexed field shows Single Indexed.
v If the Indexed field shows Single Indexed, click OK. The verification is

complete. Skip the remaining steps in this procedure.
v If the Indexed field shows Not indexed, continue with the following steps

to change the setting.
9. Click Set/Remove.

10. Select Set and then Single Indexed.
11. Click OK to set the index.
12. Click OK to apply the change and close the Application Name Properties

window.
13. Click OK to close the Access Role Class Properties window.

Enabling user access to the Workflow Subscription Wizard
To allow users to create workflow subscriptions, you must configure the
PWDesigner access role using the Workplace XT Site Preferences, and give the
users appropriate access rights to the workflow subscriptions classes. You can
perform these steps in any order, and you must perform both steps any time you
need to add or remove users.

To enable user access:
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1. Assign users as members of the PWDesigner access role. See the IBM FileNet
P8 help topic User Help → Actions, preferences, and tools → Site preferences →
Access Roles preferences.

2. Run the security script wizard with the workplacescript.xml file to add
accounts to the Workflow Designer role. In Enterprise Manager, right-click the
domain root node or the object store node and select All tasks → Run Security
Script Wizard

For more information about how to use the Security Script wizard to assign the
Workflow Designer role to user or group accounts, see the IBM FileNet P8 help
topic FileNet P8 Administration → Content Engine Administration → Content
Engine Wizard Help → Security Script.
For more information about the workplacescript.xml file and how roles are
defined in the Enterprise Manager, see the IBM FileNet P8 help topic FileNet
P8 Administration → Content Engine Administration → Managing Security →
Security Script Wizard.

Configuring folder preferences
If you plan to use folder preferences, which enable users to associate folders with
entry templates and customize columns, you must first configure the annotations
class on your Enterprise Manager.

Configuring folder preferences applies only to systems where the Content Engine
component is at version 4.0 or 4.5.

For more information on using folder preferences, see the IBM FileNet Workplace
XT help topic User help → Actions, preferences, and tools → Actions → Manage
folders.

The procedure adds an annotation class called Folder Preferences to the annotation
list under Other Classes.

To configure folder preferences:
1. On the Workplace XT server, copy the install_path/WebClient/WorkplaceXT/

addons folder and the files it contains to a temp location on the Content
Engine server.

2. Log into IBM FileNet Enterprise Manager.
3. Right click on an object store where you want to enable folder preferences.
4. Select All Tasks → Import All. Click the Import Options tab.
5. For the Import Manifest File field, click Browse.
6. Browse to the addons folder that you copied from the Workplace XT server to

the Content Engine temp location, and select the file
WorkplaceXTExtensions.xml. Click OK.

7. Click the Scripts tab.
8. In the Run-Type dropdown list, choose Post import.
9. Browse to the addons folder that you copied from the Workplace XT server to

the Content Engine temp location.
10. Select the file WorkplaceXTFolderPreferencesSecurity.vbs.
11. Click OK.
12. Click Import.
13. When the status message displays, click OK.

Installing IBM FileNet Workplace XT 55



14. Repeat this procedure on all object stores where you want to enable folder
preferences.

Configuring the Process Engine Connection Point for
Workplace XT

Before users can access tasks and work items from Workplace XT, you must
configure the Connection Point on the Workplace XT server.

Make sure that you have already completed the tasks in the IBM FileNet P8
Platform Installation and Upgrade Guide for creating a Process Engine Isolated Region
and creating a Process Engine Connection Point.

To configure the connection point:
1. Log into Workplace XT:

a. On any computer, open a browser and navigate to: http://
WorkplaceXTServerName:port#/WorkplaceXT.

b. Sign in using the same account that you used to set the bootstrap
preferences.

2. Click Admin.
3. Click Site Preferences.
4. On the General Settings page, under Tasks, select a Process Engine Connection

Point from the drop down list.
5. Click Apply, then click Exit.
6. (For new environments only) Initialize the isolated region.

Important: Performing this step in an existing environment will destroy all
data in the existing region.
a. Click Admin.
b. Click Process Configuration Console.
c. Right-click the icon or name of the isolated region you want to initialize,

and select Connect from the context menu.
d. Click Action.
e. Click Initialize Isolated Region.
f. Click Yes at the prompt asking if you want to continue.
g. Close the Process Configuration Console.

7. In Workplace XT, click Tasks to confirm that Workplace XT is communicating
with Process Engine.

8. Sign out of Workplace XT.

Setting up SSL security for Workplace XT
After you complete your installation, you can configure Workplace XT to direct
sign-ins through a Secure Socket Layer (SSL) HTTPS connection.

Workplace XT supports the following methods of configuring an SSL environment:
v Full SSL support - A single Workplace XT server, where all of the software is

running under SSL.
v One server SSL redirect - One Workplace XT server set up to redirect logon

attempts on the non-SSL port to the SSL port.
“Setting up full SSL support on a single Workplace XT server” on page 57
To set up full SSL support, enable SSL on the preferred application server.
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“Setting up SSL redirect on a single Workplace XT server”
To set up SSL redirect, enable SSL on the Web application server, set your
bootstrap preferences, update the base URL, and sign out.
“Using Java applets in an SSL Environment” on page 59
Java applets in an SSL environment can create SSLHandshakeException issues.

Setting up full SSL support on a single Workplace XT server
To set up full SSL support, enable SSL on the preferred application server.

To set up full SSL support:
1. Enable SSL on the application server that runs Workplace XT. See your SSL

documentation.
2. Test the SSL connection by logging into Workplace XT using the following

URL: https://WorkplaceXTServerName:SSL port/WorkplaceXT.

Note: The entire login process will be handled by the SSL-enabled host. Under
full SSL, after login, all pages and information will be handled in SSL.

Setting up SSL redirect on a single Workplace XT server
To set up SSL redirect, enable SSL on the Web application server, set your
bootstrap preferences, update the base URL, and sign out.

To set up SSL redirect:
1. Enable SSL on the application server that runs Workplace XT. See your SSL

documentation for details.
2. Optional: (WebSphere Application Server and JBoss Application Server only) If

you have made custom changes to your web.xml file, copy the web.xml file
from the deploy location back into the install location, install_path/IBM/
FileNet/WebClient/WorkplaceXT/WEB_INF, before editing for SSL redirect.

Option Description

WebSphere Application Server WAS_HOME/profiles/default/
installedApps/node_name/WorkplaceXT.ear/
web_client.war

JBoss Application Server JBOSS_HOME/server/server_name/deploy/
application_name.war or .ear

3. Create a backup copy of your web.xml file.
4. (WebSphere Application Server only) Modify the web.xml file in the

install_path/IBM/FileNet/WebClient/WorkplaceXT/WEB_INF directory:
a. Copy the <security_constraint> section from your file (not from this

document) and paste the new copied section directly after the original.
b. Make changes to the newly inserted <security_constraint> section as

follows (changes in bold):
Change from
<security-constraint>
<web-resource-collection>
<web-resource-name>action</web-resource-name>
<description>Define the container secured resource</description>
<url-pattern>/</url-pattern>
<url-pattern>/*</url-pattern>
</web-resource-collection>
<auth-constraint>
<role-name>All Authenticated</role-name>
</auth-constraint>
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<user-data-constraint>
<description>User data constraints</description>
<transport-guarantee>NONE</transport-guarantee>
</user-data-constraint>
</security-constraint>

to
<security-constraint>
<web-resource-collection>
<web-resource-name>action</web-resource-name>
<description>Define the container secured resource</description>
<url-pattern>/ ContainerLogin.jsp </url-pattern>
</web-resource-collection>
<auth-constraint>
<role-name>All Authenticated</role-name>
</auth-constraint>
<user-data-constraint>
<description>User data constraints</description>
<transport-guarantee> CONFIDENTIAL </transport-guarantee>
</user-data-constraint>
</security-constraint>

The change also removes the second occurrence of this line:
<url-pattern>/*</url-pattern>

c. Save your changes to the web.xml file.
5. (WebLogic Server and JBoss Application Server only) Modify the web.xml file

in the install_path/IBM/FileNet/WebClient/WorkplaceXT/WEB_INF directory:
a. In the <security_constraint> section, change the parameter, as follows,

from
<user-data-constraint>
<description>User data constraints</description>
<transport-guarantee>NONE</transport-guarantee>
</user-data-constraint>

to
<user-data-constraint>
<description>User data constraints</description>
<transport-guarantee>CONFIDENTIAL</transport-guarantee>
</user-data-constraint>

b. Save your changes to the web.xml file.
6. Create your deployment files.
v (If you deployed as a WAR file only), In the install_path/IBM/FileNet/

WebClient/deploy directory, run create_web_client_war.sh or .bat file.
v (If you deployed as an EAR file only), In the install_path/IBM/FileNet/

WebClient/deploy directory, run create_web_client_war.sh or .bat file,
then create_web_client_ear.sh or .bat file.

7. Redeploy the application.
8. Sign in to Workplace XT:

a. On any computer, open a browser and type the following URL address:
http://WorkplaceXTServerName:port#/WorkplaceXT

b. Sign in as a user with Application Engine Administrator access role
privileges. For more information, see the IBM FileNet P8 help topic User
Help → Actions, preferences, and tools → Site preferences → Access Roles
preferences.

9. (Applies only when using Application Integration) Set bootstrap preferences:
a. Navigate to Tools → Administration → Site Preferences → Bootstrap.
b. Set the Security info Site Preference SSL Host:Port to identify the alias host

name and port number.
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Use the IP address of the Workplace XT server for the SSL Host entry.
For more information, see “Setting the bootstrap properties on first login”
on page 52.

c. Click Apply to save your bootstrap settings.
10. Update the base URL:

a. Navigate to Tools → Administration → Site Preferences → Refresh.
b. Enter the Workplace XT Base URL value in the provided field. The URL

must contain a valid host name, and not contain "localhost" or an IP
number. For example, http://WorkplaceXTServerName:port#/WorkplaceXT.
For more information, see the IBM FileNet P8 help topic User Help →
Actions, preferences, and tools → Site preferences → Refresh preferences.

c. Click Refresh to update the base URL.
d. Click Exit to close Site Preferences.

11. Sign out of Workplace XT, and close your browser.
12. Test the SSL connection by signing into Workplace XT using the following

URL: http://WorkplaceXTServerName:non-SSLport#/WorkplaceXT
The login is redirected to the SSL-enabled port, then back to the non-SSL
enabled port after login is complete. A warning displays that you are
accessing pages over a secure connection, unless you turned this dialog box
off, then Workplace XT will open.

Using Java applets in an SSL Environment
Java applets in an SSL environment can create SSLHandshakeException issues.

If you are using a Java applet in an SSL environment, you might experience an
SSLHandshakeException because the appropriate certificate does not exist on your
server. Follow the instructions in the IBM FileNet P8 help topic User Help → Using
Workplace → Basics → Use Java Applets to resolve this issue.

Perform additional configuration tasks
After you have completed the installation and configuration tasks, your Workplace
XT Web application is functional. There are additional tasks that you can complete
or review to prepare the system for general use.

Except where noted, the links go to the IBM FileNet P8 help, and start from the
Contents panel in http://webserver:port#/ecm_help/_start_here.htm

where webserver:port are the application server and port for your IBM FileNet P8
help.
v Set site preferences for the Workplace XT application. Refer to User Help →

Actions, preferences, and tools → Site preferences.
v Configure email notification. Refer to FileNet P8 Administration → Process

Engine Administration → Workflow administration tasks → Coordinating
workflow design → Email notification.

v Enable logging. Refer to User Help → Using Workplace XT → Configure
Workplace XT → Configure Logging.

v Perform other configuration tasks as applicable. For a list of tasks that apply to
the full IBM FileNet P8 system, see the "Perform Additional Configuration
Tasks" in the IBM FileNet P8 Platform Installation and Upgrade Guide.
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Installing optional components
Workplace XT provides additional components that you can install and use. You
can also deploy multiple Workplace XT instances.

“Installing Workplace XT Application Integration”
You can install Application Integration if you want to integrate Workplace XT
with your Microsoft Office applications and Outlook. The Application
Integration software must be installed on each system that will use Workplace
XT Application Integration.
“Deploying multiple Workplace XT instances” on page 63
You can deploy multiple instances of Workplace XT on a single application
server. Each deployment of Workplace XT must use the same Content Engine,
Process Engine, and connection point. Each deployment of Workplace XT might
use different Site Preference files and might provide access to different object
stores.

Installing Workplace XT Application Integration
You can install Application Integration if you want to integrate Workplace XT with
your Microsoft Office applications and Outlook. The Application Integration
software must be installed on each system that will use Workplace XT Application
Integration.

Verify that the client machine meets the platform requirements documented in the
IBM FileNet P8 Hardware and Software Requirements.

You cannot collocate Workplace XT Application Integration with clients running
FileNet P8 Workplace Application Integration Toolkit.

To use Application Integration with Workplace XT, you must configure your
application server to support user token settings.

“Installing the Application Integration software interactively”
You can use the installation program to run an interactive installation for the
Application Integration software.
“Installing the Application Integration software silently” on page 61
To install the Application Integration software silently, save the
ApplicationIntegration.exe file locally and then run the file at the command
line using the /s switch.
“Verifying your Workplace XT Application Integration installation” on page 62
You can verify your Workplace XT Application Integration installation using
Microsoft Word.

Installing the Application Integration software interactively
You can use the installation program to run an interactive installation for the
Application Integration software.

To install the Application Integration software interactively:
1. Log in to the client machine using an account that has Administrator

privileges.
2. Log in to Workplace XT.
3. Click Tools → Downloads → Download Application Integration for

Microsoft(R) Office.....
4. In the dialog, do one of the following:
v Click Run to run the program from its current location.
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v Click Save. In the Save As box, find a location on your system in which to
download and save the ApplicationIntegration.exe file locally, and then
click Save. After the file is saved to your hard drive, double-click the file to
run the installation program.

A setup preparation dialog displays momentarily, followed by the Welcome
dialog for Workplace XT Application Integration.

5. Click Next.
6. Read and accept the license agreement, and click Next. If you do not accept

the license agreement, you cannot continue with the install.
7. Select the applications you want to integrate, and then click Next.

Tip: You can use the keyboard to select applications. Use the arrow keys to
move up and down the list of applications. Use the space bar to access the
context menu for any of the applications, and then use the arrow keys to
select a feature and press Enter.

Tip: The Application Integration Toolkit Components option is required to use
Application Integration.

8. Under Install to, the default installation path is displayed. Click Change to
specify a different location on the Change Current Destination Folder dialog,
and then click OK.

9. Click Next.
You might see two default installation paths, one for Microsoft Office and
Outlook, and another for the Toolkit Components. The Toolkit Components
path only appears when the system on which you are installing Application
Integration has the Toolkit Components currently installed. You cannot modify
the Toolkit Components installation path.

10. Enter the server name, port number, and application name that defines the
IBM FileNet Workplace XT address. The Server Name is the name of the web
server running Workplace XT, Port is the web server assigned port, and
Application is the name of your application, for example, Workplace XT.
Check Server uses secure connection (SSL) if you are running full SSL to
encrypt all communication with Workplace XT.
Check Server uses single sign-on (SSO) if you are using Application
Integration in an SSO environment.

Tip: You can also leave these fields blank and enter the information when you
log in to Workplace XT Application Integration.

11. Click Next.
12. Click Install.
13. After the install is complete, click Finish to complete the setup process.

Installing the Application Integration software silently
To install the Application Integration software silently, save the
ApplicationIntegration.exe file locally and then run the file at the command line
using the /s switch.

To install the Application Integration software silently:
1. Log in to the client machine using an account that has Administrator privileges.
2. Sign in to Workplace XT.
3. Click Author, and then click General Tools.
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4. Scroll down and click Download Application Integration for Microsoft Office,
and then click Save.

5. In the Save As dialog, find a location on your machine in which to download
and save the ApplicationIntegration.exe file locally, and then click Save.

6. Open a DOS command window and change the current directory to the one
where ApplicationIntegration.exe resides.

7. Type the following at the command line:
ApplicationIntegration.exe /s/v"/qn <additional
msi arguments included in string>
LICENSE_ACCEPTED=true"

Use the /s switch to launch the execution silently and include the /qn switch
in the msi string to make msi run silently.
See the following optional command line values you can also use. Append the
values within the string containing the msi arguments. For example:
ApplicationIntegration.exe /s/v"/qn /L*v
C:\temp\AppIntSetup.txt LICENSE_ACCEPTED=true"

Command Line Values Installs

ADDLOCAL=ALL All Features

ADDLOCAL=ALL REMOVE=OutlookIntegrationFeature Office Only

ADDLOCAL=ALL REMOVE=OfficeIntegrationFeature Outlook Only

ADDLOCAL=ALL
REMOVE=OutlookIntegrationFeature,OfficeIntegrationFeature

Core Only

Command Line Values Settings

HOST=host name Enter the name of the web
server running Workplace
XT.

PORT=port number Enter the Web server
assigned port number.

APPLICATION=application name Enter the directory in which
you installed the Workplace
XT application files.

SERVER_CONNECTION=1 Set Application Integration
to use an https connection

SERVER_CONNECTION=0 Set Application Integration
to use http connection. This
is the default if this
parameter is not passed.

SINGLE_SIGNON=0 Set Application Integration
to not use single sign-on
(SSO).

SINGLE_SIGNON=1 Set Application Integration
to use single sign-on (SSO).

/L*v C:\temp\AppIntSetup.txt Verbose installation log and
specify log location.

Verifying your Workplace XT Application Integration installation
You can verify your Workplace XT Application Integration installation using
Microsoft Word.
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To verify your installation:
1. Start Microsoft Word.
2. Click File → IBM FileNet Workplace XT → Open Document → Select Item. The

Login dialog box opens.
If you are using SSO and you set the Workplace XT address during installation,
the action will perform without the Login dialog box. If you did not set the
Workplace XT address, select IBM FileNet Workplace XT → Set Workplace XT
address for SSO to complete the dialog. In Office 2003, the IBM FileNet
Workplace XT choice displays under the File menu.

3. Log in using any valid account. The available object stores in your environment
are displayed.
If you did not enter the Workplace XT Address information during the
installation, you can enter the server name, port number, and application name
that define the Workplace XT address. The server name is the name of the web
server running Workplace XT, the port number is the assigned port of the Web
server, and the application is the directory where you installed the Workplace
XT application files.

4. Close all dialog boxes and close Microsoft Word.

Deploying multiple Workplace XT instances
You can deploy multiple instances of Workplace XT on a single application server.
Each deployment of Workplace XT must use the same Content Engine, Process
Engine, and connection point. Each deployment of Workplace XT might use
different Site Preference files and might provide access to different object stores.

Note:

v The procedure below assumes that you have already installed Workplace XT and
deployed one instance of the Workplace XT application. You might or might not
have signed in and configured your bootstrap preferences.

v For more information on how to deploy and manage multiple identical
applications, see your application server documentation.

v For WebLogic, deployment using a flat directory is not recommended when
there will be multiple deployments.

To deploy a second instance of the Workplace XT application:
1. Copy the Workplace XT configuration folder.

On the Workplace XT server, make a copy, WebClient2 of the Workplace XT
configuration folder found at:
install_path/IBM/FileNet/Config/WebClient

and place it in the same directory to create install_path/IBM/FileNet/
Config/WebClient2.

2. Copy the deploy folder.
On the Workplace XT server, make a copy, deploy2, of the Workplace XT
deploy folder found at:
install_path/IBM/FileNet/WebClient/deploy

and place it in the same directory to create install_path/IBM/FileNet/
WebClient/deploy2.

3. Delete the .war file and the .ear file from the deploy2 directory.
4. In the install_path/IBM/FileNet/WebClient/deploy2 directory, edit the

create_web_client_war.bat or .sh file.
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a. Make a backup of the file.
b. Change the following lines:

cd /D "%WEB_HOME%\WorkplaceXT"

"%WEB_HOME%\_AEjvm\bin\jar" -cf
"%WEB_HOME%\deploy\web_client.war" author containerSecured css
download eprocess FnJavaV1Files images include is js operations
portlets properties redirect regions scripts select UI-INF utils
WEB-INF wizards *.jsp

rem Add P8 eForms if installed.

if exist "%WEB_HOME%\deploy\eforms_add_to_war.bat"
call "%WEB_HOME%\deploy\eforms_add_to_war.bat"

to this:
cd /D "%WEB_HOME%\WorkplaceXT"

"%WEB_HOME%\_AEjvm\bin\jar" -cf
"%WEB_HOME%\deploy2\web_client2.war" author containerSecured css
download eprocess FnJavaV1Files images include is js operations
portlets properties redirect regions scripts select UI-INF utils
WEB-INF wizards *.jsp

rem Add P8 eForms if installed.

if exist
"%WEB_HOME%\deploy2\eforms_add_to_war.bat" call
"%WEB_HOME%\deploy2\eforms_add_to_war.bat"

to include the modified folder name and the new name for the WAR file,
such as web_client2.war.

5. If you want to deploy as an EAR file, modify the create_web_client_ear.bat
or .sh file in the install_path/IBM/FileNet/WebClient/deploy2 directory to
point to the modified folder names and to rename the EAR file.
a. Make a backup of the create_web_client_ear.bat or .sh file.
b. Edit the create_ear.bat or .sh file to change these lines:

cd /D "%WEB_HOME%\deploy"
"%WEB_HOME%\_AEjvm\bin\jar" -cvf
"%WEB_HOME%\deploy\web_client.ear" META-INF *.war

to this:
cd /D "%WEB_HOME%\deploy2"
"%WEB_HOME%\_AEjvm\bin\jar" -cvf
"%WEB_HOME%\deploy2\web_client2.ear" META-INF *.war

6. In the Workplace XT installation directory, edit the web.xml file.
a. In FileNet\WebClient\WorkplaceXT\WEB-INF, rename web.xml to web.xml.1.
b. Create a copy of web.xml.1 , and name it web.xml.
c. In the new web.xml, change the following parameter value:

<param-name>configurationDirectory</param-name> <param-value>C:/
Program Files/IBM/FileNet/Config/WebClient</param-value>

to set the path to the new configuration folder copy you created, for
example, install_path/IBM/FileNet/Config/WebClient2

Remember: On Windows, use double back slash (\\) in place of the
forward slash in the configurationDirectory.

d. (For deployments using the EAR file only) Change the value of the context
root to the custom name you have chosen for the new application instance,
for example, WorkplaceXT2.

7. Re-create the WAR file by running create_web_client_war.bat or .sh.
8. (For EAR file deployments only) Re-create the EAR file by running

create_web_client_ear.bat or .sh.
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9. Rename the web.xml files.
a. Rename the web.xml file that applies to the second instance to web.xml.2.
b. Rename the original file, now called web.xml.1, back to web.xml.
The original web.xml file is for the original application instance, and web.xml.2
is for the new instance. If you need to do further configuration for either
instance, you must rename the appropriate version of the file to web.xml
during the configuration.

10. Clean up the bootstrap.properties file.
If you haven't yet signed in to the Workplace XT application as part of your
first Workplace XT installation there is no need to clean up the file.
When you first sign in to Workplace XT certain values in the
bootstrap.properties file, such as the name and location of the site
preferences file, are set. To use different settings for your new Workplace XT
application you must remove the existing entries from the copied file.
The bootstrap.properties file is located in:
install_path/IBM/FileNet/Config/WebClient2

Edit the bootstrap.properties file:
a. Remove the value entered for the prefName setting. This entry contains the

name of the site preferences file stored on the object store.
b. Remove the value entered for the objectStoreId. This entry contains the

object store name where your site preferences will be stored.
c. Remove or edit any of the other values as needed.

11. In the relevant configuration files in the new IBM/FileNet/Config/WebClient2
directory, remove any comments and custom changes that should not apply to
the second Workplace XT instance.
If you have not yet signed in to the Workplace XT application as part of your
first Workplace XT installation, there is no need to clean up the files.

12. Deploy the second Workplace XT instance.
Follow the application server specific procedures to deploy your second
instance of Workplace XT using a unique name, such as Workplace XT2.
When deploying the second instance, use the newly created web_client2.war
or web_client2.ear file (depending on which method you choose) to deploy
the application:
deploy2/web_client2.war or deploy2/web_client2.ear

13. Sign in and set bootstrap preferences for the new application.
Use the following URL when signing in to set the bootstrap preferences for
your new Workplace XT instance.
http://WorkplaceXTServerName:port#/WorkplaceXT2

You must specify a unique name for the Preference name for each
deployment.
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Upgrading Workplace XT

You can upgrade your existing Workplace XT installation to the most recent
version. You will likely also need to upgrade the FileNet P8 component client
software and redeploy the Workplace XT application. You can also upgrade
optional components.

“Upgrading the Workplace XT software”
Updating the Workplace XT software is the first step in the application upgrade
process. The upgrade installer re-creates the Workplace XT folder structure and
files needed for Workplace XT.
“Installing IBM FileNet Workplace XT software updates” on page 72
After you install the IBM FileNet Workplace XT software, you must install any
service packs, fix packs, and interim fixes required for Workplace XT.
“Installing the latest Content Engine Client files on Workplace XT servers” on
page 72
The Content Engine Client software enables communication between the
Workplace XT and the Content Engine. Your Content Engine Client version on
each Workplace XT server must match the version of your Content Engine
server installation.
“Installing the latest Process Engine Client files on Workplace XT servers” on
page 76
The Process Engine Client software enables communication between the
Workplace XT and the Process Engine. You must install the Process Engine
Client files on all Workplace XT servers.
“Deploying Workplace XT after upgrading” on page 82
After you upgrade the Workplace XT software and install any additional
software updates, you must redeploy the application on the Web application
server. You can re-create the WAR or EAR file before you deploy to include
changes from software updates.
“Migrating folder preferences” on page 90
If you defined folder preferences in your previous Workplace XT version, you
must migrate the folder preferences after you upgrade your software. You
cannot use Workplace XT until you migrate the folder preferences.
“Upgrading optional components” on page 90
You can upgrade the additional or optional components that you installed to
work with Workplace XT.

Upgrading the Workplace XT software
Updating the Workplace XT software is the first step in the application upgrade
process. The upgrade installer re-creates the Workplace XT folder structure and
files needed for Workplace XT.

“Enabling screen reader assistive technology for the upgrade tool” on page 68
If you plan to use JAWS screen reader for the upgrade program, you must
perform the following tasks before you begin the upgrade.
“Upgrading the Workplace XT software” on page 68
As part of the Workplace XT software upgrade, you must back up and
undeploy your existing installation. You can then run the setup program to
upgrade the software.
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“Configuring folder preferences” on page 71
If you plan to use folder preferences, which enable users to associate folders
with entry templates and customize columns, you must first configure the
annotations class on your Enterprise Manager. Folder preferences do not apply
if your Content Engine is at version 3.5.

Enabling screen reader assistive technology for the upgrade
tool

If you plan to use JAWS screen reader for the upgrade program, you must perform
the following tasks before you begin the upgrade.

To enable screen reader assistive technology:
1. Ensure that the Sun Java JRE 1.5.0 or 1.5.x is installed on the system where you

will be performing the install.
2. Install the Java Access Bridge (available at http://java.sun.com).
3. Start the JAWS screen reader.

Upgrading the Workplace XT software
As part of the Workplace XT software upgrade, you must back up and undeploy
your existing installation. You can then run the setup program to upgrade the
software.

To upgrade the Workplace XT software:
1. Log in to the application server where Workplace XT is installed.

Option Description

UNIX Log in as a user with read, write, and
execute access to the directory where you
plan to upgrade Workplace XT.

Windows Log in as a member of the local
Administrators group or a user with
equivalent permissions.

2. From Process Task Manager, stop Component Manager (if running), then exit
the Process Task Manager application.

3. (Windows only) From the Windows Services console, stop the Process WPXT
Services Manager service.

4. (Windows only) Using the Windows Task Manager, verify that no javaw.exe
processes are running.
If the applications in the preceding steps stopped correctly, no Workplace
XT-related javaw.exe processes should be running. If needed, use Windows
Task Manager or some other process management tool to stop all javaw.exe
processes that are in the directory path install_path\_WCjvm\bin.

5. Back up, undeploy, and remove the Workplace XT (web_client) Web
application from the J2EE application server.
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Option Description

WebSphere Application Server 1. Back up the deployed Workplace XT
directory:

WAS_HOME/profiles/default/
installedApps/node_name/
WorkplaceXT.ear/web_client.war

2. Stop the Workplace XT application from
the WebSphere administration console.

3. Uninstall the Workplace XT application
from Enterprise Applications.

4. Save the changes and stop the
WebSphere server.

5. Delete the temporary Workplace XT
directory (default: WorkplaceXT) from:

WAS_HOME/profiles/default/temp/
node_name/instance/

WebLogic Server 1. From the WebLogic Server
administration console, stop the
Workplace XT Web Application Module.

2. Make a backup copy of the Workplace
XT folder:

install_path/WorkplaceXT

3. Delete the Workplace XT Web
Application Module.

4. Stop the WebLogic Server.

JBoss Application Server 4.0.x 1. Stop the JBoss Application Server server.

2. Back up the deployed Workplace XT
application:

JBOSS_HOME/server/server_name/deploy/
application_name.war or .ear

3. Delete the Workplace XT application
from the deployed location.

4. Clear out all files and folders within the
following temp directories:

JBoss_home/server/server_name/tmp/
deploy

JBoss_home/server/server_name/work/
jboss.web/localhost

6. (For systems with the IBM Content Manager OnDemand (CMOD) site
preference configured) Move the CMOD key store and change the
keyStorePath context parameter in the web.xml file.
a. Copy the CMOD key store file, cmodKeyStore. The default location is in the

following path:
install_path/WorkplaceXT/WEB-INF

b. Place the copy of the cmodKeyStore file into the Config/WebClient
directory, in the following path:
install_path/FileNet/Config/WebClient

c. Change the value for the keyStorePath parameter in the web.xml file to
match the new location of the key store file:
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<context-param>
<param-name>keyStorePath</param-name>
<param-value>install_path/FileNet/Config/WebClient/cmodKeyStore
</param-value>
</context-param>

7. Optional: Copy existing configuration files.
If you have made custom changes to your configuration files in the deployed
location, do the following before you upgrade the existing Workplace XT
installation.
Copy the following files:
v WcmApiConfig.properties

v web.xml

from the /WEB-INF folder in the backed-up Workplace XT directory created in
the previous step to the following directory:
install_path/WorkplaceXT/WEB-INF/

8. Start the upgrade process in one of the following ways, depending on
whether you want to upgrade in interactive or silent mode:

Option Description

To upgrade Workplace XT interactively: 1. Access the Workplace XT installation
software package.

2. Launch the appropriate Setup program
(WorkplaceXT-1.1.4.0-
operating_system.bin or .exe) and
follow the prompts in the wizard
screens. The installer detects and copies
settings from the previous Workplace XT
installation.

To upgrade Workplace XT silently: 1. Access the Workplace XT installation
software package, and copy the
XT_silent_upgrade.txt file to a local
directory.

2. Follow the instructions in the silent input
file to edit the values to reflect the
appropriate responses for your
installation.

Even if you accept all defaults in the
XT_silent_upgrade.txt file, you must
edit the file to accept the license
agreement (-V licenseAccepted="true").

3. From a command prompt, navigate to
and run the installer:

UNIX ./WorkplaceXT-1.1.4.0-
operating_system.bin -options
"path_to_edited_input_file/
XT_silent_upgrade.txt"
-silent

Windows
WorkplaceXT-1.1.4.0-Win.exe
-options
"path_to_edited_input_file\
XT_silent_upgrade.txt"
-silent
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9. When the upgrade program is complete, view the
web_client_install_log_1.1.4.0.txt file located in: install_path/FileNet/
WebClient.
Verify that no errors or failures were logged. Correct any errors before you
proceed.

10. Optional: Update files to support user tokens for Workplace XT.
If you are upgrading Workplace XT to 1.1.4.0, but your Content Engine is still
at 4.0, the following step does not apply.

Option Description

WebSphere 1. Copy the authentication-websphere.jar
file from here:

install_path/FileNet/WebClient/
WorkplaceXT/authenticationFiles

to here:

WAS_home/AppServer/lib/ext

2. Copy the log4j-1.2.13.jar file from
here:

install_path/FileNet/WebClient/
WorkplaceXT/WEB-INF/lib

to here:

WAS_home/AppServer/lib/ext

WebLogic 1. Copy the authentication-weblogic.jar
file from here:

install_path/FileNet/WebClient/
WorkplaceXT/authenticationFiles

to here:

WL_home/server/lib/mbeantypes

2. Copy the log4j-1.2.13.jar file from
here:

install_path/FileNet/WebClient/
WorkplaceXT/WEB-INF/lib

to here:

WL_home/server/lib/mbeantypes

JBoss Copy the authentication-utils.jar file
from here:

install_path/FileNet/WebClient/
WorkplaceXT/authenticationFiles

to here:

JBOSS_home/server/server_name/lib

Configuring folder preferences
If you plan to use folder preferences, which enable users to associate folders with
entry templates and customize columns, you must first configure the annotations
class on your Enterprise Manager. Folder preferences do not apply if your Content
Engine is at version 3.5.

The procedure adds an annotation class called Folder Preferences to the annotation
list under Other Classes.
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For more information on using folder preferences, see the IBM FileNet Workplace
XT help topic User help → Actions, preferences, and tools → Actions → Manage
folders.

To configure folder preferences:
1. On the Workplace XT server, copy the following folder and the files it

contains:
install_path/WebClient/WorkplaceXT/addons

to a temp location on the Content Engine server.
2. Log into Enterprise Manager.
3. Right click on an object store where you want to enable folder preferences.
4. Select All Tasks → Import All.
5. Click the Import Options tab.
6. For the Import Manifest File field, click Browse.
7. Browse to the addons folder that you copied from the Workplace XT server to

the Content Engine temp location, and select the file
WorkplaceXTExtensions.xml.

8. Click OK.
9. Click the Scripts tab.

10. In the Run-Type dropdown list, choose Post import.
11. Browse to the addons folder that you copied from the Workplace XT server to

the Content Engine temp location, and select the file
WorkplaceXTFolderPreferencesSecurity.vbs.

12. Click OK.
13. Click Import.
14. When the status message displays, click OK.
15. Repeat this procedure on all object stores where you want to enable folder

preferences.

Installing IBM FileNet Workplace XT software updates
After you install the IBM FileNet Workplace XT software, you must install any
service packs, fix packs, and interim fixes required for Workplace XT.

To install the Workplace XT software updates:
1. To download the latest software updates, and to determine which of these

updates might be required for use with other components and expansion
products, see the IBM FileNet P8 Compatibility Matrix.

2. Open the readmes for the software updates and perform the installation
procedures provided.

Installing the latest Content Engine Client files on Workplace XT
servers

The Content Engine Client software enables communication between the
Workplace XT and the Content Engine. Your Content Engine Client version on
each Workplace XT server must match the version of your Content Engine server
installation.

“Installing the latest Content Engine Client files on Workplace XT servers
interactively” on page 73
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The installation wizard provides an interactive way to install the Content
Engine Client files. You can use the values from your worksheet to fill in the
required value for each field on the wizard screens.
“Installing the latest Content Engine Client files on Workplace XT servers
silently” on page 74
The command-line method provides a way to silently install the Content
Engine Client files. You can use the values in your installation worksheet to edit
the silent input text file before you run the installation.

Installing the latest Content Engine Client files on Workplace
XT servers interactively

The installation wizard provides an interactive way to install the Content Engine
Client files. You can use the values from your worksheet to fill in the required
value for each field on the wizard screens.

Important: If you are performing a staged upgrade, and are upgrading Workplace
XT before you upgrade the Content Engine server to 4.5 or later, do not perform
this task. You can return to update the Content Engine Client files after you
upgrade Content Engine to version 4.5 or later.

To install the Content Engine Client files:
1. Open your completed Installation and Upgrade Worksheet file.

Tip: In the worksheet file, verify that the Data → Filter → AutoFilter command
is enabled. To view only Content Engine Client values, filter by CE Client
Installer in the Installation or Configuration Program column.

2. To download the latest software updates, and to determine which of these
updates might be required for use with other components and expansion
products, see the IBM FileNet P8 Compatibility Matrix.

3. Log on to the server where Workplace XT is installed as any user who has the
following permissions:
v Read and write permission to a temporary directory, such as temp for

Windows or tmp for UNIX, on the machine where Workplace XT is
installed.

v Execute permission on the Content Engine Client install software.
4. Verify that there is a current backup of Workplace XT.
5. Copy the Content Engine Client install software from the Content Engine

installation software to the temporary directory. The version of the install
software must match the version of Content Engine.

6. Expand the TAR or ZIP of the Content Engine Client install software within
the temporary directory.

7. Close all instances of Workplace XT and any other client applications. From
the application server administrative console, stop and undeploy Workplace
XT.

Option Description

WebSphere Application Server Stop and undeploy the Workplace XT
application.

WebLogic Server Stop and undeploy the Workplace XT
application.

JBoss Application Server Run the shutdown command.
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8. (WebLogic Server only) Manually delete the following application server cache
directories, substituting your domain name in place of mydomain:

Option Description

WebLogic Server UNIX /opt/bea/user_projects/domains/mydomain/
servers/AdminServer/tmp/_WL_user/
web_client

/opt/ bea/user_projects/domains/
mydomain/servers/.wlnotdelete

/opt/bea/user_projects/domains/mydomain/
servers/AdminServer/cache/
EJBCompilerCache

WebLogic Server Windows C:\bea\user_projects\domains\mydomain\
servers\AdminServer\tmp\_WL_user\
web_client

C:\bea\user_projects\domains\mydomain\
servers\.wlnotdelete

C:\bea\user_projects\domains\mydomain\
servers\AdminServer\cache\
EJBCompilerCache

9. Access the Content Engine Client update software.
10. Run the command for your operating system. CE_version is the version of

your Content Engine, for example, 4.5.1.

Operating System Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN

HPUX P8CE-CLIENT-CE_version-HPUX.BIN

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN

Linux P8CE-CLIENT-CE_version-LINUX.BIN

Solaris P8CE-CLIENT-CE_version-SOL.BIN

Windows P8CE-CLIENT-CE_version-WIN.EXE

Linux on System z P8CE-CLIENT-CE_version-ZLINUX.BIN

11. Complete the installation program screens using the parameters you collected
in the Installation and Upgrade Worksheet.
You can specify on the installation program which applications you want to
update. If the installation program does not automatically detect Workplace
XT, select it on the appropriate panel.
You can also choose to have the installation program create the deployment
file, or create the file later. If you have additional configuration to perform,
you can defer the file creation to avoid running multiple processes to create
the same file.

Installing the latest Content Engine Client files on Workplace
XT servers silently

The command-line method provides a way to silently install the Content Engine
Client files. You can use the values in your installation worksheet to edit the silent
input text file before you run the installation.
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Important: If you are performing a staged upgrade, and are upgrading Workplace
XT before you upgrade the Content Engine server to 4.5, do not perform this task.
You will return to update the Content Engine Client files after you upgrade
Content Engine to version 4.5.

Install the Content Engine Client files and any updates that are available.

To install the Content Engine Client files:
1. Open your completed Installation and Upgrade Worksheet file.

Tip: In the worksheet file, verify that the Data → Filter → AutoFilter command
is enabled. To view only Content Engine Client values, filter by CE Client
Installer in the Installation or Configuration Program column.

2. To download the latest software updates, and to determine which of these
updates might be required for use with other components and expansion
products, see the IBM FileNet P8 Compatibility Matrix.

3. Log on to the server where Workplace XT is installed as any user who has the
following permissions:
v Read and write permission to a temporary directory, such as temp for

Windows or tmp for UNIX, on the machine where Workplace XT is
installed.

v Execute permission on the Content Engine Client install software.
4. Verify that there is a current backup of Workplace XT.
5. Close all instances of Workplace XT and any other client applications. From

the application server administrative console, stop and undeploy Workplace
XT.

Option Description

WebSphere Application Server Stop and undeploy the Workplace XT
application.

WebLogic Server Stop and undeploy the Workplace XT
application.

JBoss Application Server Run the shutdown command.

6. (WebLogic Server only) Manually delete the following application server cache
directories, substituting your domain name in place of mydomain:

Option Description

WebLogic Server UNIX /opt/bea/user_projects/domains/mydomain/
servers/AdminServer/tmp/_WL_user/
web_client

/opt/ bea/user_projects/domains/
mydomain/servers/.wlnotdelete

/opt/bea/user_projects/domains/mydomain/
servers/AdminServer/cache/
EJBCompilerCache
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Option Description

WebLogic Server Windows C:\bea\user_projects\domains\mydomain\
servers\AdminServer\tmp\_WL_user\
web_client

C:\bea\user_projects\domains\mydomain\
servers\.wlnotdelete

C:\bea\user_projects\domains\mydomain\
servers\AdminServer\cache\
EJBCompilerCache

7. Copy the Content Engine Client install software from the Content Engine
installation software to the temporary directory. The version of the install
software must match the version of Content Engine.

8. Expand the TAR or ZIP of the Content Engine Client install software within
the temporary directory.

9. Make a backup copy of the input file, CEClient_silent_install.txt.
10. Edit the silent input file to reflect the appropriate responses for your update.

The silent input file provides instructions for editing the values. Use the
parameters recorded in the Installation and Upgrade Worksheet for your
installation.

11. Navigate to the path containing the Content Engine Client installation
program.

12. Run one of the commands in the following table to perform the silent install.
In the commands,
CE_version is the version of your Content Engine, for example, 4.5.1.
path is the path that contains the installation program.

Operating
System Install Command

AIX P8CE-CLIENT-CE_version-AIX.BIN -f path/CECLIENT.AIX/
CEClient_silent_install.txt -i silent

HPUX P8CE-CLIENT-CE_version-HPUX.BIN -f path/CEClient.HPUX/
CEClient_silent_install.txt -i silent

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN -f path/CEClient.HPUXI/
CEClient_silent_install.txt -i silent

Linux P8CE-CLIENT-CE_version-LINUX.BIN -f path/CEClient.Linux/
CEClient_silent_install.txt -i silent

Solaris P8CE-CLIENT-CE_version-SOL.BIN -f path/CEClient.Solaris/
CEClient_silent_install.txt -i silent

Windows P8CE-CLIENT-CE_version-WIN.EXE -f path\CEClient.Windows\
CEClient_silent_install.txt -i silent

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN -f path/CEClient.zLinux/
CEClient_silent_install.txt -i silent

Installing the latest Process Engine Client files on Workplace XT
servers

The Process Engine Client software enables communication between the Workplace
XT and the Process Engine. You must install the Process Engine Client files on all
Workplace XT servers.
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“Installing the latest Process Engine Client files on Workplace XT servers
interactively”
The installation wizard provides an interactive way to install the Process Engine
Client files. You can use the values you collected on your worksheet to fill in
the required value for each field on the wizard screens.
“Installing the latest Process Engine Client files on Workplace XT servers
silently” on page 79

Installing the latest Process Engine Client files on Workplace
XT servers interactively

The installation wizard provides an interactive way to install the Process Engine
Client files. You can use the values you collected on your worksheet to fill in the
required value for each field on the wizard screens.

Important: If you are performing a staged upgrade, and are upgrading Workplace
XT before you upgrade the Process Engine server to version 4.5 or later, do not
perform this task. You can return to update the Process Engine Client files after
you upgrade Process Engine to version 4.5 or later.

To install the Process Engine Client files:
1. Open your completed Installation and Upgrade Worksheet file.

Tip: In the worksheet file, verify that the Data → Filter → AutoFilter command
is enabled. To view only Process Engine Client values, filter by PE Client
Installer in the Installation or Configuration Program column.

2. To download the latest software updates, and to determine which of these
updates might be required for use with other components and expansion
products, see the IBM FileNet P8 Compatibility Matrix.

3. Log on to the server where Workplace XT is installed as any user who has the
following permissions:
v Read and write permission to a temporary directory, such as temp for

Windows or tmp for UNIX, on the machine where Workplace XT is
installed.

v Execute permission on the Process Engine Client install software.
4. Back up the deployed Web application directory.
5. Copy the Process Engine Client install software from the Process Engine

installation software to the temporary directory. The version of the install
software must match the version of Process Engine.

6. Expand the TAR or ZIP of the Process Engine Client install software within
the temporary directory. The jre.tar file that is packaged with the Process
Engine Client installer must be in the same directory as the Process Engine
Client installation program when the program is run.

7. From Process Task Manager, stop the Component Manager(s) (if running),
then exit the Process Task Manager application.

8. If you wish to retain your existing configurations, copy the following
configuration files from the backup copy of your deployed application to the
/WEB-INF folder in the installed directory on your application server,
overwriting the existing installed files.

Important: You must do this before you apply the fix pack to the existing
installation.
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The backup of these files is to ensure the files are still available in case there is
any reason to go back to the previous versions. When redeploying after
installing the fix pack, any custom settings will be added back to the deployed
working directory.
From the /WEB-INF folder in the backed-up Workplace XT directory you
created, copy these files:
WcmApiConfig.properties

web.xml

to here
XT_install_path/WorkplaceXT/WEB-INF/

9. Close all instances of Workplace XT and any other client applications. From
the application server administrative console, stop and undeploy Workplace
XT.

Option Description

WebSphere Application Server Stop and undeploy the Workplace XT
application.

WebLogic Server Stop and undeploy the Workplace XT
application.

JBoss Application Server Run the shutdown command.

10. (WebLogic Server only) Manually delete the following application server cache
directories, substituting your domain name in place of mydomain:

Option Description

WebLogic Server UNIX /opt/bea/user_projects/domains/mydomain/
servers/AdminServer/tmp/_WL_user/
web_client

/opt/ bea/user_projects/domains/
mydomain/servers/.wlnotdelete

/opt/bea/user_projects/domains/mydomain/
servers/AdminServer/cache/
EJBCompilerCache

WebLogic Server Windows C:\bea\user_projects\domains\mydomain\
servers\AdminServer\tmp\_WL_user\
web_client

C:\bea\user_projects\domains\mydomain\
servers\.wlnotdelete

C:\bea\user_projects\domains\mydomain\
servers\AdminServer\cache\
EJBCompilerCache

11. (JBoss Application Server only) Delete the deployed Web application directory,
or WAR or EAR file.

12. Access the Process Engine Client software.
13. Run the appropriate installation program for your operating system.

In the program command, version is the version of your Process Engine client
and server installation.
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Operating System Installation Program

AIX P8PE-CLIENT-version-AIX.BIN

HPUX P8PE-CLIENT-version-HPUX.BIN

HPUXi P8PE-CLIENT-version-HPUXI.BIN

Linux P8PE-CLIENT-version-LINUX.BIN

Solaris P8PE-CLIENT-version-SOL.BIN

Windows P8PE-CLIENT-version-WIN.EXE

Linux on System z P8PE-CLIENT-version-ZLINUX.BIN

14. Use the parameters you gathered in the Installation and Upgrade Worksheet
to complete the program panels and run the installation.
You can specify on the panels which applications you want to update. If the
installation program does not automatically detect Workplace XT, select it on
the appropriate panel.
You can also choose to have the installation program create the deployment
file, or create the file later. If you have additional configuration to perform,
you can defer the file creation to avoid running multiple processes to create
the same file.

15. (For upgrades from Process Engine 4.0 to 4.5 only) Add required JAR files to
the Component Manager library.
a. Start the Process Task Manager by running one of the following command

files from the install_path/FileNet/WebClient/Router directory,
depending on your operating system:

UNIX routercmd.sh

Windows
routercmd.bat

b. In the Process Task Manager console, under Workplace XT, Component
manager node, select your connection point.

c. Stop the connection point instance.
d. Click the Required libraries tab.
e. Click Add, and browse to /Router/lib.
f. Select the following files to add:

ContentExtendedOps.jar

smtp.jar

Installing the latest Process Engine Client files on Workplace
XT servers silently

Important: If you are performing a staged upgrade, and are upgrading Workplace
XT before you upgrade the Process Engine server to version 4.5 or later, do not
perform this task. You can return to update the Process Engine Client files after
you upgrade Process Engine to version 4.5 or later.

To install the Process Engine Client files:
1. Open your completed Installation and Upgrade Worksheet file.

Tip: In the worksheet file, verify that the Data → Filter → AutoFilter command
is enabled. To view only Process Engine Client values, filter by PE Client
Installer in the Installation or Configuration Program column.
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2. To download the latest software updates, and to determine which of these
updates might be required for use with other components and expansion
products, see the IBM FileNet P8 Compatibility Matrix.

3. Log on to the server where Workplace XT is installed as any user who has the
following permissions:
v Read and write permission to a temporary directory, such as temp for

Windows or tmp UNIX, on the machine where Workplace XT is installed.
v Execute permission on the Process Engine Client install software.

4. Back up the deployed Web application directory.
5. Copy the Process Engine Client install software from the Process Engine

installation software to the temporary directory. The version of the install
software must match the version of Process Engine.

6. Expand the TAR or ZIP of the Process Engine Client install software within
the temporary directory. The jre.tar file that is packaged with the Process
Engine Client installer must be in the same directory as the Process Engine
Client installation program when the program is run.

7. From Process Task Manager, stop the Component Manager(s) (if running),
then exit the Process Task Manager application.

8. If you wish to retain your existing configurations, copy the following
configuration files from the backup copy of your deployed application to the
/WEB-INF folder in the installed directory on your application server,
overwriting the existing installed files.

Important: You must do this before you apply the fix pack to the existing
installation.
The backup of these files is to ensure the files are still available in case there is
any reason to go back to the previous versions. When redeploying after
installing the fix pack, any custom settings will be added back to the deployed
working directory.
From the /WEB-INF folder in the backed-up Workplace XT directory you
created, copy these files:
WcmApiConfig.properties

web.xml

to here
XT_install_path/WorkplaceXT/WEB-INF/

9. Close all instances of Workplace XT and any other client applications. From
the application server administrative console, stop and undeploy Workplace
XT.

Option Description

WebSphere Application Server Stop and undeploy the Workplace XT
application.

WebLogic Server Stop and undeploy the Workplace XT
application.

JBoss Application Server Run the shutdown command.

10. (WebLogic Server only) Manually delete the following application server cache
directories, substituting your domain name in place of mydomain:
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Option Description

WebLogic Server UNIX /opt/bea/user_projects/domains/mydomain/
servers/AdminServer/tmp/_WL_user/
web_client

/opt/ bea/user_projects/domains/
mydomain/servers/.wlnotdelete

/opt/bea/user_projects/domains/mydomain/
servers/AdminServer/cache/
EJBCompilerCache

WebLogic Server Windows C:\bea\user_projects\domains\mydomain\
servers\AdminServer\tmp\_WL_user\
web_client

C:\bea\user_projects\domains\mydomain\
servers\.wlnotdelete

C:\bea\user_projects\domains\mydomain\
servers\AdminServer\cache\
EJBCompilerCache

11. (JBoss Application Server only) Delete the deployed Web application directory,
or WAR or EAR file.

12. Access the Process Engine Client software.
13. Copy the PEClient_silent_input.txt file to a local directory.
14. Edit the file to reflect the appropriate responses for your installation. The

silent input file provides instructions for editing the values. Use the
parameters recorded in the Installation and Upgrade Worksheet for your
installation.

15. Change the Variable_CheckboxXT line to the following:
-V Variable_CheckboxXT="true"

16. Run the Process Engine Client installer with the command for your operating
system.
In the command, version is the version of your Process Engine Client and
server installation, for example, 4.5.1.

Operating System Install Program

AIX P8PE-CLIENT-version-AIX.BIN -options
"PEClient_silent_install.txt" -silent

HPUX P8PE-CLIENT-version-HPUX.BIN -options
"PEClient_silent_install.txt" -silent

HPUXi P8PE-CLIENT-version-HPUXI.BIN -options
"PEClient_silent_install.txt" -silent

Linux P8PE-CLIENT-version-LINUX.BIN -options
"PEClient_silent_install.txt" -silent

Solaris P8PE-CLIENT-version-SOL.BIN -options
"PEClient_silent_install.txt" -silent

Windows P8PE-CLIENT-version-WIN.EXE -options
"PEClient_silent_install.txt" -silent

zLinux P8PE-CLIENT-version-ZLINUX.BIN -options
"PEClient_silent_install.txt" -silent
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17. (For upgrades from Process Engine 4.0 to 4.5 only) Add required JAR files to
the Component Manager library.
a. Start the Process Task Manager by running one of the following command

files from the install_path/FileNet/WebClient/Router directory,
depending on your operating system:

UNIX routercmd.sh

Windows
routercmd.bat

b. In the Process Task Manager console, under Workplace XT, Component
manager node, select your connection point.

c. Stop the connection point instance.
d. Click the Required libraries tab.
e. Click Add, and browse to /Router/lib.
f. Select the following files to add:

ContentExtendedOps.jar

smtp.jar

Deploying Workplace XT after upgrading
After you upgrade the Workplace XT software and install any additional software
updates, you must redeploy the application on the Web application server. You can
re-create the WAR or EAR file before you deploy to include changes from software
updates.

“Re-creating the WAR and EAR files”
If you are using a WAR file or EAR file for deployment, you must re-create the
WAR file or WAR and EAR files and redeploy the application each time you
make changes to files in the install_path/IBM/FileNet/WebClient/WorkplaceXT
directory. If you chose not to have the Content Engine or Process Engine Client
installers create your deployment file, or if you made changes to web.xml for
SSO support or any other edits, you must re-create the WAR and EAR files.
“Deploying IBM FileNet Workplace XT on WebSphere Application Server” on
page 83
After you install and configure Workplace XT, you must deploy the Web
application on your WebSphere Application Server.
“Deploying Workplace XT on WebLogic Server” on page 86
After you install and configure Workplace XT, you must deploy the client
application on your WebLogic Server. You might be required to re-create the
WAR or WAR and EAR files before you deploy.
“Deploying Workplace XT on JBoss Application Server” on page 88
After you install and configure Workplace XT, you must deploy your client
application on your JBoss Application Server. You might be required to re-create
the WAR or WAR and EAR files before you deploy.

Re-creating the WAR and EAR files
If you are using a WAR file or EAR file for deployment, you must re-create the
WAR file or WAR and EAR files and redeploy the application each time you make
changes to files in the install_path/IBM/FileNet/WebClient/WorkplaceXT directory.
If you chose not to have the Content Engine or Process Engine Client installers
create your deployment file, or if you made changes to web.xml for SSO support or
any other edits, you must re-create the WAR and EAR files.
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To re-create the WAR and EAR files:
1. If you will be deploying from a WAR file, verify that web_client.war exists. To

re-create the WAR file, run one of the following commands:

Option Description

UNIX install_path/IBM/FileNet/WebClient/
deploy/create_web_client_war.sh

Windows install_path\IBM\FileNet\WebClient\
deploy\create_web_client_war.bat

2. If you will be deploying from an EAR file, verify that both web_client.war and
web_client.ear exist. To re-create the EAR file, first re-create the WAR file, and
then run the following command to re-create the EAR file:

Option Description

UNIX install_path/IBM/FileNet/WebClient/
deploy/create_web_client_ear.sh

Windows install_path\IBM\FileNet\WebClient\
deploy\create_web_client_ear.bat

Deploying IBM FileNet Workplace XT on WebSphere
Application Server

After you install and configure Workplace XT, you must deploy the Web
application on your WebSphere Application Server.

“Deploying Workplace XT on WebSphere Application Server 6.1”
Deploy Workplace XT as an application in the WebSphere 6.1 administrative
console. You can specify the context root for the application URL during the
deployment.
“Deploying Workplace XT on WebSphere Application Server 7.0” on page 85
Deploy Workplace XT as an application in the WebSphere administrative
console. You can specify the context root for the application URL during the
deployment.

Deploying Workplace XT on WebSphere Application Server 6.1
Deploy Workplace XT as an application in the WebSphere 6.1 administrative
console. You can specify the context root for the application URL during the
deployment.

To deploy Workplace XT:
1. Log on to the WebSphere administrative console.
2. Navigate to Applications → Enterprise Applications → Install

3. Select the file to deploy.
v (If the administrative console is running locally) Select Local file system

and enter or browse to the location of the web_client.war or
web_client.ear file created by the installation program. For example,
install_path/deploy/web_client.war or install_path/deploy/
web_client.ear. Do not enter the machine name.

v (If the administrative console is remote) Select Remote file system and
enter the fully-qualified path name to the web_client.war or
web_client.ear file. For example, install_path/deploy/web_client.war or
install_path/deploy/web_client.ear. Do not enter the machine name.
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4. If you are deploying a WAR file, enter the context root.
5. Enter WorkplaceXT and click Next to proceed to deploying a new application.

Tip: The context root is the name of the application you log in to using the
web interface, such as: http://server_name:port#/WorklaceXT. Do not include a
space.

6. Click Prompt me only when additional information is required, and click
Next to proceed to deploying a new application.

7. Complete the dialogs for installing a new application, using the following
settings:
v On the Select installation options page, for Application name, enter

Workplace XT, or the name you chose to call the application.
v On the Map modules to servers page, for Clusters and Servers, specify the

server you are planning to use. Verify that your application name is selected
and associated with the correct server and nodes, if applicable.

v On the Map virtual hosts for Web modules page, for virtual host, choose
the default_host.

8. Save your configuration.
9. Navigate to Applications → Enterprise Applications → Workplace → Class

loading and update detection.
10. Set the polling interval for updated files with a number appropriate for your

environment, for example, 3 seconds.
11. Change the Class loader order to Classes loaded with application class

loader first.
12. Click Apply.
13. Click Workplace → Manage Modules.
14. Click Workplace.
15. Change the Class loader order to Classes loaded with application class

loader first.

Important: Do this only for the specific web application. Do not change the
similar settings for the entire application server.

16. Navigate to Enterprise Applications → Workplace → Security role to
user/group mapping.

17. Verify that the All Authenticated column is checked for the "All
Authenticated" role.

18. Verify that the Everyone? column is checked for the Everyone role.
19. Save all your changes to the master configuration.
20. Stop and restart WebSphere Application Server.
21. (Windows only) From the Windows Services Console, restart the Process

Workplace XT Services Manager service.
22. Restart Process Task Manager and Component Manager.
23. Exit the Process Task Manager application.
24. Start Workplace XT from the administrative console.
25. To troubleshoot the deployment, check the following log:

WAS_install_path/AppServer/profiles/profile_name/logs/server_name/
SystemOut.log
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Deploying Workplace XT on WebSphere Application Server 7.0
Deploy Workplace XT as an application in the WebSphere administrative console.
You can specify the context root for the application URL during the deployment.

To deploy Workplace XT:
1. Log on to the WebSphere administrative console.
2. Navigate to Applications → WebSphere Enterprise Applications → New

Enterprise Applications → Install

3. Select the file to deploy.
v (If the administrative console is running locally) Select Local file system

and enter or browse to the location of the web_client.war or web_client.ear
file created by the installation program. For example, install_path/deploy/
web_client.war or install_path/deploy/web_client.ear. Do not enter the
machine name.

v (If the administrative console is remote) Select Remote file system and
enter the fully-qualified path name to the web_client.war or
web_client.ear file. For example, install_path/deploy/web_client.war or
install_path/deploy/web_client.ear. Do not enter the machine name.

4. Click Fast Path, and click Next. Complete the dialogs for installing a new
application, using the following settings:
v On the Select installation options page, for Application name, enter

Workplace XT, or the name you chose to call the application.
v On the Map modules to servers page, for Clusters and Servers, specify the

server you are planning to use. Verify that your application name is selected
and associated with the correct server and nodes, if applicable.

v On the Map virtual hosts for Web modules page, for virtual host, choose
the default_host.

v (WAR file deployment only) On the Map context roots for Web modules
page, for Context root, specify WorkplaceXT, or whatever you want to call
the application.

Tip: The context root is the name of the application you log in to using the
Web interface. If you enter WorkplaceXT, the application URL will be
http://server_name:port#/WorkplaceXT.

5. Save your configuration.
6. Navigate to Applications → Enterprise Applications → Workplace → Class

loading and update detection.
7. Set the polling interval for updated files with a number appropriate for your

environment, for example, 3 seconds.
8. Change the Class loader order to Classes loaded with local class loader first

(parent last).
9. Click Apply.

10. Click Workplace → Manage Modules.
11. In the Modules column, click Workplace XT.
12. Change the Class loader order to Classes loaded with local class loader first

(parent last).

Important: Do this only for the specific web application. Do not change the
similar settings for the entire application server.

13. Navigate to Enterprise Applications → Workplace → Security role to
user/group mapping.
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14. Select the All Authenticated role and click Map Special Subjects.
15. Map the All Authenticated role to the All Authenticated in Applications

realm.
16. Select the Everyone role and click Map Special Subjects.
17. Map the Everyone role to Everyone.
18. Save all your changes to the master configuration.
19. Stop and restart WebSphere Application Server.
20. (Windows only) From the Windows Services Console, restart the Process

Workplace XT Services Manager service.
21. Restart Process Task Manager and Component Manager.
22. Exit the Process Task Manager application.
23. Start Workplace XT from the administrative console.
24. To troubleshoot the deployment, check the following log:

WAS_install_path/AppServer/profiles/profile_name/logs/server_name/
SystemOut.log

Workplace XT requires that the client operating system has the Java Runtime
Environment (JRE) downloaded and installed. If JRE is not installed, users will be
prompted to install the JRE on first login.

Deploying Workplace XT on WebLogic Server
After you install and configure Workplace XT, you must deploy the client
application on your WebLogic Server. You might be required to re-create the WAR
or WAR and EAR files before you deploy.

“Renaming the WAR file”
You can rename the WAR file if you are using a WAR file for deployment, and
you want to use "Workplace XT" or a custom name for the context root of the
application. The context root is part of the URI that end users type to access
Workplace XT.
“Deploying Workplace XT on WebLogic Server 9.2” on page 87
To use Workplace XT as a Web application, you must deploy it as an
application in the WebLogic Server Administration Console. You can specify the
context root for the application URL during the deployment.

Renaming the WAR file
You can rename the WAR file if you are using a WAR file for deployment, and you
want to use "Workplace XT" or a custom name for the context root of the
application. The context root is part of the URI that end users type to access
Workplace XT.

By default, when you deploy from a WAR file, the context root is the first part of
the WAR filename. For example, the default web_client.war will generate a context
root of http://server_name:port#/webclient. If you want to use http://
server_name:port#/custom_name, you must rename web_client.war to
custom_name.war.

To rename the WAR file:

Use the rename command to rename the WAR file. Enter the command without
the line break.
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Option Description

UNIX mv install_path/IBM/FileNet/WebClient/
deploy/web_client.war install_path/IBM/
FileNet/WebClient/deploy/
custom_name.war

Windows rename install_path\IBM\FileNet\
WebClient\deploy\web_client.war
install_path\IBM\FileNet\WebClient\
deploy\custom_name.war

Deploying Workplace XT on WebLogic Server 9.2
To use Workplace XT as a Web application, you must deploy it as an application in
the WebLogic Server Administration Console. You can specify the context root for
the application URL during the deployment.

To deploy Workplace XT:
1. From the WebLogic Server Administration Console, navigate to the domain you

initially created for the Application Engine.
2. Prepare the WebLogic Server Administration Console to deploy the application.
3. Choose whether to deploy from an exploded folder, install_path/IBM/

FileNet/WebClient, or from the WAR or EAR file, such as web_client.war or
web_client.ear in install_path/deploy).

4. Accept the defaults for the deployment, except for the name for the
deployment. Use "Workplace XT" or the custom name you have chosen instead
of "web_client".

5. Finish the deployment, and save and activate your changes.

Tip: To verify that the deployment was successful, expand Web Applications.
The web application Workplace XT is listed.

Tip: To troubleshoot the deployment, check the following log:

WLS_install_path/user_projects/domains/domain_name/servers/server_name/
logs/server_name.log

6. After deployment is complete, start Workplace XT (or your custom application
name) in the WebLogic Server Administration Console.

7. (Windows only) From the Windows Services Console, restart the Process
Workplace XT Services Manager service.

8. Restart Process Task Manager and Component Manager.
9. Exit the Process Task Manager application.

To troubleshoot the deployment, check the following log:

WLS_install_path/user_projects/domains/domain_name/servers/server_name/
logs/server_name.log

Workplace XT requires that the client operating system has the Java Runtime
Environment (JRE) downloaded and installed. If JRE is not installed, users will be
prompted to install the JRE on first login.
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Deploying Workplace XT on JBoss Application Server
After you install and configure Workplace XT, you must deploy your client
application on your JBoss Application Server. You might be required to re-create
the WAR or WAR and EAR files before you deploy.

“Deploying as Workplace XT or custom name using a WAR file”
You can rename the WAR file if you are using a WAR file for deployment, and
you want to use "Workplace XT" or a custom name for the context root of the
application. The context root is part of the URI that end users type to access
Workplace XT.
“Deploying Workplace XT”
After you install and configure Workplace XT, you must deploy the Workplace
XT application on your JBoss Application Server.

Deploying as Workplace XT or custom name using a WAR file
You can rename the WAR file if you are using a WAR file for deployment, and you
want to use "Workplace XT" or a custom name for the context root of the
application. The context root is part of the URI that end users type to access
Workplace XT.

By default, when you deploy from a WAR file, the context root is the first part of
the WAR filename. For example, the default web_client.war will generate a context
root of http://server_name:port#/webclient. If you want to use http://
server_name:port#/custom_name, you must rename web_client.war to
custom_name.war.

Important: You must rename the WAR file every time you regenerate it. The
create_web_client_war.sh/.bat script will by default create a file with the name
web_client.war .

To deploy as a custom name:

Use the rename command to rename the WAR file. Enter the command without
the line break.

Option Description

UNIX mv install_path/IBM/FileNet/WebClient/
deploy/web_client.war install_path/IBM/
FileNet/WebClient/deploy/
custom_name.war

Windows rename install_path\IBM\FileNet\
WebClient\deploy\web_client.war
install_path\IBM\FileNet\WebClient\
deploy\custom_name.war

Deploying Workplace XT
After you install and configure Workplace XT, you must deploy the Workplace XT
application on your JBoss Application Server.

To deploy Workplace XT:
1. Stop JBoss Application Server, if it is running.
2. Deploy Workplace XT according to your deployment type.
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Option Description

For exploded directory deployment only 1. On the JBoss Application Server, copy
the WorkplaceXT folder from:

install_path/IBM/FileNet/WebClient/

to:

JBOSS_home/server/server_name/deploy/

2. Append the extension .war to the
WorkplaceXT folder:

JBOSS_home/server/server_name/deploy/

3. (optional) For a custom name for the
context root (and the application),
rename the WorkplaceXT.war folder to
custom_name.war, where custom_name is
the name you choose for your
application.

For WAR file deployment only On the JBoss server, copy the
web_client.war (or custom_name.war) file
from:

install_path/IBM/FileNet/WebClient/
deploy

to:

JBOSS_home/server/server_name/deploy/

For EAR file deployment only On the JBoss server, copy the
web_client.ear file from:

install_path/IBM/FileNet/WebClient/
deploy

to:

JBOSS_home/server/server_name/deploy/

3. Start or restart the JBoss Application Server.
4. Verify that the application deployed successfully.

Verify that the server.log file located in JBOSS_home/server/server_name/log/
lists deployment of the WAR or EAR file you used.

5. (Windows only) From the Windows Services Console, restart the Process
Workplace XT Services Manager service.

6. Restart Process Task Manager and Component Manager.
7. Exit the Process Task Manager application.

Each new version of Workplace XT can add new actions or modify existing actions.
When you have completed the upgrade and deployment steps, review the new
and modified actions in your upgraded Workplace XT environment and apply
whatever access roles are appropriate for your site. For details, see the Workplace
XT help topic User Help → Actions, preferences, and tools → Site preferences →
Actions preferences.

Workplace XT requires that the client operating system has the Java Runtime
Environment (JRE) downloaded and installed. If JRE is not installed, users will be
prompted to install the JRE on first login.

Upgrading Workplace XT 89



Migrating folder preferences
If you defined folder preferences in your previous Workplace XT version, you must
migrate the folder preferences after you upgrade your software. You cannot use
Workplace XT until you migrate the folder preferences.

Although Workplace XT migrates the folder preferences automatically the first time
you log in after an upgrade, you must be aware of the following requirements:
v For environments with a Content Engine at version 4.0 or 4.5, you must

configure the Folder Preferences annotation class in Enterprise Manager before
you log into Workplace XT for the first time. Ensure that you have done the
steps in “Configuring folder preferences” on page 71.

v Your first login to Workplace XT after the upgrade must be as a user with the
Application Engine Administrator role.

v The Application Engine Administrator user must also have annotate permissions
on the folders where the preferences are to be migrated.

To migrate folder preferences:
1. Log in to Workplace XT as an Application Engine Administrator role with

annotate permissions on all folders that have previously set preferences.
2. Review the list of object stores, and click Migrate.
3. If any permission errors are displayed, click the Help link for information on

the required permissions to complete the migration step. Correct any
permissions issues and repeat the steps until all preferences have been
migrated.

Upgrading optional components
You can upgrade the additional or optional components that you installed to work
with Workplace XT.

“Upgrading Workplace XT Application Integration”
Upgrading Workplace XT Application Integration is very similar to doing a new
installation. You can upgrade Workplace XT Application Integration
interactively or silently.
“Upgrading multiple instances of Workplace XT” on page 93

Upgrading Workplace XT Application Integration
Upgrading Workplace XT Application Integration is very similar to doing a new
installation. You can upgrade Workplace XT Application Integration interactively or
silently.

“Upgrading the Application Integration software interactively” on page 91
You can use the Application Integration installation program to upgrade the
software interactively.
“Upgrading the Application Integration software silently” on page 92
To upgrade the Application Integration software silently, save the
ApplicationIntegration.exe file locally and then run it at the command line
using the /s switch.
“Verifying your Workplace XT Application Integration installation” on page 93
After you install Workplace XT Application Integration, you can test the
application by using the new menu items in your Office applications.
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Upgrading the Application Integration software interactively
You can use the Application Integration installation program to upgrade the
software interactively.

Remember: You cannot collocate Workplace XT Application Integration with
clients running FileNet P8 Workplace Application Integration Toolkit.

To upgrade the software interactively:
1. Log in to the client system using an account that has Administrator privileges.
2. Log in to Workplace XT.
3. Click Tools → Downloads → Download Application Integration for

Microsoft(R) Office.....
4. In the dialog, do one of the following:
v Click Run to run the program from its current location.
v Click Save.

In the Save As dialog box, specify a location on your machine in which to
download and save the ApplicationIntegration.exe file locally, and then
click Save. Once the file is saved to your hard drive, double-click the file to
run the installer.

A setup preparation dialog appears momentarily, followed by the Welcome
dialog for Workplace XT Application Integration.

5. Click Next.
6.

7.

8. Select the applications you want to integrate, and then click Next.
The Application Integration Toolkit Components option is required to use
Application Integration.

Tip: You can use the keyboard arrow keys to move up and down the list of
applications. Use the space bar to access the context menu for any of the
applications, and then use the arrow keys to select a feature and press Enter.

9. If necesssary, click Change to specify an installation location different from the
one specified in the Install to field. You might see two default installation
paths, one for Microsoft Office and Outlook, and another for the Toolkit
Components. The Toolkit Components path only appears when the system on
which you are installing Application Integration has the Toolkit Components
currently installed. You cannot modify the Toolkit Components installation
path.

10. Click OK, and Next.
11. Verify the server name, port number, and application name that defines the

Workplace XT address.
Verify the setting for Server uses secure connection (SSL) if you are running
full SSL to encrypt all communication with Workplace XT.
Verify the setting for Server uses single sign-on (SSO) if you are using
Application Integration in an SSO environment.
You can also leave these fields blank and enter the information when you log
in to Workplace XT Application Integration.

12. Click Next.
13. Click Install.
14. After the install is complete, click Finish to complete the setup process.
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Upgrading the Application Integration software silently
To upgrade the Application Integration software silently, save the
ApplicationIntegration.exe file locally and then run it at the command line using
the /s switch.

To upgrade the software silently:
1. Log in to the client machine using an account that has Administrator privileges.
2. Sign in to Workplace XT.
3. Click Author, and then click General Tools.
4. Scroll down and click Download Application Integration for Microsoft Office,

and then click Save.
5. In the Save As dialog box, find a location on your machine in which to

download and save the ApplicationIntegration.exe file locally, and then click
Save.

6. Open a DOS command window and change the current directory to the one
where ApplicationIntegration.exe resides.

7. Type the following at the command line:
ApplicationIntegration.exe /s/v"/qn <additional
msi arguments included in string>
LICENSE_ACCEPTED=true"

Use the /s switch to launch the execution silently and include the /qn switch
in the msi string to make msi run silently.
See the following optional command line values you can also use. Append the
values within the string containing the msi arguments. For example:
ApplicationIntegration.exe /s/v"/qn /L*v
C:\temp\AppIntSetup.txt LICENSE_ACCEPTED=true"

Command Line Values Installs

ADDLOCAL=ALL All Features

ADDLOCAL=ALL REMOVE=OutlookIntegrationFeature Office Only

ADDLOCAL=ALL REMOVE=OfficeIntegrationFeature Outlook Only

ADDLOCAL=ALL
REMOVE=OutlookIntegrationFeature,OfficeIntegrationFeature

Core Only

Command Line Values Settings

HOST=host name Enter the name of the web
server running Workplace
XT.

PORT=port number Enter the Web server
assigned port number.

APPLICATION=application name Enter the directory in which
you installed the Workplace
XT application files.

SERVER_CONNECTION=1 Set Application Integration
to use an https connection

SERVER_CONNECTION=0 Set Application Integration
to use http connection. This
is the default if this
parameter is not passed.
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Command Line Values Settings

SINGLE_SIGNON=0 Set Application Integration
to not use single sign-on
(SSO).

SINGLE_SIGNON=1 Set Application Integration
to use single sign-on (SSO).

/L*v C:\temp\AppIntSetup.txt Verbose installation log and
specify log location.

Verifying your Workplace XT Application Integration installation
After you install Workplace XT Application Integration, you can test the
application by using the new menu items in your Office applications.

To verify your installation:
1. Start Microsoft Word.
2. From the File menu, click IBM FileNet Workplace XT → Open Document →

Select Item. The Login dialog opens.
If you are using SSO and you set the Workplace XT address during installation,
the action will perform without the Login dialog. If you did not set the
Workplace XT address, select IBM FileNet Workplace XT → Set Workplace XT
address for SSO to complete the dialog. In Office 2003, the IBM FileNet
Workplace XT choice displays under the File menu.

3. Log in using any valid account. The available object stores in your environment
are displayed.
If you didn't enter the Workplace XT Address information when you ran the
upgrade program, you can enter the server name, port number, and application
name that defines the Workplace XT address.
v The Server Name is the name of the web server running Workplace XT
v Port is the web server's assigned port.
v Application is the name of your application, for example, Workplace XT.
v Check Server uses secure connection (SSL) if you use SSL to encrypt all

communication with Workplace XT. Do not select this option if you use SSL
redirect during login.

4. Close all dialog and close Microsoft Word.

Upgrading multiple instances of Workplace XT

If you are upgrading Workplace XT in an environment where you have multiple
instances of Workplace XT on a single application server, use the procedure in
“Upgrading the Workplace XT software” on page 67 with the following
modifications:
v In the step "Back up, undeploy, and remove the Workplace XT web application

from the J2EE application server":
1. Make backup copies of all deployed instances of Workplace XT.
2. Uninstall all deployed instances of Workplace XT.
3. Delete the temp directory for all instances of Workplace XT.

v In the step "Copy existing configuration files", copy the web.xml files for each
deployed instance of Workplace XT, and give the copy a descriptive name, such
as web.xml.2.

v After the step "Start the upgrade process," do the following:
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1. Back up the existing configuration files in install_path/FileNet/Config/
WebClient2 and all other instances.

2. For each instance, copy the updated configuration files in
install_path/FileNet/Config/WebClient to install_path/FileNet/Config/
WebClient2 and any additional WebClient instances, and manually add any
custom changes from the old configuration files to the new updated files.

v When you redeploy Workplace XT, using the "Deploy IBM FileNet Workplace
XT" topic appropriate for your application server type, you must repackage the
WAR/EAR files for the additional instances of Workplace XT using the modified
web.xml files mentioned above. For information, see “Deploying multiple
Workplace XT instances” on page 63.
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Removing Workplace XT software

You can remove Workplace XT if you do not need it anymore or if you want to do
a completely new installation. You can also remove the additional optional
components.

“Removing Workplace XT on WebSphere Application Server”
To remove Workplace XT on WebSphere Application Server, you must first
undeploy the Web application, then remove the software files. You must also
remove any add-on products that work with Workplace XT before you remove
the Workplace XT files.
“Removing Workplace XT on WebLogic Server” on page 97
To remove Workplace XT on WebLogic Server, you must first undeploy the Web
application, then remove the software files. You must also remove any add-on
products that work with Workplace XT before you remove the Workplace XT
files.
“Removing Workplace XT on JBoss Application Server” on page 98
To remove Workplace XT on JBoss Application Server, you must first undeploy
the Web application, then remove the software files. You must also remove any
add-on products that work with Workplace XT before you remove the
Workplace XT files.
“Removing Workplace XT Application Integration” on page 100
You can remove Workplace XT Application Integration by using Windows tools.
You can remove the software interactively by using the Add/Remove Programs
tool, or silently with the MsiExec.exe tool.

Removing Workplace XT on WebSphere Application Server
To remove Workplace XT on WebSphere Application Server, you must first
undeploy the Web application, then remove the software files. You must also
remove any add-on products that work with Workplace XT before you remove the
Workplace XT files.

This task includes Workplace XT removal instructions for WebSphere Application
Server on UNIX and Windows platforms.

If you are using an add-on product with Workplace XT, you must remove that
product before you remove Workplace XT. You might also be removing the
Content Engine client as part of the Workplace XT removal. Collect any additional
installation and upgrade documentation, including the Content Engine readme,
before beginning this procedure.

To remove the Workplace XT software:
1. Log in to the server.

Option Description

UNIX Log in as a user with write access the
directory where Workplace XT is installed.

Windows Log in as a user with Administrative rights.

2. Log in to the WebSphere administrative console.
3. Undeploy the Workplace XT application.
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a. Stop the Workplace XT Web application in the administrative console.
b. Uninstall the Workplace XT Web application from Enterprise Applications.
c. Save changes to the master configuration.

4. Shut down WebSphere.
5. If you're running the Component Manager, stop the instances and exit the

Process Task Manager.
6. Remove any IBM FileNet P8 add-on products, such as IBM FileNet eForms for

P8, that you are using with Workplace XT.
For details, see the installation and upgrade documentation for each product.

7. Navigate to the /_WCuninst folder under the IBM FileNet Workplace XT
installation location. The default location is:

Option Description

UNIX /opt/IBM/FileNet/WebClient/_WCuninst

Windows C:\Program Files\IBM\FileNet\WebClient\
_WCuninst

8. Run the Workplace XT uninstaller program:

Option Description

UNIX uninstaller.bin

Windows uninstaller.exe

Reboot or log out as prompted during the
removal process.
Tip: For Windows, you can also use
Add/Remove Programs from the Control
Panel to remove Workplace XT.

On Windows, when you click Next on the
Welcome screen, the second screen asks you
to wait while Windows Task Manager
service shuts down before continuing the
uninstall. This can take a few moments. Wait
for the shutdown to complete, then complete
the uninstall wizard from the next screen.

Attention: Do not uninstall the Content Engine client if Workplace XT is
collocated with some other application, such as Application Engine, that
requires a Content Engine client installation.

9. Remove the Content Engine client. See the readme file associated with the
version of your Content Engine client.

10. Delete the temporary working directory for Workplace XT on the application
server: WAS_HOME/temp/node_name/application_server_name/WorkplaceXT

11. (If Workplace XT is the only FileNet P8 application installed on the server)
Delete the install_path/IBM/FileNet directory.

12. (If Workplace XT is not the only FileNet P8 application installed on the server)
Delete the WebClient directories in the following locations:
install_path/IBM/FileNet/WebClient

install_path/IBM/FileNet/Config/WebClient

13. (UNIX) Remove the P8TASKMAN_HOME system environment variable.
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If Workplace XT is the only FileNet P8 application running on the server you
must remove the P8TASKMAN_HOME system environment variable to
complete the application removal.

Important: Do not remove the system environment variable if any other
FileNet P8 application is installed on the server.

14. (UNIX only) Delete the following Install Shield directory, which can cause
errors when you reinstall Workplace XT:
/InstallShield/Universal/IBM/FileNet/WebClient

For AIX, the path is as follows:
/usr/lib/objrepos/InstallShield/Universal/FileNet/WebClient

Removing Workplace XT on WebLogic Server
To remove Workplace XT on WebLogic Server, you must first undeploy the Web
application, then remove the software files. You must also remove any add-on
products that work with Workplace XT before you remove the Workplace XT files.

This task includes Workplace XT removal instructions for WebLogic Server on
UNIX and Windows platforms.

You might also be removing the Content Engine client as part of the Workplace XT
uninstall procedure. Collect any additional installation and upgrade
documentation, including the Content Engine readme, before beginning this
procedure.

To remove the Workplace XT software:
1. Log in to the application server.

Option Description

UNIX Log in as a user with write access to the
directory where Workplace XT is installed.

Windows Log in as a user with Administrative rights.

2. Undeploy the Workplace XT application.
a. Stop the Workplace XT Web Application Module.
b. Delete the Workplace XT Web Application Module.

3. Shut down WebLogic Server.
4. If you're running the Component Manager, stop the instances and exit the

Process Task Manager.
5. Remove any IBM FileNet P8 add-on products, such as IBM FileNet eForms for

P8, that you are using with Workplace XT.
For details, see the installation and upgrade documentation for each product.

6. Navigate to the /_WCuninst folder under the IBM FileNet Workplace XT
installation location. The default location is:

Option Description

UNIX /opt/IBM/FileNet/WebClient/_WCuninst

Windows C:\Program Files\IBM\FileNet\WebClient\
_WCuninst

7. Run the Workplace XT uninstaller program:
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Option Description

UNIX uninstaller.bin

Windows uninstaller.exe

Reboot or log out as prompted during the
removal process.
Tip: For Windows, you can also use
Add/Remove Programs from the Control
Panel to remove Workplace XT.

On Windows, when you click Next on the
Welcome screen, the second screen asks you
to wait while Windows Task Manager
service shuts down before continuing the
uninstall. This can take a few moments. Wait
for the shutdown to complete, then complete
the uninstall wizard from the next screen.

Attention: Do not uninstall the Content Engine client if Workplace XT is
collocated with some other application, such as Application Engine, that
requires a Content Engine client installation.

8. Remove the Content Engine client. See the readme file associated with the
version of your Content Engine client.

9. Delete the contents of the temporary working directory for Workplace XT on
the Web application server:
weblogic_install_path/project_name/domains/domain_name/servers/
AdminServer/tmp/_WL_internal

10. (If Workplace XT is the only FileNet P8 application installed on the server)
Delete the install_path/IBM/FileNet directory.

11. (If Workplace XT is not the only FileNet P8 application installed on the server)
Delete the WebClient directories in the following locations:
install_path/IBM/FileNet/WebClient

install_path/IBM/FileNet/Config/WebClient

12. (UNIX) Remove the P8TASKMAN_HOME system environment variable.
If Workplace XT is the only FileNet P8 application running on the server you
must remove the P8TASKMAN_HOME system environment variable to
complete the application removal.

Important: Do not remove the system environment variable if any other
FileNet P8 application is installed on the server.

13. (UNIX only) Delete the following Install Shield directory, which can cause
errors when you reinstall Workplace XT:
/InstallShield/Universal/IBM/FileNet/WebClient

For AIX, the path is as follows:
/usr/lib/objrepos/InstallShield/Universal/FileNet/WebClient

Removing Workplace XT on JBoss Application Server
To remove Workplace XT on JBoss Application Server, you must first undeploy the
Web application, then remove the software files. You must also remove any add-on
products that work with Workplace XT before you remove the Workplace XT files.

98 Installation and Upgrade Guide



This task includes Workplace XT removal instructions for JBoss Application Server
on UNIX and Windows platforms.

If you are using an add-on product with Workplace XT, you must remove that
product before you remove Workplace XT. You might also be removing the
Content Engine client as part of the Workplace XT removal. Collect any additional
installation and upgrade documentation, including the Content Engine readme,
before beginning this procedure.

To remove the IBM FileNet Workplace XT software:
1. Log on to the application server:

Option Description

UNIX Log in as a user with write access to the
directory where IBM FileNet Workplace XT
is installed.

Windows Log in as a user with Administrative rights.

2. Shut down JBoss Application Server.
3. Remove deployment and temporary files and directories:

a. Remove the web_client.war (or custom_name.war) folder from
JBoss_HOME/server/server_name/deploy/.

b. Clear out all files and folders within the following temp directories:
JBoss_HOME/server/server_name/tmp/deploy

JBoss_HOME/server/server_name/work/jboss.web/localhost

4. If you're running the Component Manager, stop the instances and exit the
Process Task Manager.

5. Remove any IBM FileNet P8 add-on products, such as IBM FileNet eForms for
P8, that you are using with Workplace XT.
For details, see the installation and upgrade documentation for each product.

6. Navigate to the /_WCuninst folder under the IBM FileNet Workplace XT
installation location. The default location is:

Option Description

UNIX /opt/IBM/FileNet/WebClient/_WCuninst

Windows C:\Program Files\IBM\FileNet\WebClient\
_WCuninst

7. Run the Workplace XT uninstaller program:

Option Description

UNIX uninstaller.bin
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Option Description

Windows uninstaller.exe

Reboot or log out as prompted during the
removal process.
Tip: For Windows, you can also use
Add/Remove Programs from the Control
Panel to remove Workplace XT.

On Windows, when you click Next on the
Welcome screen, the second screen asks you
to wait while Windows Task Manager
service shuts down before continuing the
uninstall. This can take a few moments. Wait
for the shutdown to complete, then complete
the uninstall wizard from the next screen.

Attention: Do not uninstall the Content Engine client if Workplace XT is
collocated with some other application, such as Application Engine, that
requires a Content Engine client installation.

8. Remove the Content Engine client. See the readme file associated with the
version of your Content Engine client.

9. (If Workplace XT is the only FileNet P8 application installed on the server)
Search for the vpd.properties file. If it exists, delete it.

10. (If Workplace XT is the only FileNet P8 application installed on the server)
Delete the install_path/IBM/FileNet directory.

11. (If Workplace XT is not the only FileNet P8 application installed on the server)
Delete the WebClient directories in the following locations:
install_path/IBM/FileNet/WebClient

install_path/IBM/FileNet/Config/WebClient

12. (UNIX) Remove the P8TASKMAN_HOME system environment variable.
If Workplace XT is the only FileNet P8 application running on the server you
must remove the P8TASKMAN_HOME system environment variable to
complete the application removal.

Important: Do not remove the system environment variable if any other
FileNet P8 application is installed on the server.

13. (UNIX only) Delete the following Install Shield directory, which can cause
errors when you reinstall Workplace XT:
/InstallShield/Universal/IBM/FileNet/WebClient

For AIX, the path is as follows:
/usr/lib/objrepos/InstallShield/Universal/FileNet/WebClient

Removing Workplace XT Application Integration
You can remove Workplace XT Application Integration by using Windows tools.
You can remove the software interactively by using the Add/Remove Programs
tool, or silently with the MsiExec.exe tool.

“Removing or modifying Workplace XT Application Integration” on page 101
You can use the Add/Remove Programs tool in the Windows Control Panel to
remove or modify Workplace XT Application Integration interactively.
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“Silently removing Workplace XT Application Integration”
You can remove Workplace XT Application Integration by using a Windows
command line tool.

Removing or modifying Workplace XT Application Integration
You can use the Add/Remove Programs tool in the Windows Control Panel to
remove or modify Workplace XT Application Integration interactively.

To remove or modify Workplace XT Application Integration:
1. Click Start → Settings → Control Panel.
2. Click Add/Remove Programs, and then click IBM FileNet Workplace XT

Application Integration.
3. Do one of the following:
v Click Remove, then click Yes to confirm you want to uninstall Workplace XT

Application Integration.
v Click Change to access maintenance wizard, and then click Next. You can

modify, repair, or remove Application Integration using the maintenance
wizard.
– Select Modify to add or remove integration with Microsoft applications

from your previous installation. For example, if you have both Microsoft
Office and Outlook installed, you can remove one of the applications
using this option. The Custom Setup dialog appears, where you can
highlight the option you want to add or remove. Click Next, and then
click Install. Click Finish to complete the process.

– Select Repair if you want to reinstall Workplace XT Application
Integration in order to repair installation errors. Click Next. Click Install
to start the repair process. Click Finish to complete the process.

– Select Remove to remove Workplace XT Application Integration from your
system, and then click Next. Click Remove. Once the application is
removed from your system, click Finish to complete the process.

Silently removing Workplace XT Application Integration
You can remove Workplace XT Application Integration by using a Windows
command line tool.

To silently remove Workplace XT Application Integration:
1. Open a command prompt.
2. Enter the following command to remove Workplace XT Application Integration:

MsiExec.exe /X{9E96D48D-7A66-484F-B06E-77DA36790468} /qn
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
3-2-12, Roppongi, Minato-ku, Tokyo 106-8711 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
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platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corporation in the United States, other countries,
or both. If these and other IBM trademarked terms are marked on their first
occurrence in this information with a trademark symbol (® or ™), these symbols
indicate U.S. registered or common law trademarks owned by IBM at the time this
information was published. Such trademarks may also be registered or common
law trademarks in other countries. A current list of IBM trademarks is available on
the Web at http://www.ibm.com/legal/copytrade.shtml (www.ibm.com/legal/
copytrade.shtml).

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Other company, product, and service names may be trademarks or service marks
of others.
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